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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by you
or third parties arising from the use of these circuits, software, or information.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of
third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of
Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration,
modification, copy or otherwise misappropriation of Renesas Electronics product.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Qudlity”. The
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

“Standard”: Compurters; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; persona electronic equipment; and industrial robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property
damages (nuclear reactor control systems, military equipment etc.). Y ou must check the quality grade of each Renesas
Electronics product before using it in a particular application. Y ou may not use any Renesas Electronics product for any
application for which it is not intended. Renesas Electronics shall not bein any way liable for any damages or losses incurred
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas
Electronics.

Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by firein the event of the failure of a Renesas
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation
of microcomputer software aloneis very difficult, please evaluate the safety of the final products or systems manufactured by
you.

Please contact a Renesas Electronics saes office for details as to environmental matters such as the environmental compatibility
of each Renesas Electronics product. Please use Renesas Electronics products in compliance with al applicable laws and
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.
Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with applicable laws
and regulations.

Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. Y ou should not use
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use
by the military, including but not limited to the development of weapons of mass destruction. When exporting the Renesas
Electronics products or technology described in this document, you should comply with the applicable export control laws and
regulations and follow the procedures required by such laws and regulations.

It isthe responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise
places the product with athird party, to notify such third party in advance of the contents and conditions set forth in this
document, Renesas Electronics assumes no responsi bility for any lossesincurred by you or third parties as aresult of
unauthorized use of Renesas Electronics products.

This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document
or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Regulatory Compliance Notices

® European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European
Union.)

CE Certifications:

« Electromagnetic Compatibility (EMC) Directive 2004/108/EC

EN 55022 Class A

WARNING: Thisis a Class A ﬁroduct. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

EN 55024

« Information for traceability

* Authorised representative

Name: Renesas Electronics Corporation

Address: 1753, Shimonumabe, Nakahara-ku, Kawasaki, Kanagawa, 211-8668, Japan
» Manufacturer

Name: Renesas Solutions Corp.

Address: Nippon Bldg., 2-6-2, Ote-machi, Chiyoda-ku, Tokyo 100-0004, Japan
* Person responsible for placing on the market

Name: Renesas Electronics Europe GmbH

Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
» Trademark and Type name

Trademark: Renesas

Product name: E10A-USB Emulator

Type name: HS0005K CUO1H / HS0005K CUO2H

Environmental Compliance and Certifications:

« Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment (RoHS)

Directive 2002/95/EC

« Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC



® United States Regulatory notices

This product complies with the following EMC regulation. (Thisisonly valid in the United States.)

FCC Certifications:

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercia environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in aresidentia areaislikely to cause
harmful interference in which case the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(2) this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.




IMPORTANT INFORMATION
READ FIRST

« READ thisuser's manual before using this emulator product.

« KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully under stand its mechanism.

Emulator Product:
Throughout this document, the term "emulator product” shall be defined as the following
products produced only by Renesas Electronics Corp. excluding all subsidiary products.

e Emulator
e User system interface cable

The user system or a host computer is not included in this definition.

Purpose of the Emulator Product:

This emulator product is a software and hardware development tool for systems employing the
Renesas microcomputer. This emulator product must only be used for the above purpose.

Limited Applications:

This emulator product is not authorized for usein MEDICAL, atomic energy, aeronautical or
space technology applications without consent of the appropriate officer of a Renesas sales
company. Such useincludes, but is not limited to, use in life support systems. Buyers of this
emulator product must notify the relevant Renesas sales offices before planning to use the product
in such applications.

Improvement Policy:

Renesas Electronics Corp. (including its subsidiaries, hereafter collectively referred to as
Renesas) pursues a policy of continuing improvement in design, performance, and safety of the
emulator product. Renesas reserves the right to change, wholly or partially, the specifications,
design, user's manual, and other documentation at any time without notice.

Target User of the Emulator Product:

This emulator product should only be used by those who have carefully read and thoroughly
understood the information and restrictions contained in the user's manual. Do not attempt to use
the emulator product until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the emulator product.
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LIMITED WARRANTY

Renesas warrants its emulator products to be manufactured in
accordance with published specifications and free from defectsin
material and/or workmanship. Renesas, at its option, will replace any
emulator products returned intact to the factory, transportation charges
prepaid, which Renesas, upon inspection, shall determine to be defective
in material and/or workmanship. The foregoing shall constitute the sole
remedy for any breach of Renesas’ warranty. See the Renesas warranty
booklet for details on the warranty period. This warranty extends only
to you, the original Purchaser. It is not transferable to anyone who
subsequently purchases the emulator product from you. Renesas is not
liable for any claim made by athird party or made by you for athird

party.
DISCLAIMER

RENESAS MAKES NO WARRANTIES, EITHER EXPRESS OR
IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED
HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,
WARRANTIESASTO MARKETABILITY, MERCHANTABILITY,
FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR
AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT
SHALL RENESASBE LIABLE FOR ANY DIRECT, INCIDENTAL
OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR
LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE
EMULATOR PRODUCT, THE USE OF ANY EMULATOR
PRODUCT, OR ITSDOCUMENTATION, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. EXCEPT AS
EXPRESSLY STATED OTHERWISE IN THISWARRANTY,
THISEMULATOR PRODUCT ISSOLD "ASIS", AND YOU
MUST ASSUME ALL RISK FOR THE USE AND RESULTS
OBTAINED FROM THE EMULATOR PRODUCT.

R20UTO870EJ1000 Rev. 10.00 Page Il of VI
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State Law:

Some states do not alow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.
Thiswarranty gives you specific legal rights, and you may have other rights which may vary from
State to state.

The Warranty is Void in the Following Cases:

Renesas shall have no liability or legal responsibility for any problems caused by misuse,
abuse, misapplication, neglect, improper handling, installation, repair or modifications of the
emulator product without Renesas' prior written consent or any problems caused by the user
system.

All Rights Reserved:

This user's manual and emulator product are copyrighted and all rights are reserved by
Renesas. No part of this user's manual, al or part, may be reproduced or duplicated in any form,
in hard-copy or machine-readable form, by any means available without Renesas’ prior written
consent.

Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics
and performance of Renesas' semiconductor products. Renesas assumes no responsibility for
any intellectual property claims or other problems that may result from applications based on
the examples described herein.

2. No licenseisgranted by implication or otherwise under any patents or other rights of any third
party or Renesas.
Figures:

Some figuresin this user's manua may show items different from your actual system.

Device names:

This user’s manual uses SHxxxx as an example of the device names.

Limited Anticipation of Danger:

Renesas cannot anticipate every possible circumstance that might involve a potential hazard.
The warningsin this user's manual and on the emulator product are therefore not all inclusive.
Therefore, you must use the emulator product safely at your own risk.

R20UTO870EJ1000 Rev. 10.00 Page 11l of VI
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SAFETY PAGE
READ FIRST

« READ thisuser's manual before using this emulator product.

« KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully under stand its mechanism.

DEFINITION OF SIGNAL WORDS

A This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

A WARNING WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

|A CAUTION | CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

| CAUTION |

CAUTION used without the safety alert symbol indicates a
potentially hazardous situation which, if not avoided, may result
in property damage.

NOT E emphasizes essential information.

R20UTO870EJ1000 Rev. 10.00 Page IV of VI
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A\ WARNING

Observe the precautions listed below. Failure to do so
will result in a FIRE HAZARD and will damage the user
system and the emulator product or will result in
PERSONAL INJURY. The USER PROGRAM will be
LOST.

1. Do not repair or remodel the emulator product by
yourself for electric shock prevention and quality
assurance.

2. Always switch OFF the host computer and user system
before connecting or disconnecting any CABLES or
PARTS.

3. Connect the connectors in the user system and in the
user interface cable by confirming the correct direction.

CAUTION

Caution to Be Taken for Disposal:

Penalties may be applicable for incorrect disposal of this waste, in accordance
with your national legislation.

European Union regulatory notices:
The WEEE (Waste Electrical and Electronic Equipment) regulations put
responsibilities on producers for the collection and recycling or disposal of
electrical and electronic waste. Return of WEEE under these regulations is

mmmm 2Pplicable in the European Union only. This equipment (including all

accessories) is not intended for household use. After use the equipment
cannot be disposed of as household waste, and the WEEE must be treated,
recycled and disposed of in an environmentally sound manner.

Renesas Electronics Europe GmbH can take back end of life equipment,
register for this service at “http://www.renesas.eu/weee”.
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Warnings on Emulator Usage

Be sure to read and understand the warnings below before using this emulator. Note that these are
the main warnings, not the complete list.

A WARNING

Always switch OFF the host computer and user system
before connecting or disconnecting any CABLES or PARTS.

Failure to do so will result in a FIRE HAZARD and will
damage the user system and the emulator product or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

CAUTION

Place the host computer and user system so that no cable is
bent or twisted. A bent or twisted cable will impose stress on
the user interface leading to connection or contact failure.

Make sure that the host computer and the user system are
placed in a secure position so that they do not move during
use nor impose stress on the user interface.

R20UTO870EJ1000 Rev. 10.00 Page VI of VI
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I ntroduction

The High-performance Embedded Workshop is a powerful development environment for embedded applications
targeted at Renesas microcontrollers. The main features are:

e A configurable build engine that allows you to set-up compiler, assembler and linker options via an easy to use
interface.

e Anintegrated text editor with user customizable syntax coloring to improve code readability.
e A configurable environment to run your own tools.

e Anintegrated debugger which allows you to build and debug in the same application.

e Version control support.

The High-performance Embedded Workshop has been designed with two key aims; firstly to provide you, the user, with
aset of powerful development tools and, secondly, to unify and present them in away that is easy to use.



About This Manua

This manual describes preparation before using the emulator, emulator functions, debugging functions specific to the
emulator, tutorial, and emulator's hardware and software specifications.

Refer to the High-performance Embedded Workshop User's Manual for details on the information on the basic usage of
the High-performance Embedded Workshop, customization of the environment, build functions, and debugging
functions common to each High-performance Embedded Workshop product.

This manual does not intend to explain how to write C/C++ or assembly language programs, how to use any particular
operating system or how best to tailor code for the individua devices. These issues are |ft to the respective manuals.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
Visual SourceSafe is atrademark of Microsoft Corporation.
IBM is aregistered trademark of International Business Machines Corporation.

All brand or product names used in this manual are trademarks or registered trademarks of their respective companies
or organizations.

Document Conventions
This manual uses the following typographic conventions:

Tablel Typographic Conventions

Convention Meaning
[Menu->Menu Option] Bold text with ‘->" is used to indicate menu options
(for example, [File->Save As...]).
FILENAME.C Uppercase names are used to indicate filenames.
“enter this string” Used to indicate text that must be entered (excluding the *” quotes).
Key + Key Used to indicate required key presses. For example, CTRL+N

means press the CTRL key and then, whilst holding the CTRL key
down, press the N key.

) When this symbol is used, it is always located in the left hand
(The *how to” symbol) margin. It indicates that the text to its immediate right is describing
“how to” do something.




User Registration

When you install debugger software, atext file for user registration is created on your PC. Fill it in and email it to your
local distributor. If you have replaced an emulator main unit or emulation probe, rewrite an emulator name and serial
number in the text file you filled in earlier to register your new hardware products.

Y our registered information is used for only after-sale services, and not for any other purposes. Without user
registration, you will not be able to receive maintenance services such as anotification of field changes or trouble
information. So be sure to carry out the user registration.

For more information about user registration, please contact your local distributor.
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SuperH™ Family E10A-USB Emulator Section 1 Overview

Section1 Overview

The E10A-USB emulator (hereafter referred to as the emulator) is a support tool for developing
application systems to run on Renesas original microcomputers.

The main unit of the emulator is connected, through the dedicated debugging interface, to the user
system. The user system can be debugged under the conditions similar to the actual application
conditions. The emulator enables debugging anywhere indoors or out. The host computer for
controlling the emulator must be an IBM PC compatible machine with USB 1.1/2.0 (Full-Speed).

Figure 1.1 shows the configuration of a system where the emulator isin use.

User system

High-performance
Embedded Workshop \

User system connector

E10A-USB emulator

Connected to
the USB connector

User system interface cable

Figurel.l System Configuration with the Emulator
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SuperH™ Family E10A-USB Emulator Section 1 Overview

The emulator provides the following features:

Excellent cost-performance emulator

Compactness and connection to the USB are implemented.

Realtime emulation

Realtime emulation of the user system is enabled at the maximum operating frequency of the
CPU.

Excellent operability

Using the High-performance Embedded Workshop enables user program debugging using a
pointing device such asamouse. The High-performance Embedded Workshop enables high-
speed downloading of load module files.

Various debugging functions

Various break and trace functions enabl e efficient debugging. Breakpoints and break
conditions can be set by the specific window, trace information can be displayed on awindow,
and command-line functions can be used.

Debugging of the user system in the final development stage
The user system can be debugged under conditions similar to the actual application conditions.
Compact debugging environment

When the emulator is used, alaptop computer can be used as a host computer, creating a
debugging environment in any place.

AUD trace function*
The AUD trace function enables realtime trace.

Note: The AUD isan abbreviation of the Advanced User Debugger. Support for the AUD varies

with the product.
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SuperH™ Family E10A-USB Emulator Section 1 Overview

11 Warnings

CAUTION

READ the following warnings before using the emulator
product. Incorrect operation will damage the user system and
the emulator product. The USER PROGRAM will be LOST.

1. Check all components against the component list after unpacking the emulator.
2. Never place heavy objects on the casing.

3. Protect the emulator from excessive impacts and stresses. For details, refer to section 1.2,
Environmental Conditions.

4. When moving the host computer or user system, take care not to vibrate or damage it.

5. After connecting the cable, check that it is connected correctly. For details, refer to section 3,
Preparation before Use.

6. Supply power to the connected equipment after connecting all cables. Cables must not be
connected or removed while the power is on.

R20UT0870EJ1000 Rev. 10.00 Page 3 of 292
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1.2 Environmental Conditions

CAUTION

Observe the conditions listed in tables 1.1 and 1.2 when
using the emulator. Failure to do so will cause illegal
operation in the user system, the emulator product, and the
user program.

Table1.1 Environmental Conditions

Item Specifications
Temperature Operating: +10°C to +35°C
Storage: —-10°Cto +50°C
Humidity Operating: 35% RH to 80% RH, no condensation
Storage: 35% RH to 80% RH, no condensation
Vibration Operating: 2.45 m/s” max.
Storage: 4.9 m/s” max.

Transportation: 14.7 m/s* max.

Ambient gases

No corrosive gases may be present

R20UT0870EJ1000 Rev. 10.00
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Table 1.2 lists the acceptabl e operating environments.

Table 1.2 Operating Environments

Item

32-Bit Editions of Windows
Vista®or 32-Bit or 64-Bit
Editions of Windows® 7

32-Bit Editions of Windows® XP

Host computer

Built-in Pentium® Il or higher-performance CPU (1 GHz or higher
recommended); IBM PC or compatible machine with USB 1.1/2.0 (Full-
Speed).

CPU

Pentium® lll (1 GHz) or higher
recommended

Pentium® 4 (3 GHz), Core™ 2 Duo
(1 GHz), or higher recommended

Minimum memory
capacity

1 Gbyte or more recommended
(at least 10 times the size of the
load module file)

1.5 Gbyte or more recommended
(at least 10 times the size of the
load module file)

Hard-disk capacity

Installation disk capacity: 600 Mbytes or more. (Prepare an area at
least double the memory capacity (four-times or more recommended)
as the swap area.)

Pointing device such as
mouse

Connectable to the host computer; compatible with Windows® XP,
Windows Vista®, or Windows® 7

Display

Monitor resolution: 1024 x 768 or higher

Power voltage

5.0 £ 0.25 V (USB-bus power type)

Current consumption

HS0005KCUO1H: 260 mA (max.)
HS0005KCUO2H: 420 mA (max.)

CD-ROM drive

Required to install the High-performance Embedded Workshop for the
emulator or refer to the emulator user's manual.

Microsoft, Windows, and Windows Vista are either registered trademarks or trademarks of
Microsoft Corporation in the United States and or other countries. All other brand and product
names are trademarks, registered trademarks or service marks of their respective holders.

13 Components

Check that all of the components are present when unpacking the product. For details on the
emulator components, refer to section 1.1 in the additional document, Supplementary Information
on Using the SHxxxx. If all of the components are not present, contact your nearest Renesas sales

office.
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Section 2 Emulator Functions

This section describes the emulator functions. They differ according to the device supported by
the emulator. For the usage of each function, refer to section 6, Tutorial.

2.1 Overview
Table 2.1 gives afunctional overview of the emulator.
For details on the functions of each product, refer to the online help.

Table2.1 Emulator Functions

No. Item Function
1 User program execution e Executes a program with the operating frequency within a
function range guaranteed by devices.

e Reset emulation

e Step functions:
Single step (one step: one instruction)
Source-level step (one step: one-line source)
Step over (a break did not occur in a subroutine)
Step out (when the PC points to a location within a
subroutine, execution continues until it returns to the calling
function)

2 Reset function e Issues a power-on reset from the High-performance
Embedded Workshop to the device during break.

3 Trace functions e Trace function incorporated in the device

e AUD trace function:
Branch trace or memory access trace

e Memory output function of trace data

4 Break functions e Hardware break function (conditions and the number of
conditions differ according to the device)

e PC break function (255 points)
e Forced break function

R20UT0870EJ1000 Rev. 10.00 Page 7 of 292
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Table2.1 Emulator Functions (cont)

No. Item

Function

5 Performance
measurement function

Uses a counter in the device to measure the number of
cycles that passes during point-to-point execution.

Measures the number of cycles that pass in executing
individual functions and lists them at the end of execution
from a ‘Go’ command.

6 Memory access functions

Downloading to RAM
Downloading to flash memory
Single-line assembly

Reverse assembly (disassembly)
Reading of memory

Writing to memory

Automatic updating of a display of selected variables during
user program execution

Fill
Search
Move

Copy
Monitor (physical address)

7 General/control register
access function

Reads or writes the general/control registers.

8 Internal I/O register
access function

Reads or writes the internal I/O registers.*

9 Source-level debugging
function

Various source-level debugging functions.

10 Command line function

Supports command input.

Batch processing is enabled when a file is created by arranging
commands in input order.

11 Help function

Describes the usage of each function or command syntax input
from the command line window.

Note: The [IO] window displays the contents defined in [SHxxxx.io]. Editing those contents adds
or deletes the registers to be displayed. For the contents to be described as [SHxxxx.i0],
refer to reference 6, 1/0 File Format, in the High-performance Embedded Workshop V.4.09

User’'s Manual.

The following directory contains [SHxxxx.io] (xxxx means the name of emulator device

group.):

<High-performance Embedded Workshop folder>:
\Tools\Renesas\DebugComp\Platform\E10A-USB\xxxx\IOFiles

R20UT0870EJ1000 Rev. 10.00
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The specific functions of the emulator are described in the next section.

2.2 Trace Functions

The emulator has two trace functions.

221 Internal Trace Function

The branch source and branch destination addresses, mnemonics, operands, and source lines are
displayed. This function uses the trace buffer built into the device.

Notes: 1. The number of branch instructions that can be acquired by atrace differs according to
the product. For the number that can be specified for each product, refer to the online
help.

2. Theinternal trace function is not supported for all products. For details on the
specifications of each product, refer to the online help.

3. Theinternal trace function is extended for some products. For details on the
specifications of each product, refer to the online help.
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2.2.2 AUD Trace Function

Thisisthe large-capacity trace function that is enabled when the AUD pins are connected to the
emulator. When an event that starts trace acquisition occurs, the trace information is output in
realtime from the AUD pins. Thisfunction isonly available on the E1I0A-USB emulator with
model name HSO005K CUO2H.

Counting each set of a branch source instruction and branch destination instruction as one branch,
the maximum amount of information acquired by atraceis 32,767.

(1) Trace acquisition event
The following events can be acquired by the AUD trace function.

(a) Branch generation information
The branch source and branch destination addresses are acquired.

(b) Memory access information within the specified range

Memory accessin the specified range can be acquired by trace.

Two memory ranges can be specified for channels A or B. Theread, write, or read/write cycle
can be selected as the bus cycle for trace acquisition.

Thisfunction is called the window trace function.

(c) Softwaretrace

When a specific instruction is executed, the PC value at execution and the contents of one
general register are acquired by trace. Describe the Trace(x) function (x is avariable name) to
be compiled and linked beforehand. For details, refer to the SHC/C++ compiler manual.
When the load module is loaded on the emulator and a valid software trace function is
executed, the PC value that has executed the Trace(x) function, the variable for x, and the
source lines are displayed.

Notes: 1. Thisfunction cannot be supported with some versions of the SHC/C++ compiler.
Since the supported version differs depending on the device to be debugged, refer to
section 2.2.2, Trace Functions, in the additional document, Supplementary Information
on Using the SHxxxX.

2. Thetypes of events acquired by atrace differ depending on the product. For detailson
the specifications of each product, refer to the online help.
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(2) Trace acquisition mode
The AUD trace function has the following modes to acquire atrace.

Table 2.2 shows the AUD trace acquisition mode that can be set in each trace function.

Table2.2 AUD Trace Acquisition Mode

Type

Mode

Description

Continuous
trace occurs

Realtime trace

When the trace information is being generated intensively
that the output from the AUD pin incapable of keeping up, the
CPU temporarily suspends the acquisition of trace
information. Therefore, although the user program is run in
real time, the acquisition of some trace information might not
be possible.

Non realtime
trace

When trace information is being generated so intensively that
the output from the AUD pin is incapable of keeping up, CPU
operations are temporarily suspended and the output of trace
information takes priority. In such cases, the realtime
characteristics of the user program are lost.

Trace buffer
full

Trace continue

This function overwrites the latest trace information to store
the oldest trace information.

Trace stop

After the trace buffer becomes full, the trace information is no
longer acquired. The user program is continuously executed.

R20UT0870EJ1000 Rev. 10.00
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(3) Trace display contents
When the program breaks, the following trace results are displayed in the [Trace] window.

PTR: The trace-buffer pointer (+0 from the last instruction to have been executed)

IP: Indicates the number of cyclesthat have elapsed since the latest trace information was
gathered. For branch instructions, the branch source and destination are counted together as
one.

Type: Displays the type of trace acquisition information.

Address: Displays the addresses from which the trace data was acquired.

Data: Displaysthe data acquired in the trace. For information without data, displays
fkkkkkkkxk? i

Instruction, Source, Label: Displays the mnemonic of the instruction at the trace acquisition
address, along with the corresponding source code and label information. Double-clicking on
the [Source] column moves the cursor to the corresponding position in the [Editor] window.

The Type, Address, and Data columns have different meanings according to the type of AUD
trace that has been selected.

Table2.3 [Trace Window] Display Contents

Trace Type Type Column Address Column Data Column

Branch trace BRANCH Branch source address No display
DESTINATION Branch destination address  No display

Window trace™ MEMORY Memory access address Memory access data

Software trace” S_TRACE Trace(x) function execution Variable x data

address
Data lost™? LOST No display No display
CPU wait CPU-WAIT No display No display

generation™”

Notes: 1. Not displayed in the internal trace.

2. According to the device being debugged, there may be no output for the [Lost] or
[CPU-WAIT] type. In such a case, it is not possible to clarify whether the trace data
was not output in time or the CPU generated a wait state for the output trace data.
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The following items will be displayed, according to the device to be debugged.

For specifications of the individual products, refer to the additional document, Supplementary
Information on Using the SHxxxx, or the online help.

PTR: The trace-buffer pointer (+0 from the last instruction to have been executed)

IP: Indicates the number of cyclesthat have elapsed since the latest trace information was
gathered. For branch instructions, the branch source and destination are counted together as
one.

Master: Type of bus master that accessed the memory.
Type: Displays the type of trace acquisition information.

Branch Type: Branch type (only displayed for a branch trace)
For an AUD trace, thisitem is only displayed if the PPC option has been enabled.

Bus: Displays which bus was accessed.

R/W: Displays whether the access involved reading or writing.

Address: Displays the addresses from which the trace data was acquired.
Data: Displays the data acquired in the trace.

PPC: Output from a performance counter

Instruction, Source, Label: Displays the mnemonic of the instruction at the trace acquisition
address, along with the corresponding source code and label information. Double-clicking on
the [Source] column moves the cursor to the corresponding position in the [Editor] window.

The Type, BUS, R/W, Address, and Data columns have different meanings according to the type
of AUD trace that has been selected.
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Table2.4 [Trace Window] Display Contents

Trace Type Type Column BUS Column R/W Column Address Column Data Column
Branch BRANCH™ No display No display Branch source No display
trace address™

DESTINATION No display No display Branch destination  No display

address
Memory- MEMORY No display Read/write Memory access Memory
range address access data™
access
trace
Software S_TRACE No display No display Trace(x) function Variable x
trace execution address  data
System bus MEMORY No display Read/write Memory access Memory
trace address access data
(write only)™

Data lost? LOST No display No display No display No display
CPU wait CPU-WAIT No display No display No display No display

generation™

Notes: 1. Not displayed when the PPC option is in use.
2. According to the device being debugged, there may be no output for the [Lost] or
[CPU-WAIT] type. In such a case, it is not possible to clarify whether the trace data
was not output in time or the CPU generated a wait state for the output trace data.

223 Memory Output Function of Trace Data

In some devices to be debugged, trace data can be written to the specified memory range. The
datais read from the memory range written in the [Trace] window and the result is then displayed.

Note: Do not specify the program area as the memory in the specified range is overwritten.

R20UT0870EJ1000 Rev. 10.00

Aug 10, 2012 RENESAS

Page 14 of 292



SuperH™ Family ELI0A-USB Emulator Section 2 Emulator Functions

224 Useful Functions of the [Trace] Window
The trace window provides the following useful functions.

(1) Searchesfor the specified data

(2) Extracts the specified data.

(3) Filters and displays again the specified data.

(4) Supplements the information from the branch destination address to the next branch source
address.

For the usage of those functions, refer to section 5.6, Viewing the Trace Information.

(5) Changes the trace settings during user program execution.

In some devices to be debugged, trace settings can be changed during user program execution.
For details on the specifications of each product, refer to the online help.

2.3 Break Function
The emulator has the following three break functions.

(1) Hardware break function
Uses a break controller incorporated in the device.
The access address, instruction fetch address, data, or bus cycle condition can be set. The
logical addressis the address condition.

This function can be also set from the [Event] column in the [Editor] or [Disassembly] window.
For the setting, refer to section 5.2, Downloading a Program.

Note: In some devices to be debugged, hardware break settings can be changed during user
program execution. For details on the specifications of each product, refer to the online
help.

(2) PC break function (BREAKPOINT)
Breaks when the dedicated instruction at the specified address that has been replaced is
executed. Thisfunction cannot be set at a place other than RAM or internal flash memory area
since amemory write occurs.
It can also be set when the [S/'W breakpoint] column for the line to be set is double-clicked in
the [Editor] or [Disassembly] window.
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(3) Forced break function
Forcibly breaks the user program.

2.4 Performance M easur ement Function

The emulator has two types of performance measurement functions.

24.1 Function for Measuring the Number of Cyclesfrom Point to Point

This function applies a counter in the device to measure the number of cycles from one specified
condition being satisfied until a next specified condition is satisfied.

Not only the number of cycles but also various items such as the number of cache misses or of
TLB misses can be measured according to the supported devices.

Thisfunction is hereafter called the performance measurement function or PA1.

Notes: 1. Supplemental Explanation on Performance Measurement for Products of the SH-2A
Device Group

Regarding Measurement of Numbers of Exceptions and Interrupts

Even when [Exception/interrupt counts (EA)] is selected as the item for measurement,
trap-instruction exceptions due to TRAPA instructions will not be counted.

2. Itemsto be measured differ according to the product and some products do not support
thisfunction. For details on the specifications of each product, refer to the online help.

24.2 Profiling Function
The profiling function is used to measure the performance of each function.

A function having low performance can be easily found if the statistics of the time for each
function are maintained.

Notes: 1. Use of the profiling and performance measurement functions at the same time is not
possible. The[Can not use this function] error message dialog box will be displayed if
simultaneous use is attempted.

2. ltemsto be measured differ according to the product and some products do not support
thisfunction. For details on the specifications of each product, refer to the online help.
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25 Memory Access Functions
The emulator has the following memory access functions.

(1) Memory read/write function

[Memory] window: The memory contents are displayed in the window. Only the amount
specified when the [Memory] window is opened can beread. Sincethereis
no cache in the emulator, read cycles are always generated. If the memory is
written in the [Memory] window, read cyclesin the range displayed in the
[Memory] window will occur for updating the window. When the [Memory]
window is not to be updated, change the setting in [Lock Refresh] from the
popup menu.

me command: A command line function that reads or writes the specified amount of
memory at the specified address.

(2) User program downloading function

A load module registered in the workspace can be downloaded. Such module can be selected
from [Download Modul€] in the [Debug] menu. Downloading is also possible by a popup menu
that is opened by right-clicking on the mouse at the load module in the workspace. The user
program is downloaded to the RAM or flash memory.

When downloading to the flash memory that has not been within the MCU, select [Emulator] from
the [Setup] menu, open the [Configuration] window, and perform required settings on the
[Loading flash memory] page.

This function also downloads information required for source-level debugging such as debugging
information.

(3) Memory data uploading function
The specified amount of memory from the specified address can be saved in afile.

(4) Memory data downloading function

The memory contents saved in afile can be downloaded. Select [Load] from the popup menuin
the [Memory] window.

(5) Displaying the variable contents
The variable contents specified in the user program are displayed.
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(6) Monitoring function
In some devicesto be debugged, memory contents can be monitored during user program
execution. For details on the specifications of each product, refer to the online help.

(7) Other memory operation functions
Other functions are as follows:

o Memory fill

e Memory copy

e Memory save

e Memory verify

e Memory search

e Internal 1/O display

e Cachetable display and edit (only for devices incorporating caches)
e TLB tabledisplay or edit (only for devices incorporating MMU)

o Displaying label and variable names and their contents

For details, refer to the online help.

Notes: 1. Memory access during user program execution:
When memory is accessed from the memory window, etc. during execution of the user
program, execution stops for the memory access and is then resumed. Therefore,
realtime emulation cannot be performed.

2. Memory access during user program break:
The program can also be downloaded for the flash memory area by the emulator.
Other memory write operations are enabled for the RAM area and the internal flash
memory. Therefore, an operation such as memory write or BREAKPOINT should be
set only for the RAM area and the internal flash memory. When the memory area can
be read by the MM U, do not perform memory write, BREAKPOINT setting, or
downloading.

3. Cache operation during user program break:
When cache is enabled in the device incorporating a cache, the emulator may change
the cache data when it accesses memory. For details, refer to section 2.1 in the
additional document, Supplementary Information on Using the SHxxxx.
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2.6 Stack Trace Function

The emulator uses the information on the stack to display the names of functionsin the sequence
of callsthat led to the function to which the program counter is currently pointing. This function
can be used only when the load module that has the Dwarf2-type debugging information is loaded.
For the usage of this function, refer to section 6.20, Stack Trace Function.

2.7 Function for Releasing I nterruptsto the User during User Program
Breaks

On some devices, al interrupts are open to the user during the execution of user programs. A
mode setting is available to specify whether or not interrupt processing is executed during breaks
in execution of the user program.

2.8 OnlineHep

An online help explains the usage of each function or the command syntax that can be entered
from the command line window.

Select [Emulator Help] from the [Help] menu to view the emulator help.
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Section 3 Preparation before Use

31 Emulator Preparation

Unpack the emulator and prepare it for use as follows:

A WARNING

READ the reference sections shaded in figure 3.1 before
using the emulator product. Incorrect operation will damage
the user system and the emulator product. The USER
PROGRAM will be LOST.

Reference
| Unpack the emulator | Component list
| Check the components against the component list |
| When the emulator
is used first.
Set up the emulator Section 3
- Install the emulator's software
(Check the components and register the user information.)

- Insert the emulator

- Set up the main unit of the emulator
| Start the High-performance Embedded Workshop | Section 4

| When the emulator
| is used for second

| Turn on the user system

| time or later.
| Input the user system reset signal |
Figure3.1 Emulator Preparation Flow Chart
R20UT0870EJ1000 Rev. 10.00 Page 21 of 292

Aug 10, 2012 RENESAS




SuperH™ Family E1I0A-USB Emulator Section 3 Preparation before Use

3.2 Emulator Hardware Configuration

Asshown in figure 3.2, the emulator consists of an emulator, a USB cable, and a user system
interface cable. The emulator is connected to the host computer viaUSB 1.1, and aso to the USB
port conforming to USB 2.0.

LI5H cable

E10A-USE emulatar

il
|l|.|

lzer systermn interface cable

Figure3.2 Emulator Hardware Configuration (when the 36-pin Type Connector is Used)
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The names of each section of the emulator are explained next.

Emulator Top View:

LL
=
[
Lul
w
s}

i) b

Figure 3.3 Emulator Top View

(@) E10A-USB logo plate: A yellow plate (for HSO005K CUO1H) or ared plate (for
HS0005K CUO2H) dedicated for the emulator is provided to be easily
distinguished from other E-series emulators.

(b) Sliding switch cover: A cover to protect switches for setting the emulator, which is closed
to prevent incorrect operation. Be sure to close this cover during

emulation.

(c) ACTION LED: Marked ‘ACT’. When this LED islit, the ELOA-USB control
softwareisin operation.

(d) Host connector: Marked ‘=<=". A connector for the host computer is provided at the

side of this mark.

(e) H-UDI port connector: Marked ‘USER I/F . A connector for the user system interface cable
isprovided at the side of this mark.

Note: Evenif the LED isnot lit, the USB is not disconnected or malfunctioned.

R20UT0870EJ1000 Rev. 10.00 Page 23 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E1I0A-USB Emulator Section 3 Preparation before Use

Emulator Host-side View:

Figure3.4 Emulator Host-side View

(@ Host-side connector: A USB connector for the host computer. Be sure to connect the
provided USB cable.
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Emulator User-side View:

Figure3.5 Emulator User-side View

(@) User-sideconnector: A user system interface cable is connected.
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Emulator Bottom View:

(@)

e

\ 4

Vs

MODEL : HS0005KCU02H

~N

(HS0005KCUO02H)
SERIAL No. : 00001A

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including

interference that may cause undesired operation.

H8S c e
H8 SX

SH-2 SH-Mobile

SH-3 NewSH-Mobile]

SH-4 SH-2A MPEG
SH-4A SH4AL-DSP

MADE IN JAPAN )

O

@W

)

Figure 3.6 Emulator Bottom View

(a) Label for product management: The serial number, revision, and safety standard, etc. of the
emulator are written to. The contents differ depending on the

time when you purchased the product.

Only one device group can be set up using the setup tool
when the emulator is purchased. Be sure to check the device
group you have selected on the label for product

management.
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3.3 CD-R

Theroot directory of the CD-R contains a setup program for installing the emulator’ s software.
The folders contain the files and programs listed below.

Table3.1 Contentsof the CD-R Directories

Directory Name Contents Description

Dlls Microsoft® runtime library A runtime library for the High-performance
Embedded Workshop. The version is checked
at installation and this library is copied to the
hard disk as part of the installation process.

Drivers E10A-USB emulator driver USB drivers for the E1I0A-USB emulator.

Help Online help for the EI0A-USB  An online help file. This is copied to the hard
emulator disk as part of the installation process.

Manuals E10A-USB emulator manuals E10A-USB emulator user’'s manuals. They

are provided as PDF files.

34 Installing Emulator’s Softwar e

Execute HewlnstMan.exe from the root directory of the CD-R and follow the cues shown on
screen to install the software.

Note: 1. When adriver isinstalled in Windows® X P, awarning message on the Windows® logo
test may be displayed, but it is not a problem. Select [Continue Anyway] to proceed
with driver installation.

2. When installing a driver, the [Select Device Group] message will be displayed in the
[Select Device] dialog box. Only the device group needs to be selected; that is, the
device name does not have to be selected. The listed devices are those supported by the
E10A USB. If the target device is not listed, the version of the emulator software you
areusing isold or support for the device may not be available.

3. Thelatest version of the emulator software is provided on the website. If the device to
be used is not listed, it is not supported. In that case, please contact a distributor or
agency since providing a preliminary version of the emulator software may be possible
as an aternative.
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35 Connecting the Emulator to the Host Computer

This section describes how to connect the emulator to the host computer. For the position of each
connector of the emulator, refer to section 3.2, Emulator Hardware Configuration.

Note: Besureto install the software for the emulator before putting the emulator in place.

A WARNING

Always switch OFF the emulator product and the user
system before connecting or disconnecting any CABLES
except for the USB interface cable. Failure to do so will result
in a FIRE HAZARD and will damage the user system and the
emulator product or will result in PERSONAL INJURY.

The USER PROGRAM will be LOST.
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The emulator is connected to the host computer viathe USB 1.1, and also to the USB port
conforming to USB 2.0. Figure 3.7 shows the system configuration.

Host computer E104-USBE emulatar

IISB cable (1.5 m

Figure3.7 System Configuration when Connecting the Emulator to the Host Computer
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3.6 Connecting the Emulator to the User System

Use the procedure below to connect the emulator to the user system with the user system interface
cable, or to disconnect them when moving the emulator or the user system.

1. Check that the host computer is turned off or the emulator is not connected to the host
computer with the USB cable.

2. Connect the user system interface cable to the user-side connector of the emulator.
3. Connect the USB cable to the host-side connector of the emulator.

Figure 3.8 shows the position of the connector.

Connector for user system interface cable

Figure 3.8 Position of the Connector
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(1) The connector must be installed to the user system. Table 3.2 shows the recommended
connector for the emulator.

Table3.2 Recommended H-UDI Port Connector

Connector Type Number Manufacturer Specifications
14-pin connector  2514-6002 Minnesota Mining & 14-pin straight type
Manufacturing Ltd.
36-pin connector DX10M-36S Hirose Electric Co., Ltd. Screw type
DX10M-36SE, Lock-pin type

DX10GM-36SE

Notes: 1. When designing the 14-pin connector layout on the user board, do not place any
components within 3 mm of the H-UDI port connector.
When designing the 36-pin connector layout on the user board, do not connect other
signal lines to the H-UDI port connector.

2. The H-UDI isan interface compatible with the Joint Test Action Group (JTAG)
specifications.

(2) The pin assignments of the connector are shown in section 2 in the additional document,
Supplementary Information on Using the SHxxxx.

(3) Connect pins 2, 4, 6, 8, 10, 12, 14, 16, 18, 20, 22, 24, 26, 28, 30, 32, 33, 34, and 36 (when
using the 36-pin user system interface cable) and pins 9, 10, 12, 13, and 14 (when using the 14-
pin user system interface cable) of the H-UDI port connector to GND firmly on the PCB.
These pins are used as electrical GND and to monitor the connection of the H-UDI port
connector. Note the pin assignments of the H-UDI port connector.
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H-UDI port connector

M

@ 7 User system

Pin1

User system interface cable

Figure3.9 Connecting the User System Interface Cableto the User System
when the 36-pin Type Connector isUsed

User system interface cable

Tab

GND line
H-UDI port
connector

User system GND
connection

User system

Figure3.10 Connecting the User System Interface Cableto the User System
when the 14-pin Type Connector is Used
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CAUTION

Note that the pin number assignments of the connector
differ from those of the connector manufacturer.

Notes. 1. Connection of the signals differs depending on the package. For details, refer to the

device' s pin assignments.

2. Toremove the 14-pin type user system interface cable from the user system, pull
the tab on the connector upward.

3. Therange of communication that the emulator operates at is different depending on
the device used.

4. To connect the signals from the connector, refer to section 1 in the additional
document, Supplementary Information on Using the SHxxxx.

5. When developing user systems, do not connect the TDI and TDO signals of the
device to the boundary scan loop, or separate them by using a switch (figure 3.11).
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H-UDI SHxxxx
port
] TDI
TDO H-UDI
JTAG Ic IC . IC
port
[ _TDI| | | _{TDO TDI| | TDQ , . . TDI TDO
TAP TAP TAP
Boundary scan loop
User system

TDI: Test data input
TDO: Test data output
TAP: Test access port

Figure3.11 User System Example
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3.7 Connecting System Ground

A\ WARNING

Separate the frame ground from the signal ground at the
user system. Failure to do so will result in a FIRE HAZARD
and will damage the user system and the emulator product or
will result in PERSONAL INJURY.

The emulator's signal ground is connected to the user system's signal ground. In the emulator, the
signal ground and frame ground are connected. In the user system, connect the frame ground only;
do not connect the signal ground to the frame ground (figure 3.12).

If it isdifficult to separate the frame ground from the signal ground in the user system, set the
GND for DC power input (AC adapter) of the host computer and the frame ground of the user
system as the same potential. If the GND potential is different between the host computer and the
target system, an overcurrent will flow in the low-impedance GND line and thin lines might be
burned.

Signal ground E10A-USB emulator User system
Signal Signal

- Logic
Host @ o9 / A /\ \

computer / \ / \ |_
P X e
Signal ground Signal ground

Power
supply

Frame ground (

Figure3.12 Connecting System Ground
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3.8 Setting the DIP Switches

AWARNING

Do not change switches (SW2 and SW3) while the
emulator and the user sytem are turned on. The changing of
switches (SW2 and SW3) will result in a FIRE HAZARD and
will damage the user system and the emulator product. The
USER PROGRAM will be LOST.

The emulator incorporates a switch (SW1) for setting up the emulator, a switch (SW2) for
determining whether or not UVCC** is connected, and a switch (SW3) for determining which pins
of the H-UDI port connector are assigned to the /CA pin** and the /AUDMD pin*°. To change
these settings, use the DIP switches that are attached to the lower right of the emulator's upper
side. To open the dliding switch cover, dlide it to the right. The DIP switches consist of three
switches (SW1 to SW3) as shown in figure 3.13. When they are in the upper position, the
emulator isturned on. When they are in the lower position, the emulator is turned off.
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r N\

RENESAS

USER I/F

(0

= /weq N J

)

)

//8 B I=HI=

ON TOFF
( f 2 3

Figure3.13 DIP Switches

Notes: 1. When the VCC pin (I/0O power supply) on the user system is connected to the UVCC
pin, the emulator is able to operate at the same voltage level of the user interface as
VCC.
2. The/CA pinisonly supported by the SH-Moaobile microcomputers.
3. The/AUDMD pinisonly supported by microcomputers with the SH2-series RAM
monitoring function.

Tables 3.3 through 3.8 show the rel ationships between settings and functions of DIP switches 1 to
3. Use the settings depending on the usage of the user system.

CAUTION

Use only the settings shown in tables 3.3 to 3.8. Use of
other settings will not activate the emulator. The USER
PROGRAM will be LOST.
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e Settings for use of the 36-pin interface cable

Description: When the VCC (1/0 power supply related to the H-UDI) of the user system is
connected to the UV CC pin of the H-UDI port connector, set the UV CC with the power supplied.
Here, the I/O voltage of the user interface appliesto the ranges between 1.8 V to 5.0 V. If the VCC
is not connected, set the UV CC as disconnected.

Table 3.3 Switch Settings of the E10A-USB (Using SH-M obile Series 36-pin | nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
Swi SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 0 (off) 3.3V fixed N.C. /CA UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V [CA uvccC Power is supplied
to UVCC

Table3.4 Switch Settings of the E10A-USB (Using SH-2 Series 36-pin I nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
SwWi1 SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 1 (on) 3.3V fixed /AUDMD N.C. UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V /AUDMD uvCccC Power is supplied
to UVCC

Note: The /AUDMD and CK pins are only supported by microcomputers with the SH2-series RAM
monitoring function. When SW2 = 0 and SW3 = 1, the CK pin can be connected to pin 29.
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Table3.5 Switch Settings of the E10A-USB (Using SH-3/SH-4 Series 36-pin I nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface I/O Connected Connected
SW1 SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 1 (on) 3.3V fixed N.C. N.C. UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V N.C. uvCccC Power is supplied
to UVCC

Table 3.6 Switch Settings of the E10A-USB (Using New_SH-Moobile Series/ SH-4A Series
Productswith 4-bit AUD Bus Width/SH-2A Series 36-pin I nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
Swi1 SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 1 (on) 1 (on) 1.8Vto50V N.C. uvCccC Normally used

Table 3.7 Switch Settings of the E10A-USB (Using SH-4A Series 36-pin Interface for
Productswith 8-bit AUD Bus Width)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
Swi1 SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 1 (on) 1 (on) 3.3V fixed AUDATAS AUDATAG6 Normally used
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e Settings for use of the 14-pin interface cable

Description: When the VCC (1/0 power supply related to the H-UDI) of the user system is
connected to the UV CC pin of the H-UDI port connector, set the UV CC with the power supplied.
Here, the I/O voltage of the user interface appliesto the ranges between 1.8 V to 5.0 V. If the VCC
is not connected, set the UV CC as disconnected.

Table 3.8 Switch Settings of the E10A-USB (Using SH-Mobile Series 14-pin | nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
Swi SW2 SW3 Voltage to Pin 8 to Pin 11 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 0 (off) 3.3V fixed N.C." /CA UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V [CA uvccC Power is supplied
to UVCC

Note: Pin 8 can be connected to GND.

Table3.9 Switch Settings of the E10A-USB (Using SH-2 Series 14-pin I nterface)

Switch Settings State of the E10A-USB
User- Signal to be  Signal to be
interface /O Connected Connected
SW1 SW2 SW3 Voltage to Pin 8 to Pin 11 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 1 (on) 3.3V fixed N.C." N.C. UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V N.C. uvcc Power is supplied
to UVCC
Note: Pin 8 can be connected to GND.
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Table3.10 Switch Settings of the E10A-USB (Using SH-3/SH-4 Series 14-pin I nterface)

Switch Settings

State of the E10A-USB

User- Signal to be  Signal to be
interface I/O Connected Connected
SW1 SW2 SW3 Voltage to Pin 8 to Pin 11 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 0 (off) 1 (on) 3.3V fixed N.C.* N.C. UVCC is
disconnected
1 (on) 1 (on) 1.8Vto50V N.C. uvCccC Power is supplied
to UVCC
Note: Pin 8 can be connected to GND.

Table3.11 Switch Settings of the E10A-USB (Using New_SH-M obile Series/SH-4A Series
Products with 4-bit AUD Bus Width/SH-2A Series 14-pin I nterface)

Switch Settings

State of the E10A-USB

User- Signal to be  Signal to be
interface /O Connected Connected
Swi1 SW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is
only set up
1 (on) 1 (on) 1 (on) 1.8Vto50V N.C. uvCccC Normally used

Table 3.12 Switch Settings of the E10A-USB (Using SH-4A Series 14-pin I nterface for
Productswith 8-bit AUD Bus Width)

Switch Settings

State of the E10A-USB

User- Signal to be  Signal to be

interface /O Connected Connected
Swi SwW2 SW3 Voltage to Pin 15 to Pin 29 Condition
0 (off) - - - - - The emulator is

only set up

1 (on) 1 (on) 1 (on) 3.3V fixed N.C. N.C. Normally used
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3.9 I nterface Circuitsin the Emulator

Figures 3.14 through 3.17 show interface circuits in the emulator. Use them as areference to
determine the value of the pull-up resistance.

Note: The 74LVC2G125 operatesat 3.3V or VCC (1.8 to 5.0 V) from the H-UDI port
connector (changed by the switch).

R20UT0870EJ1000 Rev. 10.00 Page 42 of 292
Aug 10, 2012 RENESAS



SuperH™ Family E1I0A-USB Emulator

Section 3 Preparation before Use

Emulator control circuit

3.3y H-UDI port connector

SW2, SW3

74LVC2G125
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Figure3.14 Interface Circuitsin the Emulator (H-UDI)
(New_SH-Mabile Series/ SH-4A Series/ SH-2A Series)
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Emulator control circuit
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Figure3.15 Interface Circuitsin the Emulator (AUD)
(New_SH-Mabile Series/ SH-4A Series/ SH-2A Series)

R20UT0870EJ1000 Rev. 10.00
Aug 10, 2012

RENESAS

Page 44 of 292




SuperH™ Family E1I0A-USB Emulator

Section 3 Preparation before Use

Emulator control circuit
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Figure3.16 Interface Circuitsin the Emulator (H-UDI)

(SH-Mobile Series/ SH-4 Series/ SH-3 Series/ SH-2 Series/ MPEG Series)
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Emulator control circuit
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Figure3.17 Interface Circuitsin the Emulator (AUD)

(SH-Mobile Series/ SH-4 Series/ SH-3 Series/ SH-2 Series/ MPEG Series)

R20UT0870EJ1000 Rev. 10.00

Aug 10, 2012

RENESAS

Page 46 of 292




SuperH™ Family E1I0A-USB Emulator Section 3 Preparation before Use

3.10  Setting up the Emulator
Set up the emulator’ s firmware using the following procedures.

Note:  Only one device group can be set up using the setup tool when the emulator is purchased.
Be sure to check the device group you have selected on the label for product management
attached to the back of the emulator box. To use the emulator for another device group
after set up, purchase the license tool to add a device group.

CAUTION

Do not disconnect the USB cable unless instructed to do
so by an on-screen message. Incorrect operation will damage
the emulator product.
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3.10.1  Setting up at Purchasing the Emulator or Updating the Version of Software

Note: If you are using the HSOO05K CUO1H (serial No.: 03311C or later) or HSO0005K CUO2H
(serial No.: 04146E or later) emulator hardware, the below procedure may not be required;
follow the procedure only when the dialog box shown in figure 3.18 or 3.19 is displayed
by using the procedure described in section 3.11, System Check.

& The product currenthy connected is not the SHxxxx E10A-USE Emulator

Figure3.18 [Theproduct currently connected] Dialog Box

The wersion of the emulatar firmware is incorrect.
Flease set up the emulator by using the setup tool

Figure3.19 [Theversion of the emulator firmwareisincorrect] Dialog Box

1. Open the diding switch cover and check that the switch (SW1) for setting the emulator is
turnedto‘1’.

2. Select [Renesas] -> [High-performance Embedded Workshop] -> [Tools] -> [ Setup tool for
E10A-USB Emulator] -> [SHxxxx Device Group] from [Programs] in the [Start] menu. A tool
for setting up the emulator is activated.
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of B Too
@ Hugh—por lor mance Embecdod Wiskshon
3 e Erbit

2 ¥ich-pe ResdHe

Figure3.20 [Start] Menu

E'15 Setup tool for 5 « E1 0A-USE Emulator
Device group of the emulator firmware I ----- o — (&
VYersion number of the emulataor firmware I - ——®
Wersion number of the setup progranm I 1.1.00.000 — @

Start setting up the emulator?

Exit |

Figure3.21 Setup Tool for Emulator

(a) Device group of the emulator firmware: Name of the device group currently set.

(b) Version number of the emulator firmware:  The version number of software for controlling
the SHxxxx group in the emulator. Thisitemis
displayed only when the SHxxxx group is
available.

(c) Version number of the setup program: The version number of the setup program.
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Notes: 1. If theversion numbers shownin (b) and (c) are the same, setup of the emulator is not
required. Setup the emulator only when “-.-.--.---* is shown in (b) or the version
number of (b) is older than that of (c).
2. If an emulator other than the SHxxxx E10A-USB is connected, the following error
message will be displayed to exit the setup tool.

Setup tool for SHxox E10A-USE Emulatar El

Q The product currently connected is not the SHxex E108-USE Emulator.

Figure3.22 Error Message

3. If thefollowing error message is displayed, the host computer is not connected to the
emulator or the setup switch (SW1) isturnedto ‘0’.

Setup tool for SHxex E108-USE Emulator 5'

& Shift the switch [3W1) for setting up the emulator to "17 and re-insert the USB cable.

CANCEL |

Figure3.23 Error Message
If the setup switch (SW1) isturnedto ‘0, setitto ‘1’ and connect the USB cable again.

3. Clicking the [Setup] button displays the following dialog box.

5 10A-USE Emulatar x|

Setup tool for

.-’.'-\ Shift the switch (SWl) for setting up the emulator to '0' and re-insert the USE cable.

Once vou have preszed the [OK] button, do not disconnect the USE cable until ¥ Loading™ is finished.
Incorrect operation will damage the emulator product.

, ............... CI K ................ CANCEL I

Figure3.24 [Setup tool for SHxxxx E10A-USB Emulator] Dialog Box
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4. Turn the setup switch (SW1) to ‘0’, connect the USB cable again, and click the [OK] button.
Setting up the emulator’ s firmware is started.

Notes: 1. If thefollowing dialog message is displayed, insert the USB cable again.

Setup tool for 5 < E108-USE Emulator

? It failed in the initiahzation.
s Re-inzert the USE cable.

Cancel |

Figure3.25 [Setup tool for SHxxxx E10A-USB Emulator] Dialog Box
2. When [Add New Hardware Wizard] is displayed, select [Install the software
automatically].

3. Although adialog box will be displayed to indicate disconnection of the USB, thisis
not a problem.

CAUTION

Do not turn off the host computer or disconnect the USB

cable while setting up the emulator. The emulator may be
damaged.

How loading. ..

Do not dizconnect the USE cable until “Loading” iz finished.

Figure3.26 Start of Setting up the Emulator
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5. When the following dialog box is displayed, setting up the emulator is completed.

Setup tool for 5 E10A-USE Emulator

& Setup was completed successiully.

Figure 3.27 Message for Completion of Setting up the Emulator

6. When setting up the emulator has been completed, the following message will be displayed.
Turn the setup switch (SW1) to *1’, connect the USB cable again, and click the [OK] button.

EH 0A-LSEB Emulator

Setup tool for SH:

& Shift the switch (SWH ) for setting up the emulator to 17 and re—insert the USEB cakble.

Figure3.28 [Setup Tool for SHxxxx E10A-USB Emulator] Dialog Box

Notes: 1. Besureto turn the setup switch (SW1) to ‘1’ except when the setup tool is used.

2. Tousethelicensetool for another device group, it is necessary to set up the firmware
by using the setup tool or license tool that corresponds to the device group. To use the
setup tool, however, the license tool must also be installed. For details on the license

tool, refer to the following section.
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3.10.2  Setting up the Emulator by Using the License Tool to Add a Device Group

In the license tool, the emulator for the current product group can be used for debugging another
product group (device group such as SHxxxx Device Group, H8S Device Group, or H8SX Device
Group that is supported by the emulator).

In this section, the names of the device group that have already been installed and another device
group to be added by the license tool are shown as SHxxxx Device Group and H8S Device Group,
respectively. Replace these names according to your environment when you read this section.

The license tool to add a device group does not include software for the EL0A-USB emulator.

Install the software for your product group by using the CD-R provided for the emulator or
accessing the data on the web site.

Note: If no product groups have been installed in the emulator at the time of purchase, do not use
the license tool.
Refer to section 3.10.1, Setting up at Purchasing the Emulator or Updating the Version of
Software, and use the setup tool.

(1) Installing the emulator

Inserting the CD-R into the CD-ROM drive automatically activates the installation wizard (to
prevent automatic activation, insert the CD-R by pressing the Shift key). If the installation wizard
is not automatically activated, execute setup.exe from the root directory of the CD-R.

Follow the instructions by the installation wizard.
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(2) Setting up the emulator

1. Open the dliding switch cover and check that the switch (SW1) for setting the emulator is
turnedto ‘1.

2. Select [Renesas] -> [License tool for EL0A-USB] -> [H8S Device Group] from [Programs] in
the [Start] menu. This starts up the license tool to add a device group to the emulator.

Accessories B

OCUMEnES Startup »

4 @ High-performance Embeddad Wotkshop  #

o [

ettings

[ns
ol
=

-b Renesas AutoUpdate
&) Renesas Tools HomePage

G s Ly

=

Figure3.29 [Start] Menu

Fl+ License tool for H8S E10A-USB Emulator [ ]

Device group of the emulator firmware I SH0 (&)
Yerzion number of the emulator firmware I g — (bl
Version number of the setup prozram I 1.0.00.000 ()

dtart zetting up the emulator?

setup |

Figure3.30 License Tool for Emulator

(a) Device group of the emulator firmware: Name of the device group currently set.

(b) Version number of the emulator firmware:  The version number of software for controlling
the H8S Device Group in the emulator. Thisitem
is displayed only when the H8S Device Group is
available.

(c) Version number of the setup program: The version number of the setup program.
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Notes: 1. If theversion numbers shownin (b) and (c) are the same, setup of the emulator is not
required. Set up the emulator only when “-.-.--.---* isshown in (b) or the version
number of (b) is older than that of (c).

2. If thefollowing error message is displayed, the host computer is not connected to the
emulator or the setup switch (SW1) isturned to ‘0'.

License tool for HES E10A-USEB Emulator

L] "-n,, Shift the switch (SW1) for zetting up the emulator to 1" and re-inzert the USE cable.
L]

; CANCEL |

Figure3.31 Error Message
If the setup switch (SW1) isturnedto ‘0, setitto ‘1’ and connect the USB cable again.

3. Click the [Setup] button.
When the following dialog box is displayed, turn the setup switch (SW1) to ‘0’, connect the
USB cable again, and click the [OK] button.

License tool for HBS E10A-USE Emulator |

"-\ Shift the switch (SW1) for setting up the emulator to '0' and re-insert the USE cable.
-

Once you have pressed the [OK] button, do not disconnect the USE cable until * Loading™ iz finished.
Incorrect operation will damage the emulator product.

e CANCEL |

Figure3.32 [Licensetool for H8S E10A-USB Emulator] Dialog Box

4. Setting up the emulator’s control software is started.
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Notes: 1. If thefollowing dialog message is displayed, insert the USB cable again.

Licensze tool for HBS E10A-USB Emulator
? It failed in the initialization.
s Re-inzert the USE cable.

Cancel |

Figure3.33 [Licensetool for H8S E10A-USB Emulator] Dialog Box
2. When [Add New Hardware Wizard] is displayed, select [Install the software
automatically].

3. Although adialog box will be displayed to indicate disconnection of the USB, thisis
not a problem.

CAUTION

Do not turn off the host computer or disconnect the USB

cable while setting up the emulator. The emulator may be
damaged.

How loading. ..

Do not dizconnect the USE cable until “Loading” iz finished.

Figure3.34 Start of Setting up the Emulator
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5. When the following dialog box is displayed, setting up the emulator is completed.

License tool for HES E10A-USEB Emulator

L] "-n. Setup wasz completed successfully.
L]

Figure3.35 Message for Completion of Setting up the Emulator

6. When setting up the emulator has been completed and the following message is displayed, turn
the setup switch (SW1) to ‘1’, connect the USB cable again, and click the [OK] button.

License tool for HES E10A-USEB Emulator

L] "-n,, Shift the switch (SW1) for zetting up the emulator to 1" and re-inzert the USE cable.
L]

Figure3.36 [Licensetool for H8S E10A-USB Emulator] Dialog Box

Notes: 1. Besureto turn the setup switch (SW1) to ‘1’ except when the license tool for adding
device groupsis used.

2. Tousethelicensetool for another device group, it is necessary to set up the firmware
by using the setup tool or license tool that corresponds to the device group. To use the
setup tool, however, the license tool must also be installed. For details on the setup
tool, refer to section 3.10, Setting up the Emulator, in the SuperH™ Family E10A-USB
Emulator User's Manual, or H8S, H8SX Family E10A-USB Emulator User’s Manual.

3. After you have added a device group by using the license tool, place the attached
device-group sticker onto the back of the emulator box. Otherwise, the emulator may
not be considered as atarget product when repair is required. The license tool provides
alicense to use the target device group. Be sure to acquire alicense for each of the
E10A-USB emulators being used with that device group.
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311  System Check

When the software is executed, use the procedure below to check that the emulator is connected
correctly. Here, use the workspace for atutorial provided on the product.

Refer to section 4, Preparations for Debugging, for the other activating method to create a new
project or use an existing workspace.

Connect the emulator to the host computer.
Connect the user system interface cable to the connector of the emulator.
Connect the user system interface cable to the connector in the user system.

Select [Renesas] -> [High-performance Embedded Workshop] -> [High-performance
Embedded Workshop] from [Programs] in the [Start] menu.

A w NP

Accessories
Startup

@ Administrative Tools [Comman)

L r,El_- High-per

Command Frompt
e Internet Explarer

o Help
@ High-performance Embedded Workshop Read Me

ns
@ Documents

Figure3.37 [Start] Menu

Note: The [High-performance Embedded Workshop] -> [Tools] is not displayed depending on
the user’s environment.
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5. The[Welcome!] dialog box is displayed.

Welcome!
Cptions: oK |
| f* Lireate a new project workzpace; Cancel |
[ Open arecent project workspace: Bdministration... |
—
i j " Browse to another project workspace
Figure 3.38 [Welcomel] Dialog Box
[Create a new project workspace] radio button: Creates a new workspace.
[Open arecent project workspace] radio button: Uses an existing workspace and displays

the history of the opened workspace.

[Browse to another project workspace] radio button:  Uses an existing workspace; this radio
button is used when the history of the
opened workspace does not remain.

To use aworkspace for the tutorial, select the [Browse to another project workspace] radio button
and click the [OK] button.

When the [Open workspace] dialog box is opened, specify the following directory:
<Drive where the OS has been installed>: \WorkSpace\Tutoria\E10A-USB\xxxx\Tutorial

Here, ‘xxxx’ means the target product group.
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After the directory has been specified, select the following file and click the [Open] button.

2| x|
Laok jn: Ia Tutorial j . £ Ef-

File: narne: |Tuturia|.hws Open I
Files of bype: IWDrkspaces [* hwz] j Cancel |
o

Figure3.39 [Open Workspace] Dialog Box

6. The[CPU Select] dialog box is displayed.

CPU Select X

GPU Select
|8Hxxxx ﬂ

v Search the best JTAG clock:

(0] 4 | Cancel |

Figure3.40 [CPU Select] Dialog Box
The [CPU Select] dialog box has the following options.

e [Searchthe best JTAG clock] check box
Search the JTAG clock values and start up with the highest available value as the initial
value.

Note: Opening this dialog box may not be possible. This depends on the device in use.

Select the CPU from the drop-down list and click the [OK] button.
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7. The[Select Emulator mode] dialog box is displayed depending on the MCU/MPU used.

Select Emulator mode : EI

Device

== & E10A-USE Emulator

" Writing Elash memary

Cancel_ |

Figure3.41 [Select Emulator mode] Dialog Box

Select the MCU/MPU name in use from the [Device] drop-down list box. The following items are
selectable in the [Mode] group box.

— E10A-USB Emulator
The E10A-USB emulator for the specified MCU/MPU is activated. Debugging the
program is enabled.

— Writing Flash memory
The user program is programmed to the internal flash memory. To download aload
module, register it in the workspace. Do not attempt anything other than downloading of
the load module.
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8. The[Connecting] dialog box is displayed and the emulator connection is started.

Figure 3.42 [Connecting] Dialog Box

9. Thedialog box shown in figure 3.43 is displayed if no product groups have been installed in
the emulator at the time of purchase or if the SHxxxx license has been installed in the emulator
but the emulator firmware has been set up for a different device group. The dialog box shown
infigure 3.44 isdisplayed if an old version of the emulator firmware has been set up in the
emulator. Clicking the [OK] button sets up the emulator firmware.

hexxxx E3

& SHxoo: E108-USE emulator firmware will be zet up.

Once you have pressed the [OK] button, do not disconnect the USE cable until * Loading™ iz finished.
Incorrect operation will damage the emulator product.

e CANCEL |

Figure 3.43 Dialog Box to Confirm Setting up of the Emulator Firmware
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hexxxx E

& SHxoo: E108-USE emulator firmware will be updated.

Once vou have preszed the [OK] button, do not disconnect the USE cable until ¥ Loading™ is finished.
Incorrect operation will damage the emulator product.

, ............... CI K ................ CANCEL I

Figure 3.44 Dialog Box to Confirm Updating of the SHxxxx Emulator Firmware

CAUTION

The USB cable must not be disconnected until writing is
complete. Early disconnection may damage the emulator.

Note: The above dialog boxes are only displayed if you are using the HSO005K CUO1H (serial
No.: 03311C or later) or HSOO05K CUO2H (serial No.: 04146E or later) emulator
hardware. In this case, follow the procedure described in section 3.10.1, Setting up at
Purchasing the Emulator or Updating the Version of Software.

10. The dialog box shown in figure 3.45 is displayed.

hexxxx |

& Fleaze, Feszet the user system and press <Enterr Fey.

Figure3.45 Dialog Box of the RESET Signal Input Request M essage

11. Power on the user system.
12. Input the reset signal from the user system, and click the [OK] button.
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13. If no reset signal is detected, the following dialog box is displayed.

hexx=x
Can not find ARESET signal.
Fleaze check /RESET and “cc.

Betry | lgnore |

Figure3.46 [Can not find /RESET signal] Dialog Box

When the [Ignore] button is clicked, the emulator issues areset in the CPU for initiation.
However, this method is unavailable for some products. For details, refer to section 2.2,
Specific Functions for the Emulator when Using the SHxxxx, in the additional document,
Supplementary Information on Using the SHxxxx.

14. When using the MCU with flash memory, the [Clock] dialog box shown in figure 3.47 is
opened.
For the [Clock] dialog box, set the frequency of the crystal oscillator which has been connected
to or the external clock which has been input to the target microcomputer (MCU).

Cilock

Clock |10 MHz
Set the frequency of the crvstal rezonator connected to the MCL in Cancel |

uze or the external clock being input.

Figure 3.47 [Clock] Dialog Box
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15. After the following dialog box is displayed, input the ID code as a security code for the flash
memory. However, H' FFFFFFFF is disabled asthe ID code.
Input this ID code when [E10A-USB Emulator] is selected and the [New 1D code] check box
is unselected on activating the emulator. If the ID code is not matched or the [New ID code]
check box is selected, the flash memory contents are erased.

ID Code 5'

Pleaze input ID Code

—

[+ Mew ID code

I I Cancel

Figure 3.48 [ID Code] Dialog Box

16. When "Connected" is displayed in the [Output] window of the High-performance Embedded
Workshop, the emulator initiation is completed.

& =]

L.

Connected

| [\Build f\DehugA Find in Files }\Macru f\Test f\ ‘ersion Control /

Figure3.49 [Output] Window

Note:  When the user program has aready been downloaded to the flash memory, source-level
debugging cannot be executed because there is no debugging information on the user
program after the emulator has been activated. Be sure to load the debugging information
file. For details, refer to section 4.2.1, Setting at Emulator Activation.
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Notes: 1. If the emulator isnot initiated, the following dialog boxes shown in figures 3.50
through 3.56 will be displayed.
(a) If the following dialog box is displayed and the method 11 above is unavailable, the
power of the user system may not be input or the RESET signal may not be input to
the device. Check theinput circuits for the power of the user system and the reset pin.

hexxxx

Can not find ARESET signal.
Fleaze check /RESET and “cc.

Figure3.50 [Can not find /RESET signal] Dialog Box

(b) If the following dialog box is displayed, check that the H-UDI port connector on the
user system is correctly connected.

hexxxx |

& Check the connection between the H-UD| ping and the H-UD| port connectar.

Figure3.51 [Check the connection] Dialog Box
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(c) If thefollowing dialog box is displayed, the emulator’ s firmware may not be set up
correctly. Set up the firmware of the device group that is used for the setup tool or
license toal.

& The product currenthy connected is not the SHxxxx BI0A-USE Emulator

Figure3.52 [Theproduct currently connected] Dialog Box

(d) If the following dialog box is displayed, the version of the firmware in the emulator
may be old. Set up the firmware by using the setup tool.

The wversion of the emulator firmware is incorrect.
Pleaze set up the emulator by using the setup tool

Figure 3.53 [Theversion of the emulator firmwareisincorrect] Dialog Box
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(e) If thefollowing dialog box is displayed, the device may not correctly operate. Check
if there are reasons for illegal device operation.

& COmMMUMICATION TIMEQUT ERROR

Figure3.54 [COMMUNICATION TIMEOUT ERROR] Dialog Box

hexxxx

& INYALID ASERAM FIRMWARE !

Figure3.55 [INVALID ASERAM FIRMWARE!] Dialog Box

hexxxx

& Error JTAG boot

Figure3.56 [Error JTAG boot] Dialog Box
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(f) Thefollowing dialog box is displayed when the flash memory cannot be erased.
Change the MCU since the flash memory has been reprogrammed more times than the
limitation.

E104-USB

1 Flazh memory eraze error!
= Chanee device.

Figure3.57 [Flash memory eraseerror!] Dialog Box
Note: If amodeisillegally set, the error message shown in figure 3.57 will be displayed.

(9) Thefollowing dialog box is displayed when the flash memory cannot be
reprogrammed. An incorrect system clock value has been input to the [Clock] dialog
box or the flash memory has been reprogrammed more times than the limitation.

E104-USB

] 'f Error zending Flash memory write program
L

Figure3.58 [Error sending Flash memory write program] Dialog Box
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(h) Thefollowing dialog box is displayed when an incorrect ID code has been input. For
security, the flash memory is completely erased.

E10A-USB x|

L] 'f ID code error!
L

Figure3.59 [ID codeerror!] Dialog Box

(i) Thefollowing dialog box is displayed when the MCU cannot communicate with the
emulator. The MCU may not operate correctly; check the MCU settings.

E10A-USB X

L] E Boot Failed !
[ ]

Figure3.60 [Boot Failed!] Dialog Box
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2. If anincorrect driver has been selected, the following dialog box will appear.

E10A-USB

t Unable to restore the previous driver settings
= pleaze choose another driver.

Figure3.61 [Unabletorestorethepreviousdriver settings] Dialog Box

3. If the emulator is not activated due to other reasons, a message box corresponding to
the statusis displayed. Use the message as a reference to check the wiring on the
board.
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Section 4 Preparations for Debugging

4.1 Method for Activating High-performance Embedded Workshop
To activate the High-performance Embedded Workshop, follow the procedure listed below.

1. Connect the emulator to the host computer and the user system, then turn on the user system.

2. Select [High-performance Embedded Workshop] from [Renesas] -> [High-performance
Embedded Workshop] of [Programs] in the [Start] menu.

3. The[Welcome!] dialog box is displayed.

Welcome!
Cptions: oK |
| f* Lireate a new project workzpace; Cancel |
[ Open arecent project workspace: Bdministration... |
o
" Browse to anather project waorkspace
Ly
Figure4.1 [Welcome!] Dialog Box
[Create a new project workspace] radio button: Creates a new workspace.
[Open arecent project workspace] radio button: Uses an existing workspace and displays

the history of the opened workspace.

[Browse to another project workspace] radio button:  Uses an existing workspace; this radio
button is used when the history of the
opened workspace does not remain.
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In this section, we describe the following three ways to start up the High-performance Embedded
Workshop:

e [Create anew project workspace] - atoolchain isnot in use
e [Create anew project workspace] - atoolchainisin use
e [Browseto another project workspace]

The operation of [Open a recent project workspace] radio button is same as the operation without
specifying the workspace file when [Browse to another project workspace] is selected.

4.1.1 Creating the New Workspace (Toolchain Not Used)

1. Inthe[Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Create a new project workspace] radio button and click the
[OK] button.

Welcome!

Options: 0K |

| (v Treate a new project workspace! Cancel |

., " Open arecent project workspace: Ldministration.. |
—

i = Browsze to another project workzpace
Figure4.2 [Welcomel!] Dialog Box
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2. The Project Generator is started. In this section, we omit description of the settings for the
toolchain.
If you have not purchased the toolchain, the following dialog box is displayed.

Wiorkspace Mame:
hest

Froject Mame:
hest

Directory:

IO:'\WorkSpace'\test Browze.. |

CPU familw:
|SuperH RISC engine j

Tool chain:

| Mok j

Properties... |

(0] 4 I Cancel

Figure4.3 [New Project Workspace] Dialog Box

[Workspace Name] edit box: Enter the new workspace name. Here, for example, enter ‘test’.

[Project Name] edit box: Enter the project name. When the project name is the same as
the workspace name, it needs not be entered.

Other list boxes are used for setting the tool chain; the fixed information is displayed when the
toolchain has not been installed.
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3. Makethe required setting for the toolchain. When the setting has been completed, the
following dialog box is displayed.

Setting the Tareet System for Debugeine

— Targets :
MsH—x E108-USE 5%5

i 11l l
Target type : ISH‘><>< ;I
Tareet GPU:  |SHwoo -]

fewxt | Finizh | Cancel |

Figure4.4 [Settingthe Target System for Debugging] Dialog Box
Check the target emulator and click the [Next] button.

For details on the items that can be selected in this dialog box, refer to the file titled “MPUs
and M CUs Supported by the E1I0A-USB Emulator” (esupportdevice.pdf), which isincluded on
the CD of the E10A-USB emulator software.
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4. Set the configuration file name. The configuration file saves the state of High-performance
Embedded Workshop except for the emulator.

HSetting the Debugeer Options

Target name :

SH-xx E108-1U5B SYSTEM
Coare :

|<sing le corex ;I

Caonfiguration name :
|Del:-ug_5 H-:xx_E10A-USB_SYSTEM

— Detail optiong :

Item | Yalue

Iadify |
[ Initial zeszion

fewxt | Finizh | Cancel |

Figure4.5 [Setting the Debugger Options] Dialog Box

Thisisthe end of the emulator setting.

Click the [Finish] button to exit the Project Generator. The High-performance Embedded
Workshop is activated.

After the High-performance Embedded Workshop has been activated, the emulator is
automatically connected. For operation during connection, refer to section 3.11, System Check.
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4.1.2 Creating the New Wor kspace (Toolchain Used)

1. Inthe[Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Create a new project workspace] radio button and click the

[OK] button.

Welcome!

Options: 0K |

| (v Treate a new project workspace! Cancel |
o

" Qpen a recent praject workspace: Ldministration.. |

| [

""" = Browsze to another project workzpace

Figure4.6 [Welcome!] Dialog Box
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2. The Project Generator is started.
If you have purchased the toolchain, the following dialog box is displayed.

Mew Project Workspace

Frojects I
Wiorkspace Mame:
Demaonstration ItESt
I@ Empty prlicfatian Project Name:
T@Impurt Maketile Itest
G Library
Directory:
IG:\WDrkSpace\test Browse... |
CPU familw:
|SuperH RISC engine j
Tool chain:
| Renezaz SuperH Standard j
Properties... |
oK I Cancel
Figure4.7 [New Project Workspace] Dialog Box
[Workspace Name] edit box: Enter the new workspace name. Here, for example, enter
‘test’.
[Project Name] edit box: Enter the project name. When the project nameisthe

same as the workspace name, it needs not be entered.
[CPU family] drop-down list box: Select the target CPU family.

[Tool chain] drop-down list box:  Select the target toolchain name when using the toolchain.
Otherwise, select [Nong].

[Project type] list box: Select the project type to be used.

Note: When [Demonstration] is selected in the emulator, note the following:
The [Demonstration] is a program for the simulator. When the generated program is used
by the emulator, delete the Printf statement.
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3. Makethe required setting for the toolchain. When the setting has been completed, the
following dialog box is displayed.

New Project-7/9-Settine the Tareet System for Debueeing

— Targets :

[TsH-1 Simulator -~
[T5H-2 Simulator

[(]5H-2 SimulatoriLittle endian
MSH-24 E10A-LISE

[(JsH-2& FLASH E10A-USE SYSTEM
[(JSH2A custom_Sol E104-USE SYSTEM!
[(JsH-2A_CUSTOM! E10A-USE SYSTEM ¢
[JSHZ28-FPU Cwile Baze Simulatar
[15H2A-FPU E10A-USE SYSTEMISHZA) .

& | >
Target tvpe : |F'|II Targets |
Tareet GPU | All GPUs |

T Finish | Cancel |

Figure 4.8 [New Project —7/9— Setting the Target System for Debugging] Dialog Box
Check the target emulator and click the [Next] button.

For details on the items that can be selected in this dialog box, refer to thefile titled “MPUs
and M CUs Supported by the E1I0A-USB Emulator” (esupportdevice.pdf), which isincluded on
the CD of the E10A-USB emulator software.

Mark other products as required.
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4. Set the configuration file name. The configuration file saves the state of High-performance
Embedded Workshop except for the emulator.

New Project-859-Setting the Debueeer Options

Target name :

SH-28 E108-1U5E SYSTEM

Coare :

|<sing le corex ;I

Configuration name :

|Debug SH-28_E10A-USB_SYSTEM

— Detail options :

Item | Yalue

Iod ity |

[ Initial zes=ion

et | Finigh | Cancel |

Figure4.9 [New Project —8/9— Setting the Debugger Options] Dialog Box

Thisisthe end of the emulator setting.
Exit the Project Generator according to the instructions on the screen. The High-performance
Embedded Workshop is activated.

5. After the High-performance Embedded Workshop has been activated, connect the emulator.
However, it is not needed to connect the emulator immediately after the High-performance
Embedded Workshop has been activated.

To connect the emulator, use one of the methods (a) and (b) below. For operation during
connection, refer to section 3.11, System Check.
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(8) Connecting the emulator after the setting at emulator activation

Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box. Itis
possible to register the download module or the command chain that is automatically executed
at activation. For details on the [Debug Settings] dialog box, refer to section 4.3, Setting at
Emulator Activation.

After the [Debug Settings] dialog box has been set, when the dialog box is closed, the emulator
is connected.

(b) Connecting the emulator without the setting at emulator activation

The emulator can be easily connected by switching the session file that the setting for the
emulator use has been registered.

Eﬁ:!test — High—performance Embedded Workshop

File Edit VMiew Project Debug Setup Toolz Test 'indow Help

EEEE I DR T = A TEsors B liE ) <% &
-«

source file
dbscte

wecttblc

Figure4.10 Selecting the Session File

Inthelist box that is circled in figure 4.10, select the session file name including the character
string that has been set in the [Target name] text box in figure 4.9, [New Project —8/9— Setting the
Debugger Options| dialog box. The setting for using the emulator has been registered in this
session file.

After selected, the emulator is automatically connected.
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4.1.3 Selecting an Existing Workspace

1. Inthe[Welcome!] dialog box that is displayed when the High-performance Embedded
Workshop is activated, select [Browse to another project workspace] radio button and click the
[OK] button.

Welcome!
Options: oF |
(" Create a new project workspace Cancel |
" Open a recent praject workspace: Bdministration. |

| [

Y\ N

= Browse to another project warkspace;

Figure4.11 [Welcome!] Dialog Box

2. The[Open Workspace] dialog box is displayed. Select a directory in which you have created a
workspace.
After that, select the workspace file (.hws) and press the [Open] button.
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Open Workspace

Look in: Iasample j = I':'_hF B~

File name: | sample.frwvs Open I
Filez af bype: IWnrkspaces [* biz) j Cancel |
i

Figure4.12 [Open Workspace] Dialog Box

3. This activates the High-performance Embedded Workshop and recovers the state of the
selected workspace at the time it was saved.
When the saved state information of the selected workspace includes connection to the
emulator, the emulator will automatically be connected. To connect the emulator when the
saved state information does not include connection to the emulator, refer to section 4.4,
Connecting the Emulator.
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4.2 Setting at Emulator Activation

4.2.1 Setting at Emulator Activation

When the emulator is activated, the command chain can be automatically executed. Itisaso
possible to register multiple load modules to be downloaded. The registered load modules are
displayed on the workspace window.

1. Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box.

Debug Settines E|
| DefaultSession > Tareet | Options |
@ test

Debug format:

1<none> LJ

Download modules:

Filename Offset Address | Format Add..
QK | Cancel

Figure4.13 [Debug Settings] Dialog Box ([ Tar get] Page)

2. Select the product name to be connected in the [Target] drop-down list box.

3. Select the format of the load module to be downloaded in the [Default Debug Format] drop-
down list box, then register the corresponding download module in the [Download Modules]
list box.

Note: Here, no program has been downloaded. For downloading, refer to section 5.2,
Downloading a Program.
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4. Click the [Optiong] tab.

Debue Settings g'
|DefauItSession LJ Tareet Options ]
@ = Command batch flle load timine:

At tar tion

Command line batch procezzine:

¥ Dizable batch file execution when downloading debug infaormation

v Download modules after build

I” Remoave breakpoints on download

I~ Digable memory access until after target connection command file execution
Iv Limit disazszembly memary access

I~ Do naot perform automatic tareet connection
I Reszet GPU after download module
I Digable memory access by GUI when target iz executine

0K | Gancel

Figure4.14 [Debug Settings] Dialog Box ([Options] Page)

The command chain that is automatically executed at the specified timing isregistered. The
following four timings can be specified:

e At connecting the emulator

e Immediately before downloading
o Immediately after downloading

e |Immediately after areset

Specify the timing for executing the command chain in the [Command batch file load timing]
drop-down list box. In addition, register the command-chain file that is executed at the specified
timing in the [Command Line Batch Processing] list box.
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4.2.2 Downloading a Program
A download module is added under [Download modules] in the [Workspace] window.

Open the load module of [Download modules] in the [Workspace] window by clicking the right-
hand mouse button and select [ Download modul€] to start downloading the module.

|=| WeCTIDLG
-5 G+ zource file
Q zart.cpp

Q tutorial.cpp
-5 Download modules

] utorial 2

£ Dependencies Download
Cownload (Debug Data Only?

Download & Mew hModule..
Debue Settings..
Caonfigure Wiew...

v Gllow Docking
Hide

Properties..

|

Figure4.15 Download Menu of the [Workspace] Window ([Proj ects])

Notes: 1. When load modules are downloaded, select [Debug] -> [Download] -> [All DownL oad

Modules].
2. The emulator downloads programs to the flash memory just before execution of the
user program.
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4.2.3 Setting the Writing Flash Memory Mode

The following describes the procedures when the emulator is used as atool for programming of
the internal ROM. The load module to be downloaded to the new workspace is registered and
programmed.

Note: 1. When the [Writing Flash memory] mode is selected, command chains registered on the
[Options] page of the [Debug Settings] dialog box must be removed. The [Reset CPU
after download module] checkbox must also be desel ected.

2. The emulator is also usable as a programming tool in mass production when it is
operating in the [Writing Flash Memory] mode.
However, the flash memory of an actual MCU which has been used in connection with
the E10A-USB Emulator for debugging will have been programmed at emulation and
subjected to stress accordingly. Do not use an MCU that has been used for debugging
in amass-produced product.

(a) Select the new project workspace.
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Wiorkspace Mame:
hest

Froject Mame:
hest

Directory:

IO:\WorkSpace\test Browze.. |

CPU familw:
|SuperH RISC engine j

Tool chain:

| Mok j

Properties... |

(0] 4 I Cancel

Figure4.16 [New Project Workspace] Dialog Box
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(b) Select the target MCU and click the [Next] button.

New Project-7/9-Settine the Tareet System for Debueeing

— Targets :
SH-xx E108-U5

i 11If l
Target type : ISH‘><>< |
Tareet GPU | SHioo -]

T Finish | Cancel |

Figure4.17 [New Project —7/9— Setting the Target System for Debugging] Dialog Box
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(c) The[Select Emulator mode] dialog box is displayed.

belect Emulator mode [5_<|

Device

Mode

" E104-USE Emulatar

(o Writing Flash memaory

[ Do not ghow this dialog box again.

Figure4.18 [Select Emulator mode] Dialog Box

Select the [Writing Flash memory] mode.

(d) Turn on the target board, input the reset signal from the user system, and press the [OK]
button.

L] "_.,‘ Pleaze reset the uzer swstem and press <Enterr Kew.
[ ]

Figure4.19 Dialog Box of the RESET Signal Input Request M essage
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(e) For the [Clock] dialog box, set the frequency of the crystal oscillator which has been
connected to or the external clock which has been input to the target microcomputer
(MCU).

System Glock [?|
Clack: MHz
Set the frequency of the crystal rezonator connected to the MCL

- Al e Cancel
in uze or the external clock being input.

Figure4.20 [Clock] Dialog Box

(f) Select [Debug Setting] from the [Debug] menu.

Eﬁ! test — High—performance Embedded Workshop

File Edit Wiew Project Euild BEEIEN Setup Toolz Tegt  Window  Help
|y e Debug
[T = H @

O = Synchronized Debugging...

Debug Seszions..

=/t Reset GPL

G zource file
dbsctc
intpre.c
resetpre.c
A

TN

=] Go
2| Reset Ga Shift+F5

Figure4.21 High-performance Embedded Workshop Window
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(g) Select the target MCU and then the download module with the [Add...] button.

Debug Settinegs @E'

|SessionSH-xx_E10A-USB_SYSTEM =] Tareet | Options |

: Tareet:
Wik it I =
@ Wiite_only [SH-x E10A-USE SYSTEM ~]

Core:

Debug format:

1S—Record LJ

Download modules:

Filename | Offzet Address | Format Add..
CivWark SpacedWite_only A\ Write_only' 0. 00000000 5-Record o

0K | CGancel

Figure4.22 [Debug Setting] Dialog Box ([Tar get] Page)

(h) The download file is displayed on [Project Files].

E3)

Workspace

-3 Wite_only
-5 Write_only
-3 Download modules

il

£ Dependencies

N @ Projects I @ Templates @:lNa'u'igaﬁnn Test I

Figure4.23 [Workspace] Window ([Project Files])
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(i) Select and download the file with the right-hand mouse button.

Workspace
El@ Wik ite_only

= @ Write_only
El a Du:uwnl-:uau:l todules

------ a Dependenmes Dovinload
Download (Debue Data Only)
Unload

Dovnload & Mew Module..

Bemove

N @ijeclx | @ Templates

Debue Settings...

Configure “Wiew...

IT Ellow Docking
Hide

Felocate Module...

Properties...

Figure4.24 Download Menu of the [Workspace] Window ([Project Files])

(j) Thedialog box for sum checking is displayed and programming is completed. Sum datais
avalue that datain the internal ROM area has been added by byte. If no user program
exigts, the value is calculated by H’ FF.

Debueeer

1 Flazsh memary writing OF
\‘) Sum data=H'Dfeabb?f

Figure4.25 Message for Completion of Flash Memory Programming
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(k) When the following dialog box is displayed, click on the [OK] button. The debugging
platform is automatically disconnected.

HeushZa E'

L] "_n., The connection of the emulator iz releazed.
L

Figure4.26 Message for Exiting Writing Flash Memory Mode and Automatic
Disconnection
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4.3 Debug Sessions

The High-performance Embedded Workshop stores all of your builder optionsinto a
configuration. Inasimilar way, the High-performance Embedded Workshop stores your debugger
optionsin asession. The debugging platforms, the programs to be downloaded, and each
debugging platform’ s options can be stored in a session.

Sessions are not directly related to a configuration. This means that multiple sessions can share
the same download module and avoid unnecessary program rebuilds.

Each session’ s data should be stored in a separate file in the High-performance Embedded
Workshop project. Debug sessions are described in detail below.

4.3.1 Selecting a Session
The current session can be selected in the following two ways:

e From the toolbar
Select a session from the drop-down list box (figure 4.27) in the toolbar.

\Debug_E104_SYSTER + | | |SessionE104_SYSTEM +|

Figure4.27 Toolbar Selection
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e From the dialog box

1. Select [Debug -> Debug Sessions...]. Thiswill open the [Debug Sessions] dialog box
(figure 4.28).

Debue Seszions

Debug zeszions:
; onE10A SYSTEM B,

Bemove
Save az.
Properties...

Current zession:
SessionE10A SYSTEM |

K | Cancel

Figure4.28 [Debug Sessions] Dialog Box

2. Select the session you want to use from the [Current session] drop-down list.
3. Click the [OK] button to set the session.
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4.3.2 Adding and Removing Sessions

A new session can be added by copying settings from another session or removing a session.

e Toadd anew empty session

1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
Click the [Add...] button to display the [Add new session] dialog box (figure 4.29).
Check the [Add new session] radio button.
Enter aname for the session.
Click the [OK] button to close the [Debug Sessions] dialog box.

This creates a file with the name entered in step 4. If afile with this name aready exists,
an error is displayed.

o U A WN

Add new session

™ Add a new session

St | Cancel

(« |z an exizting session file

Hame: |tut|:|ria|

Seszion file path: | Browsze..

[v Cpen and maintain link to sezzion file

[ Make zeszion file link read only

Figure4.29 [Add new session] Dialog Box
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e Toimport an existing session into anew session file

1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
Click the [Add...] button to display the [Add new session] dialog box (figure 4.29).
Check the [Use an existing session fil€] radio button.
Enter a name for the session.

Enter the name of an existing session file that you would like to import into the existing
project or click the [Browse] button to select the file location.

If the [Open and maintain link to session file] check box is not checked, the imported new
session fileis generated in the project directory.

If the [Open and maintain link to session file] check box is checked, anew session fileis
not generated in the project directory but islinked to the existing session file.

If the [Make session file link read only] check box is checked, the linked session fileis
used as read-only.

6. Click the [OK] button to close the [Debug Sessions] dialog box.

a W

e Toremoveasession
1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
2. Select the session you would like to remove.
3. Click the [Remove] button.
Note that the current session cannot be removed.
4. Click the [OK] button to close the [Debug Sessions] dialog box.
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e To view the session properties
1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
2. Select the session you would like to view the properties for.
3. Click the [Properties] button to display the [Session Properties] dialog box (figure 4.30).

asession Properties

Mame: Sesgion _E10A-USE_SYSTEM ] :
Location: G Program Filest Renezas i Hew i Wikite_only 1 Wikite_onlvSes = |

Last modified:  1200:00, Wednesday, August 23, 2006 w
[ Bead only

Figure4.30 [Session Properties] Dialog Box

e To make asession read-only
1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
2. Select the session you would like to make read-only.
3. Click the [Properties] button to display the [Session Properties] dialog box (figure 4.30).

4. Check the [Read only] check box to make the link read-only. Thisisuseful if you are
sharing debugger-setting files and you do not want data to be modified accidentally.

5. Click the [OK] button.

e To save asession with adifferent name

1. Select [Debug -> Debug Sessions...] to display the [Debug Sessions] dialog box (figure
4.28).
Select the session you would like to save.
Click the [Save as...] button to display the [Save Session] dialog box (figure 4.31).
Specify the location to save the new file.

If you want to export the session file to another location, leave the [Maintain link] check
box unchecked. If you would like the High-performance Embedded Workshop to use this
location instead of the current session location, check the [Maintain link] check box.

6. Click the [Save] button.

a s~ wD
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Save n; Iasample j i e -

Release
SimDebug_=H-2

DetaultSession het
SimSessionSH-2 haf

File name: | Save I
Save az lwpe: ISessinns [*.hsf] j Carcel |

[ taintain ik
4
Figure4.31 [Save Session] Dialog Box
4.3.3 Saving Session Information
e Tosaveasession
Select [File -> Save Session].
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4.4 Connecting the Emulator
Select either of the following two ways to connect the emulator:

(a) Connecting the emulator after the setting at emulator activation

Select [Debug settings] from the [Debug] menu to open the [Debug Settings] dialog box. Itis
possible to register the download module or the command chain that is automatically executed
at activation. For details on the [Debug Settings] dialog box, refer to section 4.3, Setting at
Emulator Activation.

When the dialog box is closed after setting the [Debug Settings] dialog box, the emulator will
automatically be connected.

(b) Connecting the emulator without the setting at emulator activation

Connect the emulator by simply switching the session file to one in which the setting for the
emulator use has been registered.

File  Edit Miew Project Debug Setup Tools  Test Window Help
H DE g |é | * 72 ‘ {+} |“|§‘ 2 ] ] ||D5hug LI ||SESS\DHSH-XX_E1DA-Usj ‘ Vel |JJ%| =y &
I SultS ession -. -

(4.

EE="]
E\--@ test

=123 © source file
o dbscte
intpre.c
resetpre.c
sbrk.c
testc

< |&] vectthle

Figure4.32 Selecting the Session File

Inthelist box that is circled in figure 4.32, select the session file name including the character
string that has been set in the [ Target name] text box in figure 4.9, [New Project —-8/9— Setting the
Debugger Optiong| dialog box. The setting for using the emulator has been registered in this
session file.

After the session file name is selected, the emulator will automatically be connected. For details
on the session file, refer to section 4.3, Debug Sessions.
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45 Reconnecting the Emulator
When the emulator is disconnected, use the following way for reconnection:
Select [Debug -> Connect] or click the [Connect] toolbar button (3). The emulator is connected.

Note: The emulator must be selected in the [Target] drop-down list box of the [Debug Settings]
dialog box (seefigure 4.13, [Debug Settings] Dialog Box ([ Target] Page)) that is opened
by selecting [Debug settings] from the [Debug] menu.

4.6 Ending the Emulator
When using the toolchain, the emulator can be exited by using the following two methods:

¢ Canceling the connection of the emulator being activated
e Exiting the High-performance Embedded Workshop

(1) Canceling the connection of the emulator being activated
Select [Disconnect] from the [Debug] menu or click the [Disconnect] toolbar button ().

(2) Exiting the High-performance Embedded Workshop
Select [Exit] from the [File] menu.

A message box isdisplayed. If necessary, click the[Y eg] button to save a session. After
saving a session, the High-performance Embedded Workshop exits. If not necessary, click the
[No] button to exit the High-performance Embedded Workshop.

High—performance Embedded Workshop

' Seszion “SessionE104_SYSTEMY in project “tutorial” has been modified.
= Do wou want to save it?

Mo | Cancel

Figure4.33 [Session has been modified] M essage Box
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Section5 Debugging

This section describes the debugging operations and their related windows and dialog boxes.
51 Setting the Environment for Emulation

511 Opening the [Configuration] Dialog Box

Selecting [Setup -> Emulator -> System...] or clicking the [Emulator System] toolbar button ((#4))
opens the [Configuration] dialog box.
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512 [General] Page

Sets the emulator operation conditions.

Configeuration

General | Loading flash memory ]

Mode

Emulation mode

| Mar mal

-
aStep option |Disal:|les interrupts during zingle step execution ﬂ
UEC made Eml =l
PPG mode |Eml |
Memary area f* Marmal 1 Phvsical ¢ Wirtual

AUD clock 11/8 GPU clack
JTAG clock 1.25MHz
TLE Maode |TLEI mizs exception iz dizabled

Wihen TLE Error occurred |Display TLE error meszage to Dialog box

Feset Mode |F'.utu:|

Fead Status [w PGSR

PPC Option [v It counts during GPU zleep

I|mE|:|I_,|‘t 1 1 1 1 1 1 1 1 1 1

Figure5.1 [Configuration] Dialog Box ([General] Page)
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Items that can be displayed in the sheet are listed below.
[Mode] Displays the MCU/MPU name.

[Emulation mode] Selects the emulation mode at user program execution.
Select Normal to perform normal emulation.

Select No break to disable PC breakpoint or break condition
settings during emulation.

[Step option] Sets the step interrupt option.

Disable interrupts during single step execution: Disables
interrupts* during step execution.

Enable interrupts during single step execution: Enables
interrupts during step execution.

*Note: Include interrupts in abreak.

[AUD clock] A clock used in acquiring AUD traces. If its frequency is set
too low, complete data may not be acquired during realtime
tracing. Set the frequency not to exceed the upper limit for the
MCU/MPU's AUD clock. The AUD clock is only needed for
using emulators that have an AUD trace function. For the
upper limit for the AUD clock, refer to section 2.2.3, Notes on
Using the JTAG (H-UDI) Clock (TCK) and AUD Clock
(AUDCK), in the additional document, Supplementary
Information on Using the SHxxxx.

[JTAG clock] A communication clock used except for acquiring AUD trace.
If itsfrequency is set too low, the speed of downloading will
be lowered. Set the frequency not to exceed the upper limit for
the MCU/MPU's guaranteed TCK range. For the upper limit
for TCK, refer to section 2.2.3, Notes on Using the JTAG (H-
UDI) Clock (TCK) and AUD Clock (AUDCK), in the
additional document, Supplementary Information on Using the
SHxxXxX.

Note: Theitemsthat can be set in this dialog box vary according to the emulator in use. For
details, refer to the online help.
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513

Downloading to the Flash Memory

Sets the emulator operation conditions for downloading the external flash memory. This function
is not available when the SH7047F, SH7144F, or SH7145F isin use.

For details, refer to section 6.22, Downloading to the Flash Memory Area

Gonfizuration

General Loading flash memory
Loading flazh memary i Dizable
Erazing flazh memory * Dizable (" Enable
File name | Browse..
Bus width of flazh memory |32—|:|it buz width ﬂ
Flazh memary erazing time | minute
Entry point
All erazing module address |
Wiriting module address [HD
fccezs zize |1 ﬂ
oK | Gancel | |

Figure5.2 [Configuration] Dialog Box ([L oading flash memory] Page)
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Items that can be displayed in the sheet are listed below.

[Loading flash memory] Sets Enable for flash memory downloading. At Enable, when
the flash memory is downloaded on the High-performance
Embedded Workshop, the write module is always called.

Disable: Not download to the flash memory
Enable: Download to the flash memory

[Erasing flash memory] Sets Enable for erasing before the flash memory is
programmed. At Enable, the erase module is called before
calling the write module.

Disable: Not erase the flash memory
Enable: Erase the flash memory

[File name] Sets the write/erase module name. The file that has been set is
loaded to the RAM area before loading to the flash memory.

[Bus width of flash memory] Sets the bus width of the flash memory.

[Flash memory erasing time] Setsthe TIMEOUT value at flash memory erasing. Increase
the value if erasing requires much time although the default
timeisthree minutes. The valuesthat can be set are as follows:
D'0 (minimum) and D’ 65535 (maximum). Only positive
integers can be input.

[Entry point] Sets the calling destination address or access size of the
write/erase module. (It must be RAM address.)

All erasing module address: Inputs the calling destination
address of the erase module.

Writing module address.  Inputs the calling destination
address of the write module.

Access size: Selects the access size of the RAM
areathat isused for loading the
write/erase module.
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5.2 Downloading a Program

This section describes how to download a program and view it as source code or assembly-
language mnemonics.

Note: After abreak has been detected, the High-performance Embedded Workshop displays the
location of the program counter (PC). In most cases, for example if an Elf/Dwarf2-based
project is moved from its original path, the source file may not be automatically found. In
this case, the High-performance Embedded Workshop will open a source file browser
dialog box to allow you to manually locate thefile.

521 Downloading a Program
A load module to be debugged must be downloaded.

To download a program, select the load module from [Debug -> Download] or select [Download]
from the popup menu opened by clicking the right-hand mouse button on the load modulein
[Download modules] of the [Workspace] window.

Notes: 1. Before downloading aprogram, it must be registered to the High-performance
Embedded Workshop as aload module. For registration, refer to section 4.2, Setting at
Emulator Activation.
2. When a program is downloaded to the external RAM, the bus controller must be
initially set in the areafor downloading. Especially, check that the initialization of
SDRAM or the setting of the bus width is appropriate for the target system.
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522 Viewing the Sour ce Code

Select your source file and click the [Open] button to make the High-performance Embedded
Workshop open thefile in the integrated editor. It isalso possible to display your source files by
double-clicking on them in the [Workspace] window.

«* tutorial.cpp

[2 &l

Line | Source A.| E. 5. Source
25 finclude “sort.h”
28 finclude <stdlib.h> &=
27
28 (ooonot1024 wold main{vaid)
23 1
a0
31 lang al10];
32 long 3
33 int i;
34 clazs Zample #p_sam}
35
36 (00001038 ® while (134
37 (00001034 p_zam= new Sanple;
38 (00001038 forl i=0; i<10; i++ )
38 |0ooni1o44 J = rand();
40 |0o001o48 if(i <oM
41 (00001050 d =y
42 i
43 |00001058 o alil = i3
44 i
45 (00001068 p_gam-rsortial:
46 |00001070 p_sam->chanzetfal;
47
43 |00001078 p_sam->s0=al0]:
49 100001074 p_sam->sl=a[1]
50 (00001078 p_sam->s2za[2]
51 |00001082 p_sam->s3=a[3] 1
52 |00001086 p_sam->s4=a[4]
53 (00001084 p_zam-rsf=a[f]
54 (0000103e p_sam->sB=a 6]
55 (00001082 p_sam-rs?=al?];

56 00001036 p_sam->sB=ala]: =
Jm ANNA1NG . n sam-Yedzal9l: JJ
Figure5.3 [Source] Window
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In this window, the following items are shown on the left asline information.
The first column (Source address column): Address information
The second column (Event column): Event information (event condition)
The third column (S/W breakpoint column): PC, bookmark, and breakpoint information

Sour ce address column

When a program is downloaded, an address for the current source file is displayed on the Source
address column. These addresses are helpful when setting the PC value or breakpoints.

Event column
The Event column displays the following item:

@ An address condition for the event condition is set. The number of address conditions that can
be set isthe same as that of event condition channels at which the address condition can be set,
but it differs depending on the product.

Thisisalso set by using the popup menu.

The bitmap symbol above is shown by double-clicking the Event column. Thisis also set by using
the popup menu.

Figure5.4 Popup Menu

Note: The contents of the Event column are erased when conditions other than the address
condition are added to each channel by using the [Edit] menu or in the [Event] window.
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S/W breakpoint column
S/W breakpoint column displays the following items:

1 A bookmark is set.
#: A PCBreak is set.
&*: PC location

) To switch off a column in all source files

Click the [Define Column Format...] menu item.

A w DN

The [Global Editor Column States] dialog box is displayed.
A check box indicates whether the column is enabled or not. If it is checked, the column is

Click the right-hand mouse button on the [Source] window or select the [Edit] menu.

enabled. If the check box is gray, the column is enabled in some files and disabled in
others. Deselect the check box of a column you want to switch off.

5. Click the [OK] button for the new column settings to take effect.

Global Editor Golumn States

[w]Dizaszembly Address
[w]Event

[w]Label

[w]Line

[w]Ob) code

[#]5/ Breakpoints
W5/ Breakpaints — &S M
£

Cancel

Figure5.5 [Global Editor Column States] Dialog Box

< To switch off acolumn in one source file

1. Open the source file which contains the column you want to remove and click the [Edit]

menu.

2. Click the [Columns] menu item to display a cascaded menu item. The columns are
displayed in this popup menu. If acolumnisenabled, it hasatick mark next to its name.
Clicking the entry will toggle whether the column is displayed or not.

R20UT0870EJ1000 Rev. 10.00
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523 Viewing the Assembly-L anguage Code

Click the [ Disassembly] toolbar button at the top of the window when a source file is opened to
show the assembly-language code that corresponds to the current sourcefile.

If you do not have a source file, but want to view code in the assembly-language level, either
choose [View] -> [Disassembly...] or click the [Disassembly] toolbar button ). The
[Disassembly] window opens at the current PC location and shows [Address] and [Code]
(optional) which show the disassembled mnemonics (with labels when available).

Selecting the [Mixed display] toolbar button (&) displays both the source and the code. The
following shows an example in this case.

»# tutorial.cpp — Disassembly. EE]E'

] ]
Ling E.. 5. Digassem.  Objcode Label Mixed
] P= -0
00001050 |E6EB NEG R5,RE Z|
00001082 |1FGC WY.L RE.B(H 30:4,R15)
ngoooios4  |GED3 WMoY R13,RE
00001056 (4808 SHLL2 RE
42 i
43 alil = s
oy 00001068  |62F3 WY R15,RZ
00001084 3260 ADD RE,R2
Qooo10sC {7001 ADD tH7 01, R13
0000105 2252 WY.L RS, &RZ
oooo10e0  (4E10 oT R4
00001082 |BFEF EF /3 BH™1044:8
0ooo10g4  |1FDB WY.L R13,B(H 2C:4,R15)
00001086 D217 WY.L ; B(H 005C:8.PCY,R2
44
45 p_san-»sorifal:
00001068 |BSFE WY R15.RE
Qono10gs 4208 JER BR2
000010BC  |E4BE MYy R11,R4
000010BE D216 WY.L B(H 0058:8.PC),R2
46 p_san-rchanzelal:
oooo1070  |BAFE WYy R15.RE f
4 »

Figure5.6 [Disassembly] Window
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524 M odifying the Assembly-L anguage Code

Y ou can modify the assembly-language code by double-clicking on the instruction that you want
to change. The [Assembler] dialog box will be opened.

Bzzembler

fddresz  Code 0k |
00007040 7937

- Cancel |
e monic:

{400 #HIT RO

Figure5.7 [Assembler] Dialog Box

The address, machine code, and disassembled instruction are displayed. Enter the new instruction
or edit the current instruction in the [Mnemonic] field. Pressing the [Enter] key will assemble the
instruction into memory and move on to the next instruction. Clicking the [OK] button will
assemble the instruction into memory and close the dialog box. Clicking the [Cancel] button or
pressing the [Esc] key will close the dialog box.

Note: The assembly-language display is disassembled from the machine code on the actual
memory. If the memory contents are changed, the dialog box (and the [Disassembly]
window) will show the new assembly-language code, but the display content of the
[Editor] window will not be changed. Thisis the same even if the source file contains
assembly codes.
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525 Viewing a Specific Address

When you are viewing your program in the [ Disassembly] window, you may want to look at
another area of your program's code. Rather than scrolling through alot of code in the program,
you can go directly to a specific address. Double-click on the addressin the [Disassembly]
window or select [Set Address...] from the popup menu, and the dialog box shown in figure 5.8 is

displayed.

Set Address

main LI Cancel |

Figure5.8 [Set Address| Dialog Box

Enter the address or label name in the edit box and either click on the [OK] button or pressthe
[Enter] key. The [Disassembly] window will be updated to show the code at the new address.
When an overloaded function or a class name is entered, the [Select Function] dialog box opens
for you to select afunction.

5.2.6 Viewing the Current Program Counter Address

Wherever you can enter an address or value into the High-performance Embedded Workshop, you
can also enter an expression. If you enter aregister name prefixed by the hash character, the
contents of that register will be used as the value in the expression. Therefore, if you open the [ Set
Address] dialog box and enter the expression #pc, the [Editor] or [ Disassembly] window will
display the current PC address. It also allows the offset of the current PC to be displayed by
entering an expression with the PC register plus an offset, e.g., #PC+0x100.
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53 Displaying Memory Contentsin Realtime
Use the [Monitor] window to monitor the memory contents during user program execution.

Note: Thisfunction is not supported in some devicesto be debugged. For details on the
specifications of each product, refer to the online help.

531 Opening the [Monitor] Window

To open the [Monitor] window, select [View -> CPU -> Monitor -> Monitor Setting...] or click the
[Monitor] toolbar button (|i) to display the [Monitor Setting] dialog box.

Monitar Setking 2=l
tonitor Setting |
Mame : |mu:unitu:ur'|
— Optionz
fddress : |H'00FE000
Size [byte] : |H'|:|02|:| j
Azeess [Eormat] : |BYTE (A5 j
v Auto-Refresh at rate [mz] : ID'DDEDD
[ Reading the Iritial % alue
— Calor
LChange Indicator : IEhange j
Foreground : _IvI Background I:Ilvl
[ bl ayfly
— Detail
lDET.-‘-\IL MOT SUPPORTED! Letail... |
— Hiztary

Figure5.9 [Monitor Setting] Dialog Box
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[Name]: Decides the name of the monitor window.
[Optiong]: Sets monitor conditions.
[Address]: Sets the start address for monitoring.
[Size]: Sets the range for monitoring.
[Access]: Sets the access size to be displayed in the monitor window.

[Auto-Refresh at rate]:

[Reading the Initial Value]:

Setsthe interval for acquisition by monitoring.

Selects reading of the values in the monitored area when the
monitor window is opened.

[Color]: Sets the method to update monitoring and the attribute of colors.

[Change Indicator]:

[Foreground]:

[Background]:

[Mayfly]:

Selects how to display the values that have changed during
monitoring (available when [Reading the Initial Value] has
been selected).

No change: No color change.

Change: Color is changed according to the [Foreground] and
[Background] options.

Gray: Those data with values that have not been changed are
displayed in gray.
Appear: A vaueisonly displayed after changed.

Sets the color used for display (available when [Change] has
been selected).

Sets the background color (available when [Change] has been
selected).

A check in this box selects restoration of the color of those
data which have not been updated in a specified interval to the
color selected in the [Background] option. The specified
interval isthe interval for monitor acquisition (available when
[Change], [Gray], or [Appear] has been selected).

[Detail]: Not supported in the emulator.

R20UT0870EJ1000 Rev. 10.00
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[History]: Displays the previous settings.

Note:  Selection of the foreground or background color may not be available depending on the
operating system in use.

After setting, clicking the [OK] button displays the [Monitor] window.

® 2 |[15 =]|[Buterascm =] ‘

Address | +0| +1 ] +2| +3 | +4| 5| 46| +7| 48] +9] 2| +8| tc| 0| 4B +7| Value |
00000000 00 00 08 OO0 00 01 00 00 00 00 08 2C 00 01 00 00 cuveveew...
00000010 00 00 08 44 00 00 08 48 EC 66 90 6F B0 00 00 20 ...D...H.f.o....

Figure5.10 [Monitor] Window

During user program execution, the display is updated according to the setting value of the auto-
update interval.

Note: Select [Refresh] from the popup menu when datais not displayed correctly after changing
the address or content of memory.

5.3.2 Changing the Monitor Settings

Selecting [Monitor Settings...] from the popup menu of the [Monitor] window displaysthe
[Monitor Setting] dialog box, which allows the settings to be changed.

Colors, the size of accesses, and the display format can be easily changed from [Color] or [Access)
of the popup menu.
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533 Temporarily Stopping Update of the Monitor

During user program execution, the display of the [Monitor] window is automatically updated
according to the auto-update interval. Select [Lock Refresh] from the popup menu of the
[Monitor] window to stop the update of display. The charactersin the address section are
displayed in black, and the update of display is stopped.

Selecting [Lock Refresh] again from the popup menu cancels the stopped state.

534 Deleting the Monitor Settings

Selecting [Close] from the popup menu of the [Monitor] window to be deleted closes the
[Monitor] window and deletes the monitor settings.

535 Monitoring Variables
Using the [Watch] window refersto the value of any variables.

When the address of the variable registered in the [Watch] window exists within the monitoring
range that has been set by the Monitor function, the value of the variable can be updated and

displayed.

This function allows checking the content of a variable without affecting the realtime operation.
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5.3.6 Hiding the[Monitor] Window

When using the Monitor function to monitor the value of a variable from the [Watch] window,
hide the [Monitor] window for the effective use of the screen.

The current monitoring information is listed as the submenu when selecting [Display -> CPU ->
Monitor]. Thelist consists of the [Monitor] window name and the address to start monitoring.

When the left of thelist is checked, the [Monitor] window is being displayed.

Selecting items of the [Monitor] window you want to hide from the monitor setting list displays no
[Monitor] window and removes the check mark at the left of thelist.

To display the [Monitor] window again, select the hidden the [Monitor] window.

1 Monitar g _i Maonitar Setking. .. Shifk+CkrH+-E

| v manitor2 - HOOFFEOAD
monitarl - H'OOFFBO00 (*_heap_area™)

Windows Select. ..

Figure5.11 Monitor Setting List
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537 Managing the [Monitor] Window

Selecting [Display -> CPU -> Monitor -> Windows Select...] displays the [Windows Select]
dialog box. In thiswindow, the current monitoring condition is checked and the new monitoring
condition is added, edited, and deleted in succession.

Sel ecting multiple monitoring conditions enables a temporary stop of update, hiding, and deletion.

Windows Seleck il 5'

| Mame | &ddress |

¥ manitar? H'OOFFEDZ0
¥ monitor] HOOFFEO [ _heap_area"]

Edt..

|
|
Lock Refresh? |
|
|

Hide'?
Bemove
Cloze |
Figure5.12 [Windows Select] Dialog Box
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54 Viewing the Current Status

Choose [View -> CPU -> Status] or click the [View Status] toolbar button () to open the
[Status] window and see the current status of the debugging platform.

il £
Item IStatus
Target Dewvice Configuaration Not Support
System Memory Pesources Not Bupport
Program MName Memory Loaded Area
.. _systemttutorial. abs H'Oo0dooooo - H'o0000017
H'oOoooosoo - H'ooodoz4e
H'OO001000 - H'00001&6EZ7
H'OOO00zZ000 - H'0000Z0EF
E\Memnr}rﬁl Platiorm }\E\rent's f
Figure5.13 [Status] Window
The [Status] window has three sheets:
e [Memory] sheet
Contains information about the current memory status including the memory-mapping
resources and the areas used by the currently loaded object file.
o [Platform] sheet
Contains information about the status of the emulator, typicaly including the CPU type and
emulation mode, the state of execution, and the statistic information of execution.
e [Events] sheset
Contains information about the event information, including resource information and
breakpoints.
Note: Theitemsthat can be set in this dialog box vary according to the emulator in use. For
details, refer to the online help.
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55 Using the Event Points

The emulator has the event point function that performs breaking, tracing, and execution time
measurement by specifying more complex conditions along with the PC breakpoints standard for
the High-performance Embedded Workshop.

55.1 PC Breakpoints

When the instruction of the specified addressis fetched, the user program is stopped. Up to 255
points can be set.

55.2 Event Conditions

Event conditions can be used for more complex conditions such as the data condition as well as
specification of the single address.

When the condition is satisfied, event conditions are also used as the start/end conditions for
performance measurement in addition to halting the user program. When event conditions are
used as the start/end conditions for performance measurement, start from setting in the
[Performance Analysis] window.

Severa event conditions can be used to set more complex conditions.

Notes: 1. When event conditions are used as the start/end conditions for performance
measurement, step operation cannot be performed. In addition, when execution is
restarted from the address where step operation has been stopped by the
BREAKPOINT, the single step function is used and operation is disabled. Restart
execution after the BREAKPOINT has been canceled.

2. Itisnot possible to use the break conditions and the start/end conditions for
performance measurement at the same time with one channel. If the performance
measurement start/end conditions are set, the settings of the break conditions will be
disabled.

3. The event conditions that can be set vary according to the emulator in use. For details,
refer to the online help.
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55.3 Opening the [Event] Window

Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button (&) to open the
[Event] window.

The [Event] window has the following two sheets:

[Breakpoint] sheet: Displays the settings made for PC breakpoints. It is also possible to set,
modify, and cancel PC breakpoints.

[Event condition] sheet:  Displays or sets the settings made for event condition channels.

554 Setting PC Breakpoints

It is possible to display, modify, and add PC breakpoints on the [Breakpoint] shest.

3
Type | State | Condition Action
Ereakpoint Enasble Address=0c000000 Ereak
£ [
Breakpoint ."i Event condition I.f’
Figure5.14 [Event] Window ([Breakpoint] Sheet)
R20UT0870EJ1000 Rev. 10.00 Page 125 of 292

Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 5 Debugging

Thiswindow displays and sets the breakpoints. Items that can be displayed in the sheet are listed
below.

[Type] Breakpoint
[State] Whether the breakpoint is enabled or disabled

[Condition] An address that the breakpoint is set
Address = Program counter (Corresponding file name, line, and symbol name)

[Action] Operation of the emulator when a break condition is satisfied
Break: Breaks program execution

When a breakpoint is double-clicked in this window, the [Breakpoint] dialog box is opened and
break conditions can be modified.

A popup menu containing the following options is available by right-clicking within the window.

555 Add

Sets breakpoints. Clicking thisitem will open the [Breakpoint] dialog box and break conditions
can be specified.

556 Edit

Only enabled when one breakpoint is selected. Select a breakpoint to be edited and click thisitem.
The [Breakpoint] dialog box will open and break conditions can be changed.

55.7 Enable

Enables the selected breakpoint(s).
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5.5.8 Disable

Disables the selected breakpoint(s). When a breakpoint is disabled, the breakpoint will remain in
the list; when specified conditions have been satisfied, a break will not occur.

559 Delete

Removes the selected breakpoint. To retain the details of the breakpoint but not have it cause a
break when its conditions are met, use the Disable option (see section 5.5.8, Disable).

55.10 DeleteAll

Removes all breakpoints.

55.11 Goto Source

Only enabled when one breakpoint is selected. Opens the [ Source] window at the address of the
breakpoint.
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55.12 [Breakpoint] Dialog Box

Breakpoint

Addrezs |

— fddress

Walue Im

Ik I Cancel

Figure5.15 [Breakpoint] Dialog Box
This dialog box specifies break conditions.

A breakpoint address to be set is specified in the [Value] edit box. The PC register can also be
specified such as #PC. Up to 255 breakpoints can be specified.

The contents to be set differ depending on the product. For details, refer to the on-line help for
each product.

When [Valug] is selected, if an overloaded function or class name including a member function is
specified in address, the [Select Function] dialog box opens.

Clicking the [OK] button sets the break conditions. Clicking the [Cancel] button closes this dialog
box without setting the break conditions.
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55.13  Setting Event Conditions

On the [Event condition] sheet, the settings for event conditions are displayed, modified, and
added.

Type | Ztate | Condition | Action |
Chl(IA OA DT CT} Enable Address=0C000000 access M-bus Break Break
Chi (IA QA DT} Dizable Hone Break
Ch3 [Ia) Enable  Address=00000000 pc Break Break
Chd [(IA) Dizable HNone Break
ChS [ IA) Dizable HNone Break
Che [ IA) Dizable HNone Break
Ch7(IA) Dizable None Break
Ch8 [IA) Dizable HNone Break
ChoO [IA) Dizable HNone Break
Ch10 ([ TIA) Dizable None Break
ChlliIa R} Dizable HNone Reset point
| P',' Breakpoint ;"\Event condition I.-'r

Figure5.16 [Event] Window ([Event condition] Sheet)

Thiswindow displays and sets the break condition. Since the number of channels for detecting
conditions and the contents to be set differ depending on the product, refer to the on-line help for
each product.

Items that can be displayed in the sheet are listed below.
[Type] Event channel number

[State] Whether the breakpoint is enabled or disabled

Enable: Valid
Disable: Invalid
[Condition] A condition that satisfies a break. The displayed contents differ depending on the
break type.
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[Action] Operation of the emulator when a break condition is satisfied.
Break: Breaks program execution

When a breakpoint is double-clicked in this window, the [Event condition] dialog box is opened
and break conditions can be modified. For details on the [Event condition] dialog box, refer to the
on-line help for each product.

A popup menu containing the following optionsis available by right-clicking within the window.

55.14 Edit...

Only enabled when one event channel is selected. Select abreakpoint to be edited and click this
item. The [Event condition] dialog box will open and break conditions can be changed.

5.5.15 Enable

Enables the selected event channel(s). An event channel that the condition has not been set is not
enabled.

55.16 Disable

Disables the selected event channel (s). When an event channel is disabled, a break will not occur
even if specified conditions have been satisfied.

55.17 Delete

Initializes the condition of the selected event channel. To retain the details of the event channel but
not have it cause a break when its conditions are met, use the Disable option (see section 5.5.16,
Disable).

5518 DeeteAll

Initializes conditions of all event channels.
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55.19 Goto Source

Only enabled when one event channel is selected. Opens the [ Source] window at address of event
channel.

If an address value has not been set to the event channel, this option cannot be used.

5,5.20 [Combination action(Sequential PtoP)]

Sets a sequentia condition of event channels or points where performance measurement or
internal tracing starts and stops.

5.5.21 Editing Event Conditions

Handlings for settings other than PC breakpoints and event conditions are common. The following
describes examples of such handling.

5.5.22 Modifying Event Conditions

Select an event condition to be modified, and choose [Edit...] from the popup menu to open the
dialog box for the event, which allows the user to modify the event conditions. The [Edit...] menu
isonly available when one event condition is selected.

5.5.23 Enabling Event Conditions

Select an event condition and choose [Enable] from the popup menu to enable the selected event
condition.

55.24 Disabling Event Conditions

Select an event condition and choose [Disable] from the popup menu to disable the selected event
condition. When an event condition is disabled, the event condition will remain in the list, but an
event will not occur when the specified conditions have been satisfied.
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55.25 Deleting Event Conditions

Select an event condition and choose [Delete] from the popup menu to remove the selected event
condition. To retain the event condition but not have it cause an event when its conditions are met,
use the [Disable] option (see section 5.5.24, Disabling Event Conditions).

5.5.26 Deleting All Event Conditions

Choose [Delete All] from the popup menu to remove al event conditions.

5.5.27 Viewingthe SourceLinefor Event Conditions

Select an event condition and choose [Go to Source] from the popup menu to open the [Source] or
[Disassembly] window at the address of the event condition. The [Go to Source] menu isonly
available when one event condition that has the corresponding source file is selected.
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5.6 Viewing the Trace Information

For the description on the trace function, refer to section 2.2, Trace Functions.

56.1 Opening the[Trace] Window

To open the [ Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button

=).

56.2 Acquiring Trace Information

When the emulator does not set the acquisition condition of the trace information, the trace
information is acquired by the internal trace function in default.

The acquired trace information is displayed in the [ Trace] window.

## Trace Window

|| B DR & w0

ETR | Ip |Type | Instruction | Source |Label ﬂ
-000007 -DT0003 BRAMNCH BF/S @H'Z0D. ..

-000006 DESTINATION MOV #H'09, ... ali]l = tmp(% - 1i];

—-000005 -DrO0DZ2 BRANCH BE/S EH'20D. ..

-000004 DESTINATION MOV #H'09, ... alil = tmp[9 - 11;

-000003 -DT0001 BRANCH BF/S EH'20D. ..

-000002 DESTINATION MOV #H'09, ... al[i] = tmp[% - 11;

—-000001 -DTO0DO0 BRANCH RTS

+0003000 DESTINATION MOV.L @R15,R. .. p sam->z0=al0]; -
| | »

Figure5.17 [Trace] Window (Type 1) (Internal Trace)

Thiswindow displays the following trace information items:

[PTR] Pointer to alocation in the trace buffer (+0 for the last executed instruction)
[1P] The amount of acquired trace information
[Type] Type of branch:

BRANCH: Branch source
DESTINATION: Branch destination

[Address] Instruction address
[Instruction] I nstruction mnemonic
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[Source] The C/C++ or assembly-language source program

[Label] Label information

Selecting the [Set...] menu in the popup menu of the [Trace] window displays the [Acquisition]
dialog box. When [AUD function] is selected in [Trace Type] within the dialog box, the trace

information is acquired by using the AUD trace function.

g & BTC

a b O
ETR 1P Type Bus R/W Address Data Source Label EI
=000337 -D"000255 BRANCH 0000104C
000336 DESTINATION 00001034
=000235% =D MEMORY L=Bus WRITE O000FFE4 0000&6eTY
—-000334 MEMORY L-Bus WRITE O0QOFEDD Q0006679
=000333 -D"0C BRANCH 00001062
000332 DESTINATION 00001044 j = rand{);
000331 ) MEMORY L-Bus WRITE O000FFED oooooooe
000330 -p* BRANCH 00001044 J = randi{);
=00032% DESTINATION 000011F0 rand
000328 MEMORY L-Bus WRITE O000FFRO Q0000000
000327 C MEMORY L-Bus READ 00001214 oooos540C
=00032& -=D'"000Z4" MEMORY L=Bus RERD 00001218

|

41CE4EED =
| »

Figure5.18 [Trace] Window (Type 1) (AUD Trace)

Thiswindow displays the following trace information items (some of thisinformation will not be
displayed in some products):

[PTR] The trace buffer pointer (+0 for the last executed instruction)
[IP] The amount of acquired trace information
[Type] Type of trace information:
BRANCH: Branch source
DESTINATION: Branch destination
MEMORY : Memory access
S TRACE: Executed Trace(x) function
LOST: Lost trace information (only in the realtime mode)
CPU-WAIT: CPU was waiting for the output of the trace information
(only in the non-realtime mode)
[Bus] The bus which was being accessed
[RIW] Whether the generated data is associated with read or write access
[Address] Address

R20UT0870EJ1000 Rev. 10.00
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[Datd] The data of the generated data access. When [Type] isS_TRACE, valuex, a
variable of function Trace(x), is displayed.

[Instruction] Instruction mnemonic

[Repeat] Displayed only when the Repeat filter is used. This item shows the number
of consecutive branch operations.

[Probe] State of the input probe

[Timestamp] Timestamp value

[Source] The C/C++ or assembly-language source program

[Label] Label information

Note:  Since the displayed contents differ depending on the product, refer to each product’s
online help. Some MCUs/MPUs supported may not have the AUD trace function.

Some devices to be debugged display the items below. For details on the specifications of each
product, refer to the additional document, Supplementary Information on Using the SHxxxx, or
the online help.

BranchType Bus R/W Address Data
SUBRL INE 000011F0

Figure5.19 [Trace] Window (Type 2)
[PTR] The trace buffer pointer (+0 for the last executed instruction)
[1P] The amount of acquired trace information

[Master] (BusMaster)  Type of bus master accessed
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[Type] Type of trace information:
BRANCH: Branch source
DESTINATION: Branch destination
MEMORY: Memory access
S TRACE: Executed Trace(x) function
LOST: Lost trace information (only in the realtime mode)
CPU-WAIT: CPU was waiting for the output of the trace information
(only in the non-realtime mode)

[Branch Type] Type of branch (only when the branch trace is acquired):
GENERAL: Genera branch
SUBROUTINE: Subroutine branch
EXCEPTION: Exception branch

[Busg] The bus which was being accessed

[R/W] Whether the generated data is associated with read or write access

[Address] Address

[Data) The data of the generated data access. When [Type] isS_TRACE, valuex, a
variable of function Trace(x), is displayed.

[PPC] Performance-counter output

[Instruction] I nstruction mnemonic

[Source] The C/C++ or assembly-language source program

[Label] Label information

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you
want to hide from the popup menu displayed by clicking the right-hand mouse button on the
header column hides that column. To display the hidden column, select the column from the said
popup menu again. Dragging the column with the mouse can change the display order.
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56.3 Specifying Trace Acquisition Conditions

The capacity of the trace buffer islimited. When the buffer becomes full, the oldest trace
information is overwritten. Setting the trace acquisition condition allows acquisition of useful
trace information and effective use of the trace buffer.

The trace acquisition condition is set in the [Acquisition] dialog box that is displayed by selecting
[Acquisition...] from the popup menu.

The [Acquisition] dialog box has the following pages:

Table5.1 [Acquisition] Dialog Box Pages

Page Iltem
[Trace mode] Sets trace acquisition conditions.
[Window trace] Sets window trace acquisition conditions.**
[AUD Branch trace] Sets branch conditions acquired by the AUD trace function.**
[Branch Trace] Sets branch conditions acquired by the internal trace function.
Notes: 1. This dialog box is not supported by the products that do not support the AUD trace
function.
2. Some products do not support this page. For details, refer to the online help for each
product.
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(2) [Trace mode] page

Sets trace acquisition conditions.

Acguizition

Trace mode | Window trace I AUD Branch frace

— Trace type
e
—aUD function

¥ Branch trace

[V Windaw trace | [+ Channel & [T Chanrel B |
[T Software trace

" Internal trace

—alUD mode
| &0 model: + Bealtime trace ¢ Non realtime trace |
| &UD modes: * Trace continue ¢ Trace stop |

BUD trace dizplay range:
Start pointer |D'255

Erd painter ID'EI

] 4 I Cancel I

Figure5.20 [Acquisition] Dialog Box ([Trace mode] Page)

This dialog box specifies the methods and conditions for the acquisition of trace information.

[Trace typel: Selects the type of the trace function.
[AUD function] Uses the AUD trace function.
[Internal trace] Usestheinternal trace function.

The following can only be set when the AUD trace function is used.
[AUD function]: Sets the trace acquisition condition.

For a description of the conditions for trace acquisition, refer to section 2.2.2, AUD Trace
Function.
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[AUD mode]: Sets the acquisition mode of the AUD trace.

[AUD model]: An option to determine the operation when the trace information is
continuously generated.

[Redltime trace] Some of the trace information will not be output.

[Non realtime trace] Where necessary, the CPU waits until each item of trace
information has been output.

[AUD mode2]:  An option that determines the operation when the trace buffer of the
emulator becomes full.

[Trace continue] The oldest trace information is overwritten by the latest
information.
[Trace stop] Trace information is not acquired after the buffer has been filled.

[AUD tracedisplay range]: Set the display range of the [Trace] window.
[Start pointer] The trace is displayed from the specified value.
[End pointer] The trace is displayed to the specified value.

Clicking the [OK] button stores the settings. Clicking the [Cancel] button closes this dialog box
without modifying the settings.
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Some devices to be debugged display the following dialog box. For details on the specifications of
each product, refer to the additional document, Supplementary Information on Using the SHxxxXx,
or the online help.

Acouisition

Trace Mode

—Trace type
g

—Trace Mode 1
= Bealtime trace ¢ MNaon realtime trace

—Trace Mode 2
& Trace continue ¢ Trace stop

—ALD Mode
i d hit £ Bt

—ALD trace display range

Start pointer |D’255

End mointer ID’D

—lLser memory area
Btart [Ho

Erid Addreze. [HISFR

—Trace Extend Mode
[T Trace data with PPC

] Cancel

Figure5.21 [Acquisition] Dialog Box ([Trace mode] Page)
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[Trace type: Selects the type of trace function.

[AUD function] Uses the AUD trace function.
[Internal trace] Usesthe internal trace function.
[User Memory trace] Uses the memory output function of trace data.

[Trace Mode 1]: An option to determine the operation when the trace information is
continuously generated; only available when selecting [AUD trace] or
[User Memory trace].

[Realtime trace] Some of the trace information will not be output.

[Non redtime trace] Where necessary, the CPU waits until each item of trace
information has been output.

[Trace mode 2]: An option that determines the operation when the trace buffer of the
emulator becomes full; only available when selecting [AUD trace] or [User
Memory trace].
[Trace continue] The oldest trace information is overwritten by the latest
information.
[Trace stop] Previous trace information is not acquired.
[AUD Mode]: Some devices to be debugged can select the 8-bit mode of the AUD pin.

For details on the specifications of each product, refer to the additional
document, Supplementary Information on Using the SHxxxx, or the online
help. Thisisonly available when [AUD trace] is selected.

[AUD trace display range]: An option to set the display range of the [Trace] window; thisis
only available when [AUD trace] is selected.
[Start pointer] The trace is displayed from the specified value.
[End pointer] The trace is displayed to the specified value.

[User Memory ared]: An option to set the display range of the [Trace] window; thisis only
available when [User Memory trace] is selected.

[Start] Specifies the start address of the memory range that the trace
result is written to.

[End address] Specifies the end address of the memory range that the trace
result is written to.
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[Trace Extend Mode]:

[Trace data with PPC] Outputs a performance counter in the [ Trace] window.
(If thisfunction is enabled, the source of the branch trace will
not be displayed.)

Clicking the [OK] button stores the settings. Clicking the [Cancel] button closes this dialog box
without modifying the settings.

(2) [Window trace] page

Acguizition il EI
Trace mode Window trace | ALID Branch trace I
—Channel &
Fiead A ite: = Bead = Wiite f* ReadMrite
Start address: IH'EI
End address: |H'FFFFI
Bus state: v | -buz  r-bus O Y-bus O Fbus
—Channel B
Fead Mikite: " Read ) Write {* Read Mrite
Start address; |H'EI
Endl address; |H'EI
BEuz state: % [-bus ) A-bug 0 Y-bus T Lhus
| ] I Cancel |

Figure5.22 [Acquisition] Dialog Box ([Window trace] Page)
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This dialog box is used to specify conditions for the acquisition of trace information. For a
description of the conditions for trace acquisition, refer to section 2.2.2, AUD Trace Functions.

[Channel A]: Enables channel A of the window trace.
[Bus state] Selects abus for trace acquisition.
[Read/Write] Setstracing of read or write access or both.
[Trace start address] Sets an address range for the tracing of data access. The start
address is set here.
[Trace end address] Sets an address range for the tracing of data access. The end

addressis set here.

[Channel B]: Enables channel B of the window trace.
[Bus state] Selects abus for trace acquisition.
[Read/Write] Setstracing of read or write access or both.
[Trace start address] Sets an address range for the tracing of data access. The start
address is set here.
[Trace end address] Sets an address range for the tracing of data access. The end

addressis set here.
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(3) [AUD Branch trace] page

Selects the type of branches to be acquired.

Acquizition

Trace mode | Window trace AUD Branch trace

v cquire normal branch instruction fracei

v ficquire subroutine branch instruction trace

v ficquire exception branch instruction trace

] 4 I Cancel I

Figure5.23 [Acquisition] Dialog Box (JAUD Branch trace] Page)
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564 Searching for a Trace Record

Use the [ Trace Find] dialog box to search for atrace record. To open this dialog box, choose
[Find...] from the popup menu.

The [Trace Find] dialog box has the following options:

Table5.2 [TraceFind] Dialog Box Pages

Page Description

[General] Sets the range for searching.
[Address] Sets an address condition.

[Data] Sets a data condition.

[Type] Selects the type of trace information.
[Bus] Selects the type of a bus.

[R/W] Selects the type of access cycles.

Note: Items other than [General] and [Address] vary according to the emulator in use. For details,
refer to the online help.

Clicking the [OK] button after setting conditions in those pages stores the settings and starts
searching. Clicking the [Cancel] button closes this dialog box without setting conditions.

When atrace record that matches the search conditions is found, the line for the trace record will
be highlighted. When no matching trace record is found, a message dialog box will appear.

Only the trace information that satisfies all the conditions set in above pages will be searched.

If asearch operation is successful, selecting [Find Next] from the popup menu will move to the
next found item.
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(2) [General] page
Set the range for searching.

Trace Find x|

Gieneral |F'n:|u:|ress | data | Type | Bus I R |

— Trace search range
[T Mot desienation [T Upward search

Start PTR: [-32767
End PTR. : ID

] I Cancel | Apply |

Figure5.24 [Trace Find] Dialog Box ([General] Page)
[Trace search range]: Sets the range for searching.

[Not designation]: Searches for information that does not match the conditions
set in other pages when this box is checked.

[Upward search: Searches upwards when this box is checked.
[Start PTR]: Entersa PTR valueto start a search.
[End PTR]: Enters a PTR value to end a search.

Note: Along with setting the range for searching, PTR valuesto start and end searching can be
set in the [Start PTR] and [End PTR] options, respectively.
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(2) [Address] page
Set an address condition.

Trace Find EI

Gieperal  Address |data | Tvpe | Bus | RAW |
[ Don't care

Setting
|7E-3|UE : IH'FFEFEEI

(] I Cancel | Apply |

Figure5.25 [Trace Find] Dialog Box ([Address] Page)

[Don't care]: Detects no address when this box is checked.
[Setting]: Detects the specified address.
[Value]: Enter the address value (not available when [Don’t care] has been
checked).
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(3) [Data] page
Set adata condition.

Trace Find EI

Generall fddresz  data |Ty|:ne |Elus |MM |
[ Don't care

Setting
|7E-3|UE : IH'EIEIEIEI

(] I Cancel | Apply |

Figure5.26 [Trace Find] Dialog Box ([data] Page)

[Don't care]: Detects no data when this box is checked.

[Setting]: Detects the specified data.
[Value]: Enter the data value (not available when [Don’t care] has been checked).
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(4) [RIW] page
Select the type of access cycles.

Trace Find EI
LA |

String :  |READ =]

] I Cancel | Apply |

Figure5.27 [Trace Find] Dialog Box ([R/W] Page)

[Don't care]: Detects no read/write condition when this box is checked.
[Setting]: Detects the specified read/write condition.
[String]: Select aread/write condition (not available when [Don't care] has been
checked).

READ: Read cycle
WRITE: Writecycle
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(5) [Type] page
Select the type being accessed. The selection is not available when atime stamp is acquired.

Trace Find e Xl
Tvpe |Bus | RAW |
—aetting
String :  |BRANCH =l
] I Cancel | Spply |
Figure5.28 [Trace Find] Dialog Box ([Type] Page)
[Don't care]: Detects no type condition when this box is checked.
[Setting]: Detects the specified type condition.
[String]: Select atype condition (not available when [Don't care] has been
checked).
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(6) [Bus] page
Select the status of a bus.

Trace Find EI

String : II— Buz j

k. I Cancel | Apply |

Figure5.29 [Trace Find] Dialog Box ([Bus| Page)

[Don't care]: Detects no bus condition when this box is checked.
[Setting]: Detects the specified bus condition.
[String]: Select a bus condition (not available when [Don't care] has been
checked).
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5.6.5 Clearing the Trace Information

When [Clear] is selected from the popup menu, the trace buffer that stores the trace information
becomes empty. If several [Trace] windows are open, al [Trace] windows will be cleared as they
all access the same buffer.

5.6.6 Saving the Trace Information in a File

Select [Save...] from the popup menu to open the [Save Ag] file dialog box, which allows the user
to save the information displayed in the [ Trace] window as atext file. A range can be specified
based on the [PTR] number (saving the complete buffer may take several minutes). Note that this
file cannot be rel oaded into the [ Trace] window.

Note: Infiltering of trace information, the range to be saved cannot be selected. All the trace
information displayed in the [Trace] window after filtering will be saved. Select afiltering
range on the [General] pagein the [Trace Filter] dialog box if you want to save the
selected range. For details on the filtering function, refer to section 5.6.10, Extracting
Records from the Acquired Information.

5.6.7 Viewing the [Editor] Window

The [Editor] window corresponding to the selected trace record can be displayed in the following
two ways:

e Sdlect atrace record and choose [View Source] from the popup menu.
e Double-click atrace record.

The [Editor] or [ Disassembly] window opens and the selected line is marked with a cursor.

5.6.8 Trimming the Sour ce

Choose [Trim Source] from the popup menu to remove the white space from the left side of the
source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu.
To restore the white space, choose [ Trim Source] while the check mark is shown.
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56.9 Temporarily Stopping Trace Acquisition

To temporarily stop trace acquisition during execution of the user program, select [Halt] from the
popup menu. This stops trace acquisition and updates the trace display. Use this method to check
the trace information without stopping execution of the user program.

5.6.10 Extracting Recordsfrom the Acquired I nformation

Use the filtering function to extract the records you need from the acquired trace information. The
filtering function allows the trace information acquired by hardware to be filtered by software.
Unlike the settings made in the [ Trace Acquisition] dialog box for acquiring trace information by
conditions, changing the settings for filtering several timesto filter the acquired trace information
allows easy extraction of necessary information, which isuseful for analysis of data. The content
of the trace buffer will not be changed even when the filtering function is used. Acquiring useful
information as much as possible by the [ Trace Acquisition] settings improves the efficiency in
analysis of data because the capacity of the trace buffer is limited.

Use the filtering function in the [ Trace Filter] dialog box. To open the [ Trace Filter] dialog box,
select [Filter...] from the popup menu.

The [Trace Filter] dialog box has the following pages:

Table5.3 [TraceFilter] Dialog Box Pages

Page Description

[General] Selects the range for filtering.
[Address] Sets address conditions.

[Data] Sets data conditions.

[Type] Selects the type of trace information.
[Bus] Selects the type of a bus.

[R/W] Selects the type of access cycles.

Note: Items other than [General] and [Address] vary according to the emulator in use. For details,
refer to the online help.

Set filtering conditions and then press the [OK] button. This starts filtering according to the
conditions. Clicking the [Cancel] button closes the [ Trace Filter] dialog box, which holds the
settings at the time when the dialog box was opened.

In filtering, only the trace information that satisfies one or more filtering conditions set in the
above pages will be displayed in the [ Trace] window.
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Filtering conditions can be changed several times to analyze data because the content of the trace
buffer is not changed by filtering.

(1) [General] page
Set the range for filtering.

Gereral |F'n:|u:|ress | data | Twpe | Buz | RAW |
[ Don't care other pages! [~ Enable Filter
[T Mot dezienation
Trace dizplay range
Start PTR: |
End PTR.: I

] I Cancel | Apply |

Figure5.30 [TraceFilter] Dialog Box ([General] Page)

[Don't care other pages]: Only selects the cycle number when this box is checked. Other options
become invalid.

[Enable Filter]: Enables the filter when this box is checked.

[Not designation]: Filters information that does not match the conditions set in those pages
when this box is checked.

[Trace display range]: Sets the range for filtering.

[Start PTR]: Entersa PTR valueto start filtering.
[End PTR]: Entersa PTR value to end filtering.

Note: Along with setting the range for filtering, PTR valuesto start and end filtering can be set
in the [Start PTR] and [End PTR] options, respectively.
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(2) [Address] page
Set address conditions.

& Foint  { Ranee

Fram : IH'

To: |

(] I Cancel | Apply |

Figure5.31 [Trace Filter] Dialog Box ([Address| Page)
[Don't care]: Detects no address when this box is checked.
[Setting]: Detects the specified address.
[Point]: Specifiesasingle address (not available when [Don't care] has been checked).
[Range]: Specifies an address range (not available when [Don't care] has been checked).

[From]: Enter asingle address or the start of the address range (not available when
[Don’'t care] has been checked).

[To]: Enter asingle address or the end of the address range (only available when
[Range] has been selected).

Note: Along with setting the address range, the start and end of the address range can be set in
the [From] and [To] options, respectively.
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(3) [Data] page
Set adata condition.

Generall fddresz  data |Ty|:ne |Elus |MM |

Setting
& Foint  { Ranee

Fram : IH'

To: |

] 4 I Cancel | Epply |

Figure5.32 [Trace Filter] Dialog Box ([data] Page)
[Don't care]: Detects no data when this box is checked.
[Setting]: Detects the specified data.
[Point]: Specifies single data (not available when [Don’t care] has been checked).
[Range]: Specifies a data range (not available when [Don’'t care] has been checked).

[From]: Enter single data or the minimum value of the data range (not available when
[Don't care] has been checked).

[To]:  Enter the maximum value of the data range (only available when [Range] has
been selected).

Note: Along with setting the data range, the minimum and maximum values can be set in the
[From] and [To] options, respectively.
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(4) [RIW] page
Select the type of access cycles.

Generall fdddrezs | data | Tvpe | Bus it

[ o't care:

5 Szitin.g ............
[ JREAD
WRITE

] I Cancel | Apply |

Figure5.33 [Trace Filter] Dialog Box ([R/W] Page)
[Don't care]: Detects no read/write condition when this box is checked.
[Setting]: Detects the specified read/write condition.

READ: Detectsread cycleswhen this box is checked (not available when
[Don't care] has been checked).

WRITE: Detects write cycles when this box is checked (not available when
[Don’t care] has been checked).

R20UT0870EJ1000 Rev. 10.00 Page 157 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 5 Debugging

(5) [Type] page
Select the type being accessed. The selection is not available when atime stamp is acquired.

Generall fdddrezs | data  Tvpe |Elus | R |

[JBRANCGH <
[JDESTINATION

[(JMEMORY

[JLOST

[JGPU-Wait j

k. I Cancel | Apply |

Figure5.34 [TraceFilter] Dialog Box ([Type] Page)

[Don't care]: Detects no type condition when this box is checked.
[Setting]: Detects the specified type condition (not available when [Don’'t care] has been
checked).
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(6) [Bus]| page
Select the status of a bus. The selection is not available when atime stamp is acquired.

Generall fdddrezs | data | Type Bus IMM |

I Don't care:
—aetting
[I-Bu=

[L-Bus
[ ¥-Bus
[v-Bus

] I Cancel | Spply |

Figure5.35 [Trace Filter] Dialog Box ([Bus] Page)
[Don't care]: Detects no bus condition when this box is checked.

[Setting]: Detects the specified bus condition (not available when [Don’t care] has been
checked).
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5.6.11 Analyzing Statistical Information

Choose [Statigtic...] from the popup menu to open the [Statistic] dialog box and analyze statistical

information under the specified conditions.

2%

F S Reitowtints] EEt

ltem - |<N|:|ne> |
Start I

Eezult |
End I

[Clear |
Fesult :
Condition | Arnavint | PTH

LCloze

L

Figure5.36 [Statistic] Dialog Box

[Statistic Analysis): Setting required for analysis of statistical information.
[Default]: Setsasingle input value or character string.
[Range]: Sets the input value or character string as arange.
[Item]: Setsthe item for analysis.
[Start]: Setsthe input value or character string. To set arange, the start value

must be specified here.
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[End]: Specify the end value if arange has been set (only available when
[Range] has been selected).

[Set]: Adds a new condition to the current one.

[New]: Creates anew condition.

[Result] button: Obtains the result of statistical information analysis.
[Clear]: Initializes the settings.
[Result] list box: Clearsall conditions and results of statistical information analysis.

[Close]: Closes this dialog box. All the results displayed in the [Result] list will
be cleared.

This dialog box allows the user to analyze statistical information concerning the trace information.
Set the target of analysisin [Item] and the input value or character string by [Start] and [End].
Click the [Result] button after setting a condition by pressing the [New] or [Add] button to
analyze the statistical information and display itsresult in the [Result] list.

Note: Inthisemulator, only [PTR] can be set as arange. Each of other items must be specified
as acharacter string. In analysis of statistical information, character strings are compared
with those displayed in the [ Trace] window. Only those that completely match are
counted. Note, however, that thistest is not case sensitive. The number of blanks will not
be cared either.
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5.6.12 Extracting Function Callsfrom the Acquired Trace Information

To extract function calls from the acquired trace information, select [Function Call...] from the
popup menu. The [Function Call Display] dialog box will be displayed.

Function Call Displas 2 x|
Setting
Enable to dizplay trace information with function
call anly ¢
 Enable " Dizable

ok | LCancel |

Figure5.37 [Function Call Display] Dialog Box

[Setting]: Selects whether or not to extract function calls.
[Enable]: Extracts function calls.
[Disable]: Does not extract function calls.

When [Enabl€] is selected, only the cycles that include function calls are extracted for display
from the acquired trace information. The content of the trace buffer is not changed by extraction of
function calls. Using this function for the trace information that includes function calls allows the
user to know the order of function calls.
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5.7 Analyzing Performance

Use the performance analysis function to measure execution performance. The performance
analysis function does not affect the realtime operation because it measures execution performance
in the specified range by using the on-chip circuit for performance measurement.

Note: The measurement conditions and the number of channels differ depending on the product.
Refer to the EL0A-USB emulator’ s additional document that is specific to the MCU/MPU
you are using.

57.1 Opening the [Performance Analysis] Window

Choose [View -> Performance -> Performance Analysis] or click the [PA] toolbar button () to
open the [Select Performance Analysis Type] dialog box.

ct Performance Analysis Type B

Performance Analysis: Performance Analysis

LCancel

Figure5.38 [Select Performance Analysis Type] Window

Click the [OK] button to open the [Performance Analysis| window.

o Performance Ar

*a “a *H H
Channel |Condition Result
Chl AT 0000C7DD
Chz BT oo000l02
Ch3 DISABLE 00000000
Ch4 DISABLE 00000000
Figure5.39 [Performance Analysis] Window
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It is possible to hide any column not necessary in the [ Performance Analysis] window. Selecting a
column you want to hide from the popup menu displayed by clicking the right-hand mouse button
on the header column hides that column. To display the hidden column, select the column from
the said popup menu again.

5.7.2 Setting Conditions for M easurement

Conditions for measurement can be displayed and changed in the [Performance Analysis] window.
Select a point where a condition isto be set, and then select [Set...] from the popup menu to
display the [Performance Analysis Properties] dialog box.

573 Starting Performance Data Acquisition

Executing the user program clears the result of previous measurement and automatically starts
measuring execution performance according to the conditions that have been set. Stopping the user
program displays the result of measurement in the [Performance Analysis] window.

574 Deleting a M easurement Condition

Select [Reset] from the popup menu with a measurement condition selected to delete the
condition.

575 Deleting All Measurement Conditions

Choose [Reset All] from the popup menu to delete all the conditions that have been set.
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5.8 Viewing the Profile I nformation

The profile function enables function-by-function measurement of the performance of the
application program in execution. This makesit possible to identify parts of an application
program that degrade its performance and the reasons for such degradation.

The High-performance Embedded Workshop displays the results of measurement in three
windows, according to the method and purpose of viewing the profile data.

5.8.1 Stack Information Files

The profile function alows the High-performance Embedded Workshop to read the stack
information files (extension: “.SNI”) which are output by the optimizing linker (ver. 7.0 or later).
Each of these files contains information related to the calling of static functionsin the
corresponding source file. Reading the stack information file makes it possible for the High-
performance Embedded Workshop to display this information to do with the calling of functions
without executing the user application (i.e. before measuring the profile data). However, this
feature is not available when [ Setting->Only Executed Functions] is checked in the pop-up menu
of the [Profile] window.

When the High-performance Embedded Workshop does not read any stack information files, the
data about the functions executed during measurement will be displayed by the profile function.

To make the linker create a stack information file, choose [Build -> SuperH Risc engine Standard
Toolchain...], and select [Other] from the [Category] list box and check the [Stack information
output] box in the [Link/Library] sheet of the [Standard Toolchain] dialog box.
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enging Standard Toolchain

Configuration : G/C++ | Assembly  Link/Library |Standard Library | GPU | Debt |+
{Debug E10A SYSTEM =l

Category IOther LI

Mizcellaneous options :

El--@ All Loaded Projects

=R

-0 © source file

20 G++ source file

#-10 Azsembly source file

[ 1A hways output 59 recard at the end
i‘Eit- k information output

j
[1Compress debug information

-2 Linkage symbal file [low memory use during linkage ;l
User defined options : IF'.bsoIutel’F{eIucatablefLibrary ;I

=

=l

Optionz Link/Library :
-noprelink -rom=D=F, -nomessaege ﬂ

—list="FICONFIGDIRMSPROJECGTHAME) map™ —nooptimize
-start=DVECGTTEL DINTTEL/T0.FReset PRG Pt PRGADS00.P.C.C

QK I Cancel I

Figure5.40 [Standard Toolchain] Dialog Box (1)
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5.8.2 Profile Information Files

To create a profile information file, choose the [Output Profile Information Files...] menu option
from the pop-up menu of the [Profile] window and specify the file name, after measuring a profile
data of the application program.

This file contains information on the number of times functions are called and global variables are
accessed. The optimizing linker (ver. 7.0 or later) is capable of reading the profile information file
and optimizing the allocation of functions and variables in correspondence with the status of the
actual operation of the program.

To input the profiler information file to the linker, choose [ Optimize] from the [Category] list box
and check the [Include profile] box in the [Link/Library] sheet of the [Standard Toolchain] dialog
box, and specify the name of the profile information file.

SuperH RISC engine Standard Toolchain

Configuration : G/G++ | Assembly Link/Library | Standard Library | GPU | Deb 4| |
[Debue_E10A_SYSTEM I Category + [optimize =
E'@ All Loaded Projects Show entries for :
= 5 e uid
: . IOptlmlze items ;I
[:l Z zource file
|:| G+ zource file Optimize : ISpee.j vl Eliminated size :I (001 EE
H-C1] Assembly source file - - : i
-] Linkage symbal file [ Linify strings W include profile ;
WIEliminate dead code |
WFeallocate regizters Modify..
[C1Eliminate same code Cache size i —
WlOptimize branches Size - I (0008 E

Line : I (0020 Eﬁ

Optionz Link/Library :

-noprelink -rom=D=F, -nomeszage
~ligt="${CONFIGDIR¥S (PROJECTHAMEN map”
—-optimize=speed

Lel]»

oK I Cancel

Figure5.41 [Standard Toolchain] Dialog Box (2)

To enable the settings in the [Include profile] box, specify the [Optimize] list box as some setting
other than [None].
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583

Loading Stack Information Files

Y ou can select whether or not to read the stack information file in a message box for confirmation
that is displayed when aload module is loaded. Clicking the [OK] button of the message box |oads
the stack information file. The message box for confirmation will be displayed when:

There are stack information files (extension: “*.SNI").
The [Load Stack Information Files (SNI files)] check box is checked in the [Confirmation]

sheet of the [Options] dialog box (figure 5.42) that can be opened by choosing [ Setup
->Options...] from the main menu.

Options

Build | Editor | Debue |

Dizplay confirmation dialoes for:

Workspace Confirmation ]Network

[winitialize Target

[Wikeyboard shartout
[Load Program
;i.-:--an:l Stack Inform
[Loading Labels

[w]Fezet P4 Setting
wlsave file changes
[ ISave memary
[1Savine Labels

——1

[WiGo when no programs downloaded

WIhwalid macra initial directary

ation Files

[[Lose seszion changes on refresh
wilacra recording with non zupported target
wiMested zymbalz expansion

[w]Feload out-of-date download modules
[w]Fezet All P& Settines

[w]Fezet All P& Settines at Loading

[wlscan Dependencies Prior To Build

~ Set All
Clear All

overnrite

before mode switch

o ]

Cahcel

Figure5.42 [Options] Dialog Box
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584 Enabling the Profile

Choose [View->Performance->Profile] to open the [Profile] window.

Choose [Enable Profiler] from the pop-up menu of the [Profile] window. The item on the menu
will be checked.

5.85 Specifying Measuring M ode

Y ou can specify whether to trace functions calls while profile datais acquired. When function
calls are traced, the relations of function calls during user program execution are displayed as a
tree diagram. When not traced, the relations of function calls cannot be displayed, but the time for
acquiring profile data can be reduced.

To stop tracing function calls, choose [Disable Tree (Not traces function call)] from the pop-up
menu in the [Profile] window (a check mark is shown to the left of the menu item).

When acquiring profile data of the program in which functions are called in a special way, such as
task switching in the operating system, stop tracing function calls.

5.8.6 Executing the Program and Checking the Results

After the user program has been executed and execution has been halted, the results of
measurement are displayed in the [Profile] window.

The [Profile] window has two sheets; a[List] sheet and a[Tree] sheet.
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587  [List] Sheet

This sheet lists functions and global variables and displays the profile data for each function and

variable.
Prafile
2 - 5] D% | |
Function/Varishle | F/Vl Address | Size Times | Optionl OptionZ | -
_PowerON_Reset PC F ooooogao H'OO0000O0:Zc 1 1214 ]
Sample:: Sample () F oooozood H'O00000ZE 1 1752 ]
_ divlu F oooo14es  H'OOO0O0OCOO 1 945 ]
oooo1zvo F oooo137o  H'O00000o0o0 1 2930 ]
_malleoc F oooolzco  H'O0000O0CO 1 5093 ]
_free F oooo1Zzic  H'OO0000000 1 1264 ]
_rand F 0odol11lrF0 H'OOO0O00O0ZC 10 9880 ]
operator newiunsigned... F ooooilig8c  H'O0000064 1 2547 0
- CATT, THNTT F nnnniiEg H'OOOOONZ 1 1405 I n _}ILI
4 PI'\ List f{Tree f

Figure5.43 [List] Sheet

Clicking the column header sorts the itemsin an alphabetical or ascending order. Double-clicking
the [Function/Variable] or [Address] column displays the source program corresponding to the

addressin theline.

Right-clicking on the mouse within the window displays a pop-up menu. For details on this pop-

up menu, refer to section 5.8.8, [Tree] Sheet.
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58.8 [Tree] Sheet

This sheet displays the relation of function calls along with the profile data that are values when
the function is called. This sheet is available when [Disable Tree (Not traces function call)] is not

selected from the pop-up menu in the [Profile] window.

Prafile [x]

B - |5l GEA |

Function | Address | Size | Stack Size | Times | Optionl | Optiond | 0
Bl CiyProgram Files\RenesashHew'ToolshR. ..

E| PowerON_Reset PC 0oo00g00  H'O000O00ZC  H'OOOOOO00O0 1 1814 u] u]

INITSCT 000010p0  H'00000000 H'00000000 1 132142 0 0

CALL_INIT 00001138 H'0000O00ZC  H'OOOOOOOO 1 1405 u] u]

ain 00001024  H'00000094 H'O000OOOO 1 15430 [u} i]

- Sample: : Sample () 00002000 H'000000ZE  H'0000CO0O 1 0 0

é""uperatur new (unsigned long) 0000118c  H'OOOOOO64 H'OOOOOOOO 1 2547 u] u]

! - _roalloe 000012Zed  H'O000O0OOO H'OO00OOO0OO 1 5093 u] u]

"""" rand 000011F0  H'ODOOODZC  H'OOOOOOOO0 10 9380 u] 0

«| [ I |

AR List A Tree

Figure5.44 [Tree] Sheet

Double-clicking afunction in the [Function] column expands or reduces the tree structure display.
The expansion or reduction is also provided by the “+" or “-“ key. Double-clicking the [Address]
column displays the source program corresponding to the specific address.

Right-clicking on the mouse within the window displays a pop-up menu. Supported menu options
are described in the following:

e View Source
Displays the source program or disassembled memory contents for the address in the selected
line.

e View Profile-Chart
Displays the [Profile-Chart] window focused on the function in the specified line.

e Enable Profiler
Toggles acquisition profile data. When profile data acquisition is active, acheck mark is
shown to the left of the menu text.
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¢ Not trace the function call
Stops tracing function calls while profile data is acquired. This menu is used when acquiring
profile data of the program in which functions are called in a specia way, such astask
switching in the operating system.
To display therelation of function callsin the [Tree] sheet of the [Profile] window, acquire
profile data without selecting this menu. In addition, do not select this menu when optimizing
the program by the optimizing linkage editor using the acquired profile information file.

e Find...
Displaysthe [Find Text] dialog box to find a character string in the [Function] column. Search
is started by inputting a character string to be found in the edit box and clicking [Find Next] or
pressing the Enter key.

e FindData...
Displaysthe [Find Data] dialog box.

Find Data EHE |

Cancel |

Find Data

' Maximum

= Minimum

Figure5.45 [Find Data] Dialog Box

By selecting the column to be searched in the [Column] combo box and the search typein the
[Find Data] group and entering [Find Next] button or Enter key, search is started. If the [Find
Next] button or the Enter key isinput repeatedly, the second larger data (the second smaller
data when the Minimum is specified) is searched for.

e Clear Data

Clears the number of times functions are called and profile data. Datain the [List] sheet of the
[Profile] window and the datain the [Profile-Chart] window are also cleared.
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Output Profile Information Files...

Displays the [Save Profile Information Files] dialog box. Profiling results are saved in a profile
information file (.pro extension). The optimizing linkage editor optimizes user programs
according to the profile information in thisfile. For details of the optimization using the profile
information, refer to the manual of the optimizing linkage editor.

Note: If profile information has been acquired by choosing the [Not trace the function call]

menu, the program cannot be optimized by the optimizing linkage editor.

Output Text File...
Displaysthe [Save Text of Profile Data] dialog box. Displayed contents are saved in atext file.
Setting
This menu has the following submenus (the menus available only in the [List] sheet are also
included).
— Show Functions/Variables
Displays both functions and global variables in the [Function/Variable] column.
— Show Functions
Displays only functions in the [Function/Variable] column.
— Show Variables
Displays only global variablesin the [Function/Variable] column.
— Only Executed Functions

Only displays the executed functions. If a stack information file (.sni extension) output
from the optimizing linkage editor does not exist in the directory where the load moduleis
located, only the executed functions are displayed even if this check box is not checked.

— Include Data of Child Functions

Sets whether or not to display information for a child function called in the function as
profile data.

Properties...
Sets the items to be measured.
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589 [Profile-Chart] Window

The [Profile-Chart] window displays the relation of calls for a specific function. This window
displays the specified function in the middle, with the callers of the function on the left and the
callees of the function on the right. The numbers of times the function calls the called functions or
iscalled by the calling functions are also displayed in this window.

Profile—Chart x|

_Power0ON Reset_PC Sample::sortilong *

Sample: : Sauple |

Figure5.46 [Profile-Chart] Window

5.8.10 Typesand Purposes of Displayed Data
The profile function is able to acquire the following information:

Address Y ou can see the locations in memory to which the functions are allocated.
Sorting the list of functions and global variablesin order of their addresses
alows the user to view the way the items are allocated in the memory space.

Size Sorting in order of size makesit easy to find small functions that are frequently
called. Setting such functions as inline may reduce the overhead of function
calls. If you are using a microcomputer which incorporates a cache memory,
more of the cache memory will need to be updated when you execute larger
functions. Thisinformation allows you to check if those functions that may
cause cache misses are frequently called.

Stack Size When there is degp nesting of function calls, pursue the route of the function
calls and obtain the total stack size for al of the functions on that route to
estimate the amount of stack being used.

R20UT0870EJ1000 Rev. 10.00 Page 174 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 5 Debugging

Times

Profile Data

Sorting by the number of calls or accesses makesit easy to identify the
frequently called functions and frequently accessed global variables.

Measurement of avariety of CPU-specific datais also available aswell asitems
that can be measured with the performance measurement function. For details,
refer to the online help.

5.8.11 Creating Profile Information Files

To create a profile information file, choose the [Output Profile Information Files...] menu option
from the pop-up menu. The [Save Profile Information Files] dialog box is displayed. Pressing the
[Save] button after selecting afile name will write the profile information to the selected file.
Pressing the [ Save All] button will write the profile information to all of the profile information

files.
el .3
Prafile Information files Glose |
Program Files | Frafile Infarmation files =
Sample Z: M Program Files\RenesastHew\Tools\A. ..
Save Al |
Browse,. |
<] | 2
Figure5.47 [Save Profile Information Files] Dialog Box
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58.12 Notes

1. Tolerances

The profile function internally breaks user program execution, collects the measured data, and
re-executes the user program.

Since the function also counts when the measured item is generated at break or re-execution,
tolerances will be included in the measured profile value.

The measured value of this function should be the reference.

2. Functions that cannot be used while the profile function is being used
(a) Performance measurement function
The profile function isimplemented by using the performance measurement function

described in section 2.4, Performance Measurement Function. This function cannot be
used when the profile function is enabled.

(b) Step function
When the profile function is enabled, do not use the step function. The profile data cannot
be measured correctly.

(c) Internal trace function
When the profile function is enabled, it isinvalid to select the internal trace mode as all
items of the internal trace mode are internally selected. Do not use the internal trace when
the profile function is enabled.

(d) Continuous trace function (only for the supported devices)
When the profile function is enabled, do not use the continuous trace function that is used
in the internal trace function. The profile data cannot be measured correctly.

(e) Halt function

When the profile function is enabled, do not use the halt function of theinternal and AUD
traces.

(f) Memory access during user program execution
When the profile function is enabled, memory access is disabled during user program
execution.

(9) When the profile function is used, abreak occursif abranch instruction is generated.
Accordingly, the realtime emulation will not be performed. In addition, since the emulator
firmware is controlled on generation of a break, the executed result of the branch
instruction may be displayed on the [Trace] window when the execution is returned to the
user program from the emulator firmware. In this case, **EML** is displayed.

(h) When the profile function is enabled, do not use the function of Event Condition 3.

R20UT0870EJ1000 Rev. 10.00 Page 176 of 292
Aug 10, 2012 RENESAS



SuperH™ Family E10A-USB Emulator Section 5 Debugging

3. Others

(a) When the profile function is used, the contents that have been set in the performance
measurement function or data that has been measured will be deleted.

(b) Since the profile function is implemented with the internal break, it takes along time to
start and end the user program execution. The user program execution times under the
following environment are shown below:

Environment:
Host computer: 3.00 GHz (Pentium® 4)
Memory: 1.00 Ghyte
SH72633: 5 MHz (TCK clock)
OS: Windows® XP
Execution program: 10,000 nested calls

(i) When the profile function is not used: 1 second or lower

(if)  When the profile function is used in the setting without including a child function:
17 seconds

(iif) When the profile function is used in the setting including a child function:
20 seconds

5.9 Using Multiple Debugging Platforms

Multiple debugging platforms can be operated at the same time in the High-performance
Embedded Workshop.

When selecting [Renesas High-performance Embedded Workshop] -> [High-performance
Embedded Workshop] from [Programs] in the [ Start] menu to initiate another High-performance
Embedded Workshop, two emulators can be used separately for debugging.
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591 Distinguishing Two Emulators

Connect two emulators to the USB connector. Then, initiate the High-performance Embedded
Workshop using the tutorial workspace. The following message is displayed.

L ] 'l_.,‘ Pleaze chooze driver.
[ ]

Figure5.48 Message for Driver Selection

Click the [OK] button. The following dialog box will appear.

Driver Details

Driver: |SlR i

Detailz

Interface: | ﬂ

Channel: | ﬂ

[ Ceniie.

Cloze

Figure5.49 [Driver Details] Dialog Box (1)
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Select [Renesas E-Series USB Driver] from the [Driver] drop-down list box and open the
[Channel] drop-down list box. Channel information for two emulatorsis displayed in the
[Channel] drop-down list box as shown in figure 5.50.

Driver Details

Dir iver: |Rﬂnesas E-Seriez USE Driver ﬂ
Detailz
Interface: |L|SEE interface ﬂ
Channel: |N-:| channel zelected ﬂ

(Mo channel selected

4=

Cloze

Figure5.50 [Driver Details] Dialog Box (2)

Information displayed in figure 5.50 is the information of the USB connector to which the
emulators are connected.

Note: The displayed character strings of the information differ according to the host computer’s
environment.

Check which of the character strings of information show emulators.

Select [<no driver selected>] in the [Driver] drop-down list box and disconnect one emulator from
the USB connector. After that, select [Renesas E-Series USB Driver] in the [Driver] drop-down
list box. Only information on the USB connector that the emulator is connected to is displayed in
the [Channel] drop-down list box.

The above procedures are used to discern which of the emulators are indicated by the displayed
character strings of information in the [Channel] drop-down list box.
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Examples

E10A-USB: [Cont0] —[Port1]:
The emulator is connected to port 1 of USB controller 0.

E10A-USB: [Cont4] —[Port7][Port3]:
The emulator is connected to general hub port 3 connected to port 7 of USB controller 4 (only
selectable when a USB hub is connected).

510 Start/Stop Function

The start/stop function is useful if you wish to control a user system in synchronization with
starting and stopping of user program execution.

To open the [Start/Stop Function Setting] dialog box, select [Setup -> Emulator -> Start/Stop
function setting...] or click on the [Start/Stop Function Setting dialog box] toolbar button.

!
(=]

Figure5.51 [Start/Stop Function Setting dialog box] Toolbar Button

Start/Stop Function Settine

v Fun the specified routine just before the uzer
program execution ig started.

Start address HD j

v Fun the specified routine just after the uszer
program execution iz stopped.

Start address ] j

_. .............. DK ................ Gancel |

Figure5.52 [Start/Stop Function Setting] Dialog Box
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The [Start/Stop Function Setting] dialog box contains the following options.
[Run the specified routine just before the user program execution is started.] checkbox:
Select this box if you wish to run a user routine just before the user program execution starts.

[Start address]:  Specify an address where aroutine will start to run just before the user
program execution starts. Y ou can aso specify alabel. Do not specify
an odd-numbered address.

[Run the specified routine just after the user program execution is stopped.] checkbox:
Select thisbox if you wish to run a user routine just after the user program execution stops.

[Start address]:  Specify an address where aroutine will start to run just after the user
program execution stops. Y ou can aso specify alabel. Do not specify
an odd-numbered address.

Notes: 1. The start/stop function is not supported for all products. For details on the
specifications of each product, refer to the online help.

2. For details, refer to the START_FUNCTION_BEFORE and
STOP_FUNCTION_AFTER command pages in the online help information.

3. The start/stop function is subject to the following limitations.
e  AnRTSinstruction must be written at the end of the user routine.
e  Theuser routine must end.
e  Ensurethat no break occurs within the user routine.
e Nointerrupts should be accepted in the user routine.
e  Theuser routine to run before the user program execution starts must end within

2ms.

e  Theuser routine to run after the user program execution stops must end within
30s.

e  User stack should be used by the user routine to run after user program
execution.

e If the user routine is to use a general-purpose register, saving the contents of the
register, making theinitial setting, and restoring the contents should al be done
within the routine.

e If valuesare set viathe [Registers] window of the HEW just before user program
execution starts, these values will not be reflected to the user routine.
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If values of general-purpose registers are changed by the user routine, execution
of the user program being debugged will not be affected.

While profiling isin progress, the user routine (start or stop) runs whenever
branch information is acquired.

The specified user routine must not include the sleep() intrinsic function in the
case of C/C++ or the SLEEP instruction in the case of assembly.

The specified user routine must not include division or modular multiplication in
the case of C/C++ or DIVS or DIVU instructions in the case of assembly.

The specified user routine must not include interrupt functions declared by
#pragmainterrupt in the case of C/C++ or the RESBANK instruction in the case
of assembly.

Ensure that FPU exceptions do not occur within the user routine.
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Section 6 Tutorial

6.1 Introduction
This section describes the main functions of the emulator by using a tutorial program.

The tutorial program is based on the C++ program that sorts ten random data items in ascending or
descending order. Thetutoria program performs the following actions:

e Themain function generates random data to be sorted.
e The sort function sorts the generated random data in ascending order.
e The change function then sorts the data in descending order.

Thefiletutorial . cpp contains source code for the tutorial program. Thefile
Tutorial.abs isacompiled load modulein the Elf/Dwarf2 format.

Notes: 1. Operation of Tutorial .abs isbigendian. For little-endian operation,
Tutorial.abs must be recompiled. After recompilation, the addresses may differ
from those given in this section.

2. Thissection describes general usage examples for the emulator. For the specifications
of particular products, refer to the additional document, Supplementary Information
on Using the SHxxxx, or the online help.

3. Theoperation address of Tutorial . abs attached to each product differs depending
on the product. Replace the address used in this section with upper 16 bits of the
actually loaded address.

Example: Although the PC address is H’ 0000006c in the manual, enter H' O0CO0XXxx
when the loaded address of Tutorial . abs isH 0C00006c (upper bit H' 0000 is
changed to H' 0C00).

4. When using the MCU with flash memory, specify the end address of the internal
RAM for the stack pointer (SP) and re-compile the program. The internal RAM area
differs depending on the MCU. Refer to the hardware manual of the MCU used.

5. Thedisplayed addresses and data may differ from those given in this section
depending on the MCU/MPU to be used.
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6.2 Running the High-per formance Embedded Workshop

To run the High-performance Embedded Workshop, refer to section 3.11, System Check.

6.3 Setting up the Emulator

The clocks which are used for data communi cations must be set up on the emulator before the
program is downl oaded.

e AUD clock
A clock used in acquiring AUD traces.
If its frequency is set too low, complete data may not be acquired during realtime tracing.
Set the frequency not to exceed the upper limit for the MCU/MPU’s AUD clock.
The AUD clock is only needed for using emulators that have an AUD trace function.
e JTAG (H-UDI) clock (TCK)
A communication clock used except for acquiring AUD trace.
If its frequency is set too low, the speed of downloading will be lowered.
Set the frequency not to exceed the upper limit for the MCU/MPU’ s guaranteed TCK range.

For details of the limitations on both clocks, refer to section 2.2.3, Notes on Using the JTAG
(H-UDI) Clock (TCK) and AUD Clock (AUDCK), in the additional document, Supplementary
Information on Using the SHxxxx.

The following is a description of the procedure used to set the clocks.
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6.4 Setting the [Configuration] Dialog Box

Select [Emulator] then [Systems...] from the [Setup] menu to set a communication clock. The

[Configuration] dialog box is displayed.

Configuration

General | Loading flash memory ]
Mode
Emulation mode |Nurma| ﬂ
Step option |Di3ah|es interruptz during =ingle step execution ﬂ
UBG mode [Eml =l
PPC made [Eml |
Memary area t+ Mormal © Phwsical © Mirtual
ALD clock [1/8 GPU clock [~
UTAG clack [1.25MHz =l
TLE Mode |TLB mizs exception is dizabled |
When TLE Error occurred |Display TLE error mezzage to Dialog box ﬂ
Rezet Mode |,ﬁ.ut.;. j
Read Status v PGSR
PPC Cption [v It counts during GPU zleep
I|me|:|u‘t 1 1 1 1 1 1 1 1 1 1
| T e
, ' ) ' ' ' ' ' ' ;
0] 4 | Cancel | ‘

Figure6.1 [Configuration] Dialog Box

Set appropriate valuesin the [AUD clock] and [JTAG clock] combo boxes. The clock also

operates with the default value.
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Note: Theitemsthat can be set in this dialog box differ according to the product. For details on
the settings for each product, refer to the online help.

e Click the [OK] button to set a configuration.

6.5 Checking the Operation of the Target Memory for Downloading
Check that the destination memory areafor downloading is operating correctly.

When the destination memory is SDRAM or DRAM, aregister in the bus controller of the device
must be set before downloading. Set the bus controller correctly in the [10] window according to
the memory type to be used.

When the required settings, such as the settings for the bus controller, have been completed,
display and edit the contents of the destination memory in the [Memory] window to check that the
memory is operating correctly.

Note: The above way of checking the operation of memory may be inadequate. Itis
recommended that a program for checking the memory be created.

e Sdlect [Memory...] from the [CPU] submenu of the [View] menu and enter H2 00000000
and H”000000FF in the [Begin] and [End] edit boxes, respectively.

Mizplay Address

Digplay Address: Q0000000 -

Scroll Start Address: 00000000 |
Seroll End Address:  |FFFFFFFF -]

(] 4 I Cancel |

Figure6.2 [Display Address] Dialog Box

e Click the[OK] button. The [Memory] window is displayed and shows the specified memory
area.
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Memory [00000000] X
p oz (5 00 B Z A £ aas 32 [

hddress | Label Rezister 0+ +2 +3 +4 +h +B 47 +3 +3 +A +B +C 40 +E  +F | ASCII ~
] Qoo oo 08 00 00 01 00 00 00 00 0% 2 00 01 00 00 =
000o0010 oo oo 02 44 00 00 0% 4% OF E1 OF F1 OF E1 OF F1

nooooozo OF E0 OF EO OF FO OF FO OF E1 OF EO OF F1 OF EO

00000030 OF E1 OF EO OF FO OF F1 OF F1 OF FO OF E0 OF E1

00000040 OF E0 OF E1 OF EO OF E0 OF F1 OF FO OF FO OF FO

0oonoosn OF E1 OF F1 0OF F1 OF E1 OF EO OF FO OF FO OF E1

000000gn OF F1 OF FO OF EO OF E0O OF FO OF ED OF FO OF Fi

0000on7o OF E0 OF E1 OF F1 OF E1 OF ED OF ED OF FO OF FO

00000080 OF F1 OF E1 OF F1 0OF E1 OF FO OF F1 0OF E0 OF E1

00000030 OF F1 OF E1 OF FO OF E1 OF EO OF ED OF F1 OF F1

0000004n OF E1 OF FO OF EO OF E1 OF EO OF FO OF E0O OF F1

000000En OF FO OF FO OF F1 OF F1 OF F1 OF E1 0OF E1 OF El “
< ?

Figure6.3 [Memory] Window

¢ Placing the mouse cursor on apoint in the display of datain the [Memory] window and
double-clicking allows the values at that point to be changed. Data can also be directly edited
around the current position of the text cursor.

6.6

6.6.1

Downloading the Tutorial Program

Downloading the Tutorial Program

Download the object program to be debugged.

In this emulator, it is enabled to download the program and set the PC breakpoint in the internal
flash memory area. For the method to set the PC breakpoint, refer to section 6.17.1, PC Break

Function.

o Select [Download modul€] from [Tutorial.abs] under [Download modules].
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E@ tutorial
EI@ tutorial
=3 G header file
----- =] =hrk.h

----- ; sorth

----- g stackscth
..... ; vecth
=53 © zource file
..... ] dbscte

..... 9 intprg.c

..... =] resetprec
----- g shrk.c

----- Q wecttblc
=53 G+ gource file
Q zort.cpp
2] tutorialcpp
=3 Download modules

Unload

Dawnload & WNew Module...

Bemove

Debug Settings..

Configure Wiew...

IT Allow Docking
Hide

Properties...

Figure6.4 Downloading the Tutorial Program
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6.6.2

Displaying the Sour ce Program

The High-performance Embedded Workshop allows the user to debug a user program at the

source level.

e Double-click [tutorial.cpp] under [C++ source filg].

= @ tutorial

= I@ tutorial

-2 © header file
[=] sbrkh
[ sorth
[2] stackscth
Q wecth

=123 G zource file
[2] dbscte
Q intpre.c

resetprec

Q shrk.c
Q vectthlc

-9 G+ source file
Q sort.opp

—1-Z3 Download modules
tutorialabs - 000
3 Dependencies

|z &|&

Line Source & E.| 5. Source
13
14 fifdef __cplusplus
15 Fitinclude <ios>
16 Alint oz _baserzlnitziinit_cnt;
17 fendif
18 fifdef __cplusplus
k] extern “C"
20 ftendif
21 wvoid abarti{void);
22 fifdef __cplusplus
23
24 endif
i include "sort.h”
26 include <stdlib.hX>
27
28 (00001024 wvoid main(void)
29
30
1 lang a[10];:
32 long j3
33 int i;
34 clazz Zample #p_sam;
35
36 (00001036 while (131
37 (00001034 p_sam= new Sample;
38 (00001038 for{ =0y <10 i++ )
39 100001044 i = rand(]};
40 (00001048 [RESRESNIDE]
41 (00001050 o= =i
42
43 100001068 alil = is
44
45 (00001068 p_sam-rzsortia);
46 foooo1o7n p_zan-rchangeia);
47
48 (00001076 p_sam->=0=a[0];
49 (0000107 & p_sam-»s1=a[1];
50 |0000107E p_san-rs2=a[2];
51 (00001082 p_san-r=zi=al[d];
52 |0000108E6 p_sam-rzd=a[4];
53 (00001084 p_zan-rsb=al5];
54 |0000108E p_san-rsb=a[B];
55 (00001092 p_sam->s7=a[7];
BE |0000109E p_sam->rs8=a[8];
57 100001094 p_san-rs¥=a[8];
58 |0000108E delete p_sam;
54
1} H
B1
G2 |000010B8 woid abartivoid]
B3 {
64
31 i

Figure6.5 [Editor] Window (Displaying the Sour ce Program)
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e Select afont and size that are legible from the [Format...] option in the [ Setup] menu if
necessary.

Initially the [Editor] window shows the start of the user program, but the user can use the scroll
bar to scroll through the user program and look at the other statements.

6.7 Setting a PC Breakpoint
A PC breakpoint is a simple debugging function.

The [Editor] window provides avery simple way of setting a PC breakpoint at any point in a
program. For example, to set a PC breakpoint at the sort function call:

e Select by double-clicking the [S/'W breakpoint] column on the line containing the sort
function call.
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=3 tutarial 5i &l| &
= tutorial
z |
= - ine ource &. | E.| 5. Source
E3 © header file Li S A EJS. S
[=] sbrkh 13
2] sorth 14 fifdef __cplusplus
E .k h 15 Sitinclude <iosk
" int joz_bazer:Initiiinit_cnt;
S‘acth“‘ 1 é;" t ios_b Init:zinit_ent
vect, 17 endif
-9 © zource file }g Ki{def FEEpluscplus
extern
= ﬁif;i 20 frendif
! 21 void abort{voidl;
%resetprg.c 22 fifdef __cplusplus
shrkc 23 1
[ Vecttbl.c 24 n?”dif M N
P Einclise (sonit e
sortopp a7
28 (00001024 void main(void)
=23 Download modules gg
- D. tut;rlal..abs— oo a1 lons a[IU]
ependencies 39 long j:
23 int i3
34 clazzs Zample #p_sam;
35
36 (00001036 while (131
37 (00001034 p_sam= new Sample;
38 (00001038 forf i=0; i<1(g: i+t 3
39 (00001044 i = rand
40 (00001048 i < 0
41 (00001050 i= -
42
ii 00001058 a[i] =0
45 (00001068 ) p_sam-»sort{a);
46 00001070 p_san->changela):
47
45 00001078 p_zam-rsl=a[0];
49 (00001074 p_zam->s1=al1];
50 (0000107E p_zam-rs2=a[2];
51 |(Dooninaz p_zam-rsi=a[3];
52 (00001086 p_zam-rs4=a[4];
53 (00001084 p_zam-»s5=a[5];
54 | 0000108E p_zam-rsh=a[B];
55 (00001042 p_zam-»s7=a[7];
56 (00001096 p_zam-rs8=a[8];
57 (00001034 p_zam-»si=a[3];
5% (0000109E delete p_sam;}
54
£0 1
B1
EZ |D00010B8 void abort (void)
B3 {
B4
68 }

Figure 6.6 [Editor] Window (Setting a PC Breakpoint)

The symbol e will appear on the line containing the sort function. This shows that a PC
breakpoint has been set.

Note: The PC breakpoint cannot be set in the ROM area.
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6.8 Setting Registers
Set values of the program counter and the stack pointer before executing the program.

o Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is
displayed.

Neme | Value Radix |&
RO 0ooopono Hex
Rl oooooooo Hex
R2 aooooono Hex
E3 0ooopono Hex
R4 Qooooono Hex
RS aooooono Hex
RE 0ooooono Hex
R7 Qooooono Hex
k2 aooooono Hex
el 0ooopono Hex
r10 Qooooono Hex
R11 o0ooooooo Hex
R1Z 0ooopono Hex
R13 0ooopono Hex
R14 o0ooooooo Hex
R15 20000000 Hex
P 20000000 Hex
3R 01110000000000000000000011110000 MEEOOOOOO000000-—-——-—- 111i00-- EBin
GER aooooono Hex
VER 0ooooono Hex
Ma - H nnnnnnNnn Haw ¥
< |

Figure6.7 [Register] Window
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¢ To change the value of the program counter (PC), double-click the value areain the [Register]
window with the mouse. The following dialog box is then displayed, and the value can be
changed. Set the program counter to H’ 00000800 in this tutorial program, and click the [OK]
button.

PG — 5et Value

Yalue : (00000200

Radiz: |Hex [~

oet fs: |'I.I'l.l'n|:||e Reeizter ﬂ

(] 4 | Cancel |

Figure 6.8 [Register] Dialog Box (PC)

e Change the value of the stack pointer (SP) in the same way. Set H’ 00010000 for the value of
the stack pointer in this tutoria program.
When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). The internad RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

RS — S5et Value

Yalue : (00010000

Radix: |Hex |

oet fs: |'I.I'l.l'n|:||e Reeizter ﬂ

(] 4 | Cancel |

Figure6.9 [Register] Dialog Box (R15)
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Execute the program as described in the following:
toolbar.

Section 6 Tutorial

To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the

!

Figure6.10 [Go] Button

When the program execution is started, * ** RUNNI NG  is displayed on the status bar, and then

the executed PC address is displayed in the products that support the CPU status acquisition
function. The program will be executed up to the breakpoint that has been set, and an arrow will

with the message [ BREAKPQO NT] in the status bar.

be displayed in the [S/W breakpoint] column to show the position that the program has halted,
2.

Notes: 1. When the sourcefileis displayed after a break, a path of the source file may be
inquired. The location of the sourcefileis asfollows:
<Drive where the OS has been installed>:

\WorkSpace\Tutorial\E10A-USB\xxxx\Tutorial\source.
Here, ‘xxxx’ means the target product group.

If program execution is failed, select [Reset CPU] from the [Debug] menu, reset the
device, and restart the procedure from figure 6.8.
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28 (00001024
29
a0
21
32
23
34
a5
g (00001036
a7 (00001034
38 (00001038
29 (00001044
40 (00001048
41 (00001050
47
43 (00001058
44
45 (00001068
46 (00001070
47
48 (00001076
49 (00001074
RO |0000107E
B1 (00001082
52 (00001086
RS (00001084
R4 |0000108E
BE (00001092
RE (00001096
57 (00001094
RE |0000109E
5
ED
B
B2 |000010BS
B3

woid main(waid)

long al10];

long j;:

int i:

clazs Sample %p_szam;

while (10
p_sam= new Sample;
forl i=03 i<10: 44+ 3
i = rand();
ifii < 03]

= -1
alil = Js

p_sam-rsortia);
p_sam->changefa);

p_sam-rs0=a[0];
p_=am-rsl=a[1];
p_sam-rs?=al[2];
p_sam-rs3=ald];
p_zam-rsd=a[4];
p_zam-rsh=a[h];
p_sam-rsb=alf];
p_sam-rs¥=al[7]:
p_sam-rs8=a[8];
p_=am-rsd=a[9];
delete p_sam;

h
¥Did abort (void)

Figure6.11 [Editor] Window (Break State)
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The user can see the cause of the break that occurred last time in the [Status] window.

e Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is
displayed, open the [Platform] sheet, and check the St at us of Cause of | ast break.

Status X
Ite_;q Statt_ls_

Connected to: SHxxx E1DA-USE IY¥YITEM (Renesas E-Series UIE Driver)
CEU S

Run status Ready

Cause of last hresk BREAEK POINT

Fun time count 0000hO00min000=04Tms

Ermulation wmode Hormal

Endian EBig

ATD Dizsshle

£ »

b '\ Memary }\Platfnrm A Events /

Figure6.12 [Status] Window

Note: Theitemsthat can be displayed in this window differ according to the product. For the
items that can be displayed, refer to the online help.
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6.10 Reviewing Breakpoints
The user can see all the breakpoints set in the program in the [Event] window.

e Sdlect [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed. Select the [Breakpoint] sheet.

L LI

Type | State | Condition Action

Ereakpoint Ensble Address=00001068 (tutorial.epp/45) Physical space Ereak

| Breakpuint_(i Ewent condition f

Figure6.13 [Event] Window

The popup menu, opened by clicking the [Event] window with the right-hand mouse button,
alows the user to set or change breakpoints, define new breakpoints, and delete, enable, or
disable breakpoints.
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6.11 Referringto Symbols
The [Label] window can be used to display the information on symbolsin modules.

Select [Label] from the [Symbol] submenu of the [View] menu. The[Label] window is displayed
so that the user can refer to the addresses of symbolsin modules.

EF |Address | Hame e

00000300 PowerON Reset PC
00oo082e  Manual Reset PC
00000844 INT Illegal code
Q0000848 Dummy

oo0o01000 shrk

00001024 main

000010B8  short

oooo10pd  INITSCT
000010E4 loopl

O0O010EC loop2

000010F0 next loopd
O00010F4 next loopl
00001108 loopd

00001104 loopd

00001110 next loopd
00001114 next loop3
000011E5 bsec_top

0000112cC bsec end e

Figure6.14 [Label] Window
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6.12 Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been
registered in the [Memory] window. For example, to view the memory contents corresponding to
_maininword size:

e Sdect [Memory ...] from the [CPU] submenu of the [View] menu, enter _maininthe
[Display Address] edit box, 00000000 inthe [Scroll Start Address] edit box, and FFFFFFFF
in the [Scroll End Address] edit box.

Mizplay Address E'E'
Display Address: -
Scroll Start Address: ||:||:||:||:||:”:”:”:I ﬂ
Scroll End Address: |FFFFFFFF ﬂ

(] 4 I Cancel |

Figure6.15 [Display Address] Dialog Box
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e Click the [OK] button. The [Memory] window showing the specified area of memory is

displayed.
Memory =
oz |6 0H0 8 2 aedydh dpdE| £ 0 a6 .32 | [
tddresz | Label Register +0 41 +2 43 +4 +5 4B +7 4B +3 N B 40 +D +E 4F ~
00001024 | main 2F &6 2F BE 2F CE 2F DE 2F EB 4F 22 7F CC E& OO
nooo1034 D2 21 B4 A3 42 OB ED 00O IF 0& BB 03 EE 0& DC 1F =
0ooo1044 4C 0B 00 03 40 11 E5 03 8D 02 IF OC BR BB IF 5C
Qonoios4 BE DE 46 08 BZ F3 32 BC 7D M 2 BE 4E 10 BF EF
00001064 1F DB D2 17 BS F3 42 0B B4 B3I D2 16 EBR F3 42 0B ....e.B.d...e.B.
oonoto74 B4 B3 B2 FZ 2B 22 52 F1 1B 21 52 FZ 1B 22 52 F3 d.b.+"R..!R.."R.
aonoioad | 1B 2% 62 F4 1B 24 B2 F5 1B 25 52 F& 1B 26 852 F7 .YR..IR..%R..%R.
Q0001034 1B 27 52 F8 1B 28 52 F3 1B 23 D2 OB 42 OB 64 B3 .'R..(R..)..B.d.
00001044 A&F CE 00 039 VF 234 4F 26 BKE FE GD FE BC FE BB FBE ..... A0kn.m. | ..
000010B4 00 OB BA F6 00 OB 00 03 00 00 20 00 00 00 10 FO ofeeeeier vownn
ono10c4 00 00 20 2E 00 00 20 AE 0O 0O 11 O OIE OZF OZE .. ... e o
£ >

Figure6.16 [Memory] Window
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6.13 Watching Variables

Asthe user steps through a program, it is possible to watch that the values of variables used in the
user program are changed. For example, set awatch on the long-type array a declared at the
beginning of the program, by using the following procedure:

o Click theleft of displayed array a in the [Source] window to position the cursor.
o Sdect [Instant Watch...] with the right-hand mouse button.

The following dialog box will be displayed.

Instant Watch

+-a {000OFFE4 } done[100)

Figure6.17 [Instant Watch] Dialog Box

e Click the [Add] button to add a variable to the [Watch] window.

Type Jcope
(long[10]) [Auto]

Watch1 f Watchz f, Watch3 }, Watchs [

Figure6.18 [Watch] Window (Displaying the Array)
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The user can also add a variable to the [Watch] window by specifying its name.

e Click the [Watch] window with the right-hand mouse button and select [Add Watch...] from
the popup menu.

The following dialog box will be displayed. Enter variable 1.

fAdd Watch

“Wariable or expression: ok

|i Cancel

Figure6.19 [Add Watch] Dialog Box
e Click the [OK] button.

The [Watch] window will now also show the int-type variable i.

{ 0000 ) (long[10]}
i H'0000000a { R13 ) {int) [Auto]

Watch1 f Watchz f, Watch3 }, Watchs [

Figure6.20 [Watch] Window (Displaying the Variable)

R20UT0870EJ1000 Rev. 10.00 Page 202 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 6 Tutorial

The user can click mark ‘+' at the left side of array a in the [Watch] window to watch all the
elements.

Type Acope
5 {long[107}) [Auto]
B [0] H'00000000 { OOOOF... (long)
M [1] H'000053de { OOOOF... [long)
B/ [zl H'O0O0Z704 { OOOOF... [long)
B o[3] H'00005665 { DOOOF... {long)
B 4] H'00000d=a { OOOOF... [ long)
B [5] H'OOOO421f | OOCOOF... [ loneg)
B (6] H'00003ead { DOOOF... (long)
B 7] H'00004d1d { OOOOF... [long)
B [e] H'00002Z£5a { DOOOF... {long)
® 9] H'00O0Z0da { OOOOF... [long)
i H'O00O0O0O=a { R13 } [int) [Auto]
Watchl 4 watch2 }, watchs i wWakchd [

Figure6.21 [Watch] Window (Displaying Array Elements)
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6.14 Displaying Local Variables

The user can display local variablesin afunction using the [Locals] window. For example, we
will examine the local variablesin the main function, which declares four local variables: a, 7, 1,
and p_sam.

e Select [Locals] from the [Symbol] submenu of the [View] menu. The [Locals] window is
displayed.

The [Locals] window shows the local variablesin the function currently pointed to by the program
counter, along with their values. Note, however, that the [Locals] window isinitially empty
because local variables are yet to be declared.

Name Value Type

El { } [long[101)
| H'0O00Z20da { RS 1} [ Loteg)
i H'0DO0OOO0= { R13 O} [int)
F-p sam 0x000053d8 { R11 } [class Sample*)

Figure6.22 [Locals] Window

e Click mark ‘+' at the left side of array a in the [Locals] window to display the elements.

o Refer to the elements of array a before and after the execution of the sort function, and
confirm that random datais sorted in descending order.
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6.15  Stepping Through a Program

The High-performance Embedded Workshop provides a range of step menu commands that allow
efficient program debugging.

Table6.1  Step Option

Menu Description

Command

Step In Executes each statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Steps out of a function, and stops at the statement following the statement in the

program that called the function.

Step... Steps the specified times repeatedly at a specified rate.

6.15.1 Executing [Step In] Command

The [Step In] command steps into the called function and stops at the first statement of the called
function.

e To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step
In] button on the toolbar.

#

Figure 6.23 [Step In] Button
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1

2 (nooozoon
3 |0nonzooz?
4 (00002012
16 |0000201E
16 |0000201%8
17 |000020714
18 |00ooznoic
13 |0000201E
20 |onon2o2o
21 (0oon2o22
22 (0oon2oz4
23 (00002026

26 (0000202E

31 |0000203E

38 (00002046
34 (00002064
3h (0000206C
36 (0000206C

34 (00002078
33 |ooon2ovc

46 (00002090

Sample::Sanplel)

}

void Sampleiisort(long #a)

}

long t;
i. i. k., gap:

gap = b3
whilel gap » 0 3
for{ k=0; kigap: k++i

forf i=k+gap: (<107 i=itzap )
for{j=i-zap: j»=k: j=j-zap){
iflalil>alitgap]df
t = alil;
alil = alitgapl;
all+tzap] = t;

elze
break;

H

gap = gap/2;

Figure6.24 [Editor] Window (Step In)

e The highlighted line movesto the first statement of the sort function in the [Editor] window.
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6.15.2  Executing [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the
calling statement in the main function.

e To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step
Out] button on the toolbar.

Note: It takes time to execute this function. When the calling sourceis clarified, use [Go To
Cursor].

¥

Figure6.25 [Step Out] Button
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Figure6.26 [High-performance Embedded Workshop] Window (Step Out)

The data of variable a displayed in the [Watch] window is sorted in ascending order.

R20UT0870EJ1000 Rev. 10.00 Page 208 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 6 Tutorial

6.15.3 Executing [Step Over] Command

The [Step Over] command executes afunction call as asingle step and stops at the next statement
of the main program.

¢ Moveto the change function following the procedures described in section 6.15.1, Executing
[Step In] Command.

e To step through all statementsin the change function at asingle step, select [Step Over] from
the [Debug] menu, or click the [Step Over] button on the toolbar.

o

Figure 6.27 [Step Over] Button
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Figure6.28 [High-performance Embedded Workshop] Window (Step Over)
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6.16

Forced Breaking of Program Executions

Section 6 Tutorial

Cancel all breaks.

or the [Go] button on the toolbar.

1

The High-performance Embedded Workshop can force a break in the execution of aprogram.
[ ]

To execute the remaining sections of the mai n function, select [Go] from the [Debug] menu

Figure6.29 [Go] Button

Lot

The program goesinto an endlessloop. To force abreak in execution, select [Halt] from the
[Debug] menu or the [Stop] button on the toolbar.

Figure6.30 [Stop] Button
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6.17 Break Function

The emulator has PC and hardware break functions. With the High-performance Embedded
Workshop, a PC breakpoint can be set using the [ Breakpoint] sheet of the [Event] window, and a
hardware break condition can be set using the [Event condition] sheet.

An overview and setting of the break function are described below.

6.17.1 PC Break Function

The emulator can set up to 255 PC breakpoints. Other methods for setting a PC breakpoint than in
section 6.7, Setting a PC Breakpoint, are described below.

e Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed.
o Select the [Breakpoint] sheet.

Y

Type State Condition Action

£ >
ki Breakpuint.,-ﬂ Event condition {

Figure6.31 [Event] Window (Before PC Breakpoint Setting)
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e Click the [Event] window with the right-hand mouse button and select [Add...] from the
popup menu.

e Enter H'00001076 inthe[Address] edit box.

Breakpoint

Addrezs l

Address
Walue  [HODOO1076

{« Mormal

(" Phwv=zical zpace

" \irtual zpace

2k | Cancel

Figure6.32 [Breakpoint] Dialog Box

Notes: 1. Thisdialog box differsaccording to the product. For the items of each product, refer to
the online help.

2. For some MCUSMPUs, the address value to be entered in the [Address] edit box is not
H'00001076. In such cases, specify the address where “p_sam->s0=g[(];"
(tutorial.cpp/48) is located.

e Click the [OK] button.
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The PC breakpoint that has been set is displayed in the [Event] window.

h

Type | State | Condition |Action
Breakpoint Enable Address=00001076(tutorial.cpp/48) FPhysical space Break

< >

| * |} Breakpoint ."{. Event condition fr

Figure6.33 [Event] Window (PC Breakpoint Setting)

Note: Theitemsthat can be displayed in this window differ according to the product. For the
items that can be displayed, refer to the online help.

To stop the tutorial program at the PC breakpoint, the following procedure must be executed:

e Set the program counter and stack pointer values (PC = H 00000800 and R15 = H’00010000)
that were set in section 6.8, Setting Registers, in the [Register] window. Click the [Go] button.
When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). The internad RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

o If program execution isfailed, reset the device and execute again the procedures above.
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The program runs, and stops at the set PC breakpoint.

28
23
a0
a1
a2
a8
a4
a5
36
a7
a8

noonioz4

00001036
00001034
00001038
39 (00001044
40 (00001048
41 (00001050
42
43
44
45
48
47
48

noonioss

goonioes
gooniotn

gooniote
43 (00001074
50 (00O0010VE
51 (00001082
b2 (00001086
53 (00001084
64 (0000108E
55 (00001092
GE (0000109E
a7 (00001094
58 (0000109E
ik
G0
E1

void mainfvoid)

long al10];

lang i3

int i:

clazsz Sample *p_sam;

while 13
p_zam= new Sample:
forf =07 i<10; i++ 3
i = rand();
ifi <03
i=-1;
alil = j:

p_zam-rsort{a):
p_zam-rchangel(al;

p_zam-»s0=a[0];
p_zam-»=z1=a[l1];
p_zam-rs?=a[?]:
p_zam-»s3=a[3];
F_zam-rsd4=a[4];
p_zam-»sh=a[f];
p_zam-r=zb=a[B];
p_zam-rs¥=al[7]:
p_zam-»s8=a[8];
p_zam-»s3=a[3];
delete p_zam;}

Figure6.34 [Editor] Window at Execution Stop (PC Break)
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The [Status] window displays the following contents.

Item Status

Connected to: SHuwxx EIDA-TIE STITEM (REenesas E-Jeries U3IE Driwver
CPT SHaxxxx

Fun status Ready

Cause of last hreak BREAK POINT

Fun time counkt O000k000min000=04 6ms

Erulation mode Normal

Endian Big

D Dizahle

>
Memory  # Platform A Events lﬂ'
Figure6.35 Displayed Contents of the [Status] Window (PC Break)
Note: Theitemsthat can be displayed in this window differ according to the product. For the
itemsthat can be displayed, refer to the online help.
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6.18 Hardware Break Function
Hardware break settings vary with the product.

A method is given below in which the address bus condition is set under an event condition
“Ch1(IA_OA)”.

e Sdlect [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is
displayed.

e The PC breakpoint that has been previously set is deleted. Click the [Event] window with the
right-hand mouse button and select [Delete All] from the popup menu to cancel al PC
breakpoints that have been set.

e Toset Chl(lA_OA), click the[Event condition] tab.

A hardware break condition can be set independently for each of the event channels. In this
example, set “Ch1(IA_OA)".

Note: The number of hardware break conditions differs according to the product. For the
number that can be specified for each product, refer to the online help.
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e Sdect alineof Ch1(lIA_OA) in the [Event] window. When highlighted, double-click thisline.
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BF (kR E I " ENE MU PPEe %% | EEWEEX DS &
=] = | |
oy ol | W &0)&] e |
= L Watorial e e e e e
J'_]I:Mm il Lne  Sorce A E 5 Source ] :(‘)
] sbekh 2| . = 2
13 sorth 20 (00001024 vaid main{vold) #2
3] stackseth £ [ =] 00000
=] vecth H 1. 74 00000000
= 23 souce file 3 00O0000A
L] dbctc ; poOOo00
=] ritpree 3 ¥ =B FEFFFEC
R | — i T S S oo
la] wectible 3 gnnananqs Chl{IA OA) Enable Address=00001088 [tutorial. : Hreak 0000000
3 Cre soure fily RO TR Cvent candition |
=] setese &1 WU TSy BF IR
=] tutsrialcon 48 | b4 [TA) | Addrss | ASID | Bus State | Action |
= 23 Duvmload modes 43 (00001058 | Rohs (on)
B & loonross | forson) —
3 Deperdencies a8 |oooorogo | fCb7 (Lors = Don' carl
@ loononozs | oo e ;“
| bohO (e 0000000000000
5 3323!352 f:ﬁi“. £ booooooo
I (0000108 | fioniliza] hnnooonn
52 [ooontose | [l
3 |0000108h B12 (B cception ensble Trace 0000000
:4 gggg:g:g R [ hon0oonn
= ¥ 0001076
56 (0000103 e ]
57 [oooniosa | J=T=Te § L 00000F0
5 [oo0oies ™ [ i
& ' ! < {(]fz2= 00000000
A |" = 3 SER 00000000
«| | =, | | | RO_BANE 00000000 &
~ e [@r =1 ig T = nseenrlepp [ st Carcal . IR .
AR B WX e Moioralar|fidr|o|k@|?
Nome | Value | Type | Jeope | =) Conmected
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" (1 H'00005Ide { OO0OFPEO |} (long)
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Figure6.36 [High-performance Embedded Workshop] Window ([Event condition 1])

e The[Event condition 1] dialog box is displayed.
e Clear the [Don't care] check box in the [Address| page.

o Select the [Prefetch address break after executing] radio button and enter H' 00001068 asthe
value in the [Address] edit box.

Notes: 1. The number of hardware break conditions differs according to the product. For the
number that can be specified for each product, refer to the online help.
2. For some MCUSMPUs, the address value to be entered in the [Address] edit box is not
H'00001068. In such cases, specify the address where “p_sam->sort(a);”
(tutorial.cpp/45) islocated.
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Event condition 1

Address | ASID | Action |
fddress

ata addrezz
(" Prefetch address break before executing
f* Prefetch address break after executing

Bddress |H'IIIEIEIIZI'I ]t
f* Mon uzer mask " Uzer mazk
tidask, |

OF | Cancel |

Figure 6.37 [Address] Page ([Event condition 1] Dialog Box)

Note: Theitemsthat can be set in this dialog box differ according to the product. For details on

the settings for each product, refer to the online help.
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e Click the [OK] button.
e Thefirst point display in the State line changes from Disable to Enable.

e Thefirst point display in the Condition line changes from None to Address =
H’'00001068 (tutorial.cpp/45) pcafter.

e Set the program counter and stack pointer values (PC = H’ 00000800 and R15 = H’ 00010000)
that were set in section 6.8, Setting Registers, in the [Register] window. Click the [Go] button.
When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). The internal RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

¢ If program execution isfailed, reset the device and execute again the procedures above.

The program runs and then stops at the condition specified under Ch1(1A_OA).

R20UT0870EJ1000 Rev. 10.00 Page 220 of 292
Aug 10, 2012 RENESAS



SuperH™ Family E10A-USB Emulator

Section 6 Tutorial

28 (00001024
24
a0
a1
4l
a3
a4
ab
36 (00001036
a7 (00001034
a8 (0oon1o038
39 (00001044
40 (00001045
41 (00001050
42
43 (000010548
44

45 (00001063 || o>

46 (00001070
47
4% (00001076
49 (00001074
60 (000010FE
51 (00001082
52 (00001086
b3 (00001054
54 |(000010%E
85 (00001092
BB (00001036
57 (00001094
b8 (0000103E
54
B0

B

woid main{vaid)

lonz a[10];

long J;

int i:

clazz Zample #p_sam:

while (104
p_sam= new sample;
farl i=0: i<10;
I = rand();
ifii <0

= -i:

alil = Js

i++ 11

p_zam-sort{al;
p_zam-rchangelal:

p_sam-rsl=al0];
p_sam-»s1=all1]:
p_zam-rs2=a[2];
p_zam-»sd=a[3];
p_zsam-rsd=a[4];
p_zam-»sh=a[6];
p_zam-rsh=a[B];
p_zam-rs¥=a[7]:
p_sam-rsf=alf];
p_sam-»s3=a[9]:
delete p_zam;

Figure 6.38 [Editor] Window at Execution Stop (Event Condition 1)
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The [Status] window displays the following contents.

-~

it Al

Connected to: SHuxxxx E10A-TSE 3¥YSITEM [Renesas E-3eries USE Dris
CPU SHemxx

Fun status Ready

Zause of last hreak EVENT CONDITION 1

Run time count 0000h000mind00=04  ms

Erulation mode Normal

Endian Big

D Dizsshle

s
¥
Platform A Events ,-’
Figure6.39 Displayed Contents of the [Status] Window (Event Condition 1)
Note: Theitemsthat can be displayed in this window differ according to the product. For the
items that can be displayed, refer to the online help.
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6.18.1 Setting the Sequential Event Condition
The emulator has sequential event functions.
Set hardware break conditions as follows:

Ch1(IA_OA):
A break condition is satisfied immediately after address H'00001068 is accessed.

Ch2(IA_OA_DT_CT):
A break condition is satisfied immediately after address H'00001058 is accessed.

Note: For some MCUSMPUs, the address values are different from those given above. In such
cases, specify the address of “p_sam->sort(a);” (tutorial.cpp/45) for Ch1(lIA_OA) and
specify the address of “d[i]=j;” (tutorial.cpp/43) for Ch2(IA_OA_DT_CT).

Follow the setting method described in the previous section.

R20UT0870EJ1000 Rev. 10.00 Page 223 of 292
Aug 10, 2012 RENESAS



SuperH™ Family E10A-USB Emulator Section 6 Tutorial

To set these breakpoints as sequential:

e Select [Sequential Setting] from the popup menu by clicking the [Event] window with the
right-hand mouse button. The [Sequentia setting] dialog box will open.

Sequential setting

GPU Sequential Event | SystemBus Sequential Event 1

[~ Don't care

[ 2 Channel Sequeniial
v i
I Cha—»3
M Che-=5
[T Ch11->10

™~ Many Channel Sequential
= ;

T L TE T

" GPU Extend

QK | Cancel

Figure6.40 [Sequential setting] Dialog Box

Note: Theitemsthat can be displayed in this dialog box differ according to the product. For the
itemsthat can be displayed, refer to the online help.

o Select the[Ch 2 -> 1] radio button and click the [OK] button.
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When the setting is completed, the [Event] window will be as shown in figure 6.41.

LI G =

Type State Condition Action
n:l‘.hll: IA ©OA) Ensble Address=00001068 (tutorial.cpp/45) poafter Sequential Break
Ch2 (IA QA DT CT) Enshle Address=00001038 (tutorial.cpp/43) poafter Zequential Break
Ch3 [ Ia) Dizakhle None

Chd [ TA) Dizakhle None

Chi|oaA) Dizakble None

ChE [ Oa) Disakble None

Ch7 (LDTLE) Dizakhle None

ChB (3ystemBus) Disabhle None

Ch9 (SvstemBus) Dizakble None

Ch10[IA OA R} Dizakhle None

©h1l{IA OA DT ¢T ) Disable HNone

ChlZ (Branch) Enable general ensble subroutine enable exception enable Trace

Software Trace Disable None

£ | >
| b ;,' Breakpaint }\'Ey_ent l_:ond_il:ionl.-Ir

Figure6.41 [Event condition] Page

Note: Theitemsthat can be displayed in this dialog box differ according to the product. For the
items that can be displayed, refer to the online help.

e Set the program counter and stack pointer values (PC = H’ 00000800 and R15 = H’ 00010000)
that were set in section 6.8, Setting Registers, in the [Register] window. Click the [Go] button.
When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). Theinterna RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

o If program execution isfailed, reset the device and execute again the procedures above.
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The program runs and then stops at the condition specified under Ch1(IA_OA).

28 (00001024 void mainfvoid)

21 {

an

a1 long a[10];

3z lomz j:

a3 int i:

34 clazz Sample #®p_sam;
3h

36 (00001036 while (131

37 00001034 p_zam= new Sample;
3g (0o0o103s farf i=0; i<10; i++ )
39 (00001044 i = rand():
40 (00001048 ifli <o)
41 (000071060 = -i:
42 h

43 (00001068 | 4 alil = i:
44 h

A5 (000010B% | 4| = p_zam-ssort (a):
48 (00001070 p_zam-rchanzefal;
47

48 (00001076 p_sam-rs0=a[0]:
49 (0000107 & p_zam-rsl=a[1]:
B0 (0000107E p_sam-rs2=al2];
51 |00001082 p_sam-»s3=a[3]:
52 (00001086 p_zam-rsd4=a[4]:
B3 (00001084 p_zam-rsh=a[6];
54 |0000108E p_zsam-rsb=a[B]:
BES (00001092 p_sam-»s7=al7];
BB (00001098 p_zam-rsi=a[8]:
57 (00001094 p_zam-rs3=a[9]:
B3 (00001039E delete p_sam;

ha !

1] !

R1

Figure6.42 [Editor] Window at Execution Stop (Sequential Break)
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The [Status] window displays the following contents.

Status

E-Series UIE Driwver)

Zause of last break EVENT CoONDITION 1,2
Run time count 0000KOD0min000=s04d Tms
!Emulatinn wode Normal

|Endian Big

Dizsshle

Memary f, Platform i Events /

Figure 6.43 Displayed Contents of the [Status] Window (Sequential Break)

Note: Theitemsthat can be displayed in this window differ according to the product. For the
items that can be displayed, refer to the online help.

e The sequential break conditionsthat have been previously set are deleted. Click the [Event]
window with the right-hand mouse button and select [ Delete All] from the popup menu to
cancel all hardware break conditions that have been set.

e Select [Sequential Setting] from the popup menu by clicking the [Event] window with the
right-hand mouse button. The [Sequentia setting] dialog box will open (figure 6.40).

o Sdlect the[Don't care] radio button and click the [OK] button.
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6.19 Trace Functions
The emulator has three branch-instruction trace functions.

e Internal Trace Function

The branch source and branch destination addresses, mnemonics, operands, source lines, and
labels are displayed. Since this function uses the trace buffer built into the MCU/MPU, a
realtime trace can be acquired.

Notes. 1. Thenumber of branch instructions that can be acquired by atrace differs according to
the product. For the number that can be specified for each product, refer to the online
help.

2. Theinternal trace function is not supported for al products. For details on the
specifications of each product, refer to the online help.

3. Theinternal trace function is not extended for all products. For details on the
specifications of each product, refer to the online help.

e AUD Trace Function

Thisisthe large-capacity trace function that is enabled when the AUD pin is connected to the
emulator. When a set of the branch source and branch destination instructionsis one branch,
the maximum number of events acquired by atrace is 262,144.

Thisfunction is only available on the EL0A-USB emulator with model name
HS0005K CUO2H.

The following information can be acquired:

e Types of trace information: Branch information, memory access information from the CPU,
and PC or Rn value during the Trace Rn instruction execution

e Trace acquisition address value
e Datavaue

e Mnemonic

e Operand

e Sourceline
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Notes: 1. The AUD trace function is not supported for all products. For details on the
specifications of each product, refer to the online help.

2. Thetypes of trace information that can be acquired by an AUD trace function differ
according to the product. For details on the specifications of each product or the
number of acquired branches, refer to the online help.

3. When multiple loops are performed to reduce the number of AUD trace displays, only
the I P counts up according to the product.

e Memory Output Trace Function

Thisfunction is used to write the trace result to the specified memory range. The datais read
from the memory range written in the [ Trace] window and the result isthen displayed. Thisis
large-capacity trace function that is valid when the AUD pin of the deviceis hot connected to
the emulator.

Note: Some products do not support the memory output trace function. For details on the
specifications of each product, refer to the online help.

6.19.1 Displaying the Trace Window

Select [Trace] from the [Code] submenu of the [View] menu. The result of the acquired traceis
displayed.
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6.19.2 Internal Trace Function

The branch source and branch destination information for the latest several branch instructions are
displayed.

In the internal trace function, the type of the branch instruction can be specified and acquired.

The typeis specified asfollows:

e Sdlect [Eventpoints] from the [Code] submenu of the [View] menu.
e Click on the [Event condition] tab.
e Sdlect theline of Ch12(Branch) so that it is highlighted. Then double-click on thisline.

e The[Event condition 12] dialog box appears. Deselect the [Don’t care] checkbox on the
[Branch event] page.

Event condition 12

Branch event l fction ]

Branch

[v Acguire general branch instruction event
[v Acguire subroutine branch instruction event

[v Acouire exception branch instruction event

OF | Cancel |

Figure6.44 [Branch event] Page
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Deselect the [Acquire break] checkbox and select the [Acquire trace] checkbox on the [Action]
page.

Event condition 12

Branch event Action

[ Bcquire break

~
[ PA2 (v -
[ PA3 (v -
[ PAd (v -

0] 4 | Cancel

Figure6.45 [Action] Page

Notes: 1. Theitemsthat can be set in thisdialog box differ according to the product. For details
on the settings for each product, refer to the online help.
2. In some products, the branch settings are made in the [Branch trace] page of the
[Acquisition] dialog box. For details on the specifications of each product, refer to the
online help.
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Run the program as shown in the example of section 6.17.1, PC Break Function. The trace results
are displayed in the [ Trace] window after the program execution is completed.

o 2B & | | O

PTR b M..| Type BranchType Bus R/W  Address  Data PPC3 | PPC4 | Instruction Source Label e
000012 DESTINATION 0000zoo0 MoV #E'09, R2 ali]l = tmp[9 - i];

-000011 -D'000005 ¢PU BRANCH GENERAL 00002082 BE/3 @H'20D0:8

-000010 DESTINATION 0000zop0 MoV #E'08, R2 ali] = tmp[9 - 1];

-000009 -p'000004 ¢BU BRANCH GENERAL 00002082 BE/S @H'20D0:8

-000008 DESTINATION 00002000 MOV HH'09,R2 ali] = twp[9 - i];

-000007 -p'000003 ¢BU BRANCH GENERAL 00002082 BE/S @H'20D0:8

-000006 DESTINATICN 00002000 MOV #H'09,R2 ali] = tmp[9 - i];

-000005 -p'000002 CPU BRANCH GENERAL 000020E2 BESS @H'Z0D0:8

-000004 DESTINATION 00002000 MO #H'09, R2 ali] = tmp[9 - i];

—-000003 -p'000001 CPU EBRANCH GENERAL 0000zZ0EZ BE/S BH'Z0D0:8

-000002 DESTINATION 00002000 MOV #E'09, B2 ali] = tmm[9 - il; b

Figure6.46 [Trace] Window

o |f necessary, adjust the column widths by dragging bordersin the header bar (immediately
below the title bar).

Note: The type and the amount of information that can be acquired by atrace differ according to
the product. For details on the specifications of each product, refer to the online help.
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6.19.3 AUD Trace Function
This function is available when the AUD pin of the MCU/MPU is connected to the emulator.
The following is the procedure for setting the AUD trace function.

(1) Setting the trace acquisition mode
o Display the[Trace] window.

e Click the [Trace] window with the right-hand mouse button and select [Acquisition] from the
popup menu to display the [ Trace Acquisition] dialog box.

The trace acquisition condition is set in the [ Trace mode] page.
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fcquisition

Trace Mode

Trace tvpe

Internal trace  © User Memory trace

Trace Mode 1
f* Bealtime trace  Mon realtime trace

Trace Mode 2
¢ Trace continue ©  Trace stop

AUD Mode
f* dhit f'“

ALD trace display range
Start pointer  |0'265

Erd pointer  |D'0

Ilzer me mory area

Trace Extend Mode
[ Trace data with PPG

0] | Cancel

Figure 6.47 [Trace mode] Page

Note: Thisdialog box cannot be used in a product that does not support the AUD trace function.
The items that can be set in thiswindow differ according to the product. For details on the
settings for each product, refer to the online help.
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The following table shows the options.

AUD Trace Acquisition Mode

Type Mode

Description

Continuous Realtime trace
trace occurs

When the trace information is being generated intensively
that the output from the AUD pin incapable of keeping up,
the CPU temporarily suspends the output of trace
information. Therefore, although the user program is run in
real time, the acquisition of some trace information might not
be possible.

Non realtime trace

When trace information is being generated so intensively
that the output from the AUD pin is incapable of keeping up,
CPU operations are temporarily suspended and the output
of trace information takes priority. In such cases, the
realtime characteristics of the user program are lost.

Trace buffer Trace continue This function always overwrites the oldest trace information
full to acquire the latest trace information.
Trace stop When the trace buffer becomes full, the trace information is

no longer acquired. The user program is continuously
executed.

Note: Theitemsthat can be set in this window differ according to the product. For detailson the
settings for each product, refer to the online help.
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(2) Displaying the trace result
¢ Run the program as shown in the example of section 6.17.1, PC Break Function. Thetrace
results are displayed in the [ Trace] window after the program execution is completed.

& EE @

PIR ir Master  Type EBranchType Bua| R/W | Addreas  Dnta| PRCI | PPCA | Inscruction Source Tabel #
000243 -p'DD0Z55 CRU DRANCH 00001072 T AloopZ:0

000242 DESTIRATION 0000108c MV .L RS, 883 loop2
-000z41 -p'00014% CPU ERANCH [T o BRA Hnext loop3ilZ

=000 an DESTIRATION noon1114 CMP/HT n1,R2 mevk_le
Q0023% -p'000140 CRU DRANCH 00001116 T dloopd:d

Q00238 DESTIRATION 00001100 MoV L ARLY, R docpd
=-000237 -p'000147 CPU BRANCH Looo110E BRA Hoext loopd:lZ

=000T36 DESTINATION noooi111o CMP/HT n3, R4 nevt_le
Q00235 -p'000146 CRU DRANCH 00001112 T dloop4d:0

000234 DESTIRATION 00001104 MoV L AR+, RE locpd

=-000233 -p'000137 CPU BRANCH vooo11zz RTS

N3z DESTIRATICN nnoanenc ML A(H'IN28:8, P] B2 _CALL_TRIT();

000231 -1'000136 CBU DRANCH 00000808 738 a2

000230 DESTIRATION 00001139 MoV L #13,8-R15 CALL
-000ZZ9 -D'O00L3S CRU BRANCH 00001148 BT BHT115¢:8

-00n2za DESTIRATTION nnoa115c LIE.L AR154, PR

-000227 -1'000134 cov BRANCH 00001160 nrs -
< ¥

Figure6.48 [Trace] Window (Example)

6.19.4 Memory Output Trace Function
Thisfunction is used to write the trace result to the specified memory range.
The following is the procedure for setting the memory output trace function.

(1) Setting the trace acquisition mode
o Display the[Trace] window.

e Click the [Trace] window with the right-hand mouse button and select [Acquisition] from the
popup menu to display the [Acquisition] dialog box.

The trace acquisition condition is set in the [ Trace mode] page.

R20UT0870EJ1000 Rev. 10.00 Page 236 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 6 Tutorial

fcquisition

Trace Mode

Trace tvpe
(" 8D trace  Internal trace O lzer Memory trace

Trace Mode 1
f* Bealtime trace  Mon realtime trace

Trace Mode 2
¢ Trace continue ©  Trace stop

AUD Mode
') {

ALD trace display range

Uger memory area
Start Address |H'2000

End Address  |H33FF

Trace Extend Mode
[ Trace data with PPG

0] | Cancel

Figure6.49 [Trace Mode] Page
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The following table shows the options.

Trace Acquisition Mode

Type Mode

Description

Continuous Realtime trace
trace occurs

When trace information is being generated so intensively that
the output from the memory is incapable of keeping up, all
the information may not be output. The user program can be
executed in realtime, but some trace information will be lost.

Non realtime trace

When trace information is being generated so intensively that
the output from the memory is incapable of keeping up, the
CPU stops operations. The user program is not executed in
realtime.

Trace buffer Trace continue
full

This function always overwrites the oldest trace information
to acquire the latest trace information.

Trace stop

When the trace buffer becomes full, the trace information is
no longer acquired. The user program is continuously
executed.

Note: Theitemsthat can be set in this window differ according to the product. For details on the
settings for each product, refer to the online help.
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(2) Displaying the trace result
e Set the start and end addresses, which are in the memory range that outputs the trace result, in
the [Start Address] and [End Address] edit boxes of [User Memory area), respectively.

¢ Enter the addresses depending on your environment. Do not specify the range that the
program has been downloaded to, as the memory contents are overwritten by the trace output

result.

¢ Run the program as shown in the example in section 6.17.1, PC Break Function. Thetrace
results are displayed in the [ Trace] window after program execution is compl eted.

The following is an example of the trace display.

B & EBC &l | FO

FTR IP Master  Type BranchType | Bus R/W Address | Daka| PPC3| PPC4 | Tusbruction Source Label e
~nonoe DESTTRATTON [ITET T mo RS, RO tmpli] = a1l

=000021 -o'000010 PO HRANCH GENETAL ONanzocE BPSE BH'2088:8

-onnozn DESTTHATTON noonznes o RS, RO twp[4] = alil;

=0000%9 -0'000000 CRU BRANCH GENEDAL 00002082 BESE @x'2000:8

000018 DESTINATLON 00002000 oV #u'09, k2 af1] = tmp[9 - 1];

000217 -p'000000 cru URANCH GENERAL 0000202 oefs au'2000:0

000016 DESTINATLON 00002000 oV #u'09, k2 af1] = tmp(9 - 1];

-000013 -0'000007 CPU BRANCH FENERAL UUODZUEZ EF/3 HH'2000:8

-0ouo14 DESTIRATION uuovzony HOV WH'09, B2 ali] = tmpl® - i];

-000013 -0'000006 CPU BRANCH FENERAL UUODZUEZ EF/3 HH'2000:8

-onnn12 DESTTRATTON nnonzonn o ¥H'00,Ra ali] = ewpl0 - 4];

=0na0t1 -o'000005 Cro BRANCH GENERAL 0NonzoE: BESE X' 20008

-onnoin DESTTRATTON nnonzonn o ¥H'00,Ra ali] = ewpl0 - 4];

000209 -p'000004 cEU URANCH GENERAL 000020E2 oeSs |u'2000:8

000008 00002000 woy #u'09, k2 af1] = tup[9 1l

000307 -p'000003 cru GENERAL 000020E2 oefs |u'2000:8

000006 0dgoozowa Lo #u'09, k2 af1] = tmp[9® ali

=-000005 -0'000002 CPU BRANCH GENERAL UUOLZUEZ EF/3 HH'I000:8

~0oogos DESTIRATION uuovziony HOV WH'O9, R2 ali] = tmpl¥® - i];

~O00003 =B 000001 CPn RRANCH GENERAL NOO0ZORE EF/2 OH'20D0:8

-onnonz DESTIRATTON nnonzonn o #H'0, B2 a[4] = twp[9 = 4];

-000601 -0'000000 PO HRANCH SUBRATTINE n0oninEs RTS

+onnnon DESTIRATTON nnon10Ts freTR an1s,n2 p_anm-sal=al0] ; e
< 3

Figure6.50 [Trace] Window (Example)
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6.19.5 MMU Support
This function can be used when the supported MCU/MPU has an MMU.
e TLB window

In the emulator, the contents of the TLB table can be easily displayed and edited by selecting
[CPU -> TLB] from the [View] menu. For details, refer to the online help.

e VP _MAP trandation function

The MCU/MPU, which has an MMU, trand ates internal addresses (virtual addresses) to actual
memory addresses (physical addresses). Address translation is performed according to the address
tranglation table (trandation look-aside buffer: TLB) inthe MCU/MPU. The MMU operates
during command input wait state as well as during user program execution. When a command for
memory access is executed while the MMU address trandation function is enabled, the address
trandated by the MMU is accessed. |If the specified addressis not within the TLB, a TLB miss
occurs, and the TLB must be updated by the user program.

The emulator has address trandation functions according to the VP_MAP tables. The VP_MAP
tables are the address trand ation tables for the emulator created with the VPMAP_SET command.

The following shows an example of how to use the VP_MAP tables.
Example:

1. Create VP_MAPtablesfor trandating virtual addresses H'10000 to H'10fff to physical
addresses H'4000000 to H'4000fff and virtual addresses H'11000 to H'11fff to physical
addresses H'0 to H'fff.

>vs 10000 10fff 4000000 (RET)
>vs 11000 11fff 0 (RET)

>vd (RET)
<VADDR_TOP> <VADDR_END> <PADDR_TOP>
00010000 00010fff 04000000
00011000 00011fff 00000000
DISABLE
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2. Then, enable the VP_MAP tables. (When the tables are disabled, addresses are not translated.)

>ve enabl e (RET)

>vd (RET)

<VADDR TOP> <VADDR END> <PADDR TOP>
00010000 00010f f f 04000000
00011000 00011ff f 00000000
ENABLE

Here, virtual addresses correspond to physical addresses as shown in figure 6.51.

\\ H'0
H'10000 7 HFFF

H'10FFF /
H'11000 \\\\
H'11FFF
H'12000 H'12000
H'12FFF 7/ H'12FFF
oY Y,
/ / / / H'4000000
H'4000FFF
Virtual address Physical address

Figure6.51 Address Trandation accordingto VP_MAP Tables

How to translate addresses depends on the settings of the radio buttons of the [Memory area]
group in the [Configuration] dialog box. The following shows how to translate addressesin each
setting state.

When the Nor mal radio button is selected:

The VP_MAP table has a priority over the TLB. When the VP_MAP table is enabled and the
specified address is within the VP_MAP table settings, the emulator trand ates the address
according to the VP_MAP table. If the specified addressis outside the VP_MAP table settings
even when the VP_MAP table is enabled, or when the VP_MAP table is disabled, the emulator
translates the address according to the MMU state.

When the Physi cal radio button is selected:

The addressis not translated.
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e WhentheVirtual radiobutton is selected:

The addressistrandated according to the TLB. |f the specified addressis outside the TLB
table settings, a TLB error will occur.

Table6.2 Address Trandation Tables

VP_MAP MMU
Within/
Radio Enabled/ Outside Enabled/ Within/Outside Table Used for
Button* Disabled the Range Disabled the TLB Range Translation
Normal Enabled Within the Enabled Within the range Translated according to
range the VP_MAP table
Outside the range Translated according to
the VP_MAP table
Disabled  Within/outside the Translated according to
range the VP_MAP table
Outside the  Enabled Within the range Translated according to
range the TLB table
Outside the range TLB error
Disabled  Within/outside the Not translated
range
Disabled  Within/ Enabled Within the range Translated according to
outside the the TLB table
range
Outside the range TLB error
Disabled  Within/outside the Not translated
range
Virtual Enabled/  Within/ Enabled Within the range Translated according to
disabled outside the the TLB table
range
Outside the range TLB error
Disabled  Within the range Translated according to
the TLB table
Outside the range TLB error
Physical Enabled/  Within/ Enabled/  Within/outside the Not translated
disabled outside the  disabled range
range
Note: Specified by the [Memory area] group box in the [Configuration] dialog box.
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6.20 Stack Trace Function

The emulator uses the information on the stack to display the names of functionsin the sequence
of callsthat led to the function to which the program counter is currently pointing.

Note: Thisfunction can be used only when the load module that has the EIf/Dwarf2-type
debugging information is loaded. Such load modules are supported in SHC/C++ compiler
(including OEM and bundle products) V6.0 or later.

e Double-click the [S/W breakpoint] columnin the sort function and set a PC breakpoint.

26
27
28
29
30
31
37
33
4
25
36
37
38
49
40
41
47
43
44
45
45
47
48
49
B
B 1
52

(o

nonn2oze

oonoznse
oonnzo4e
nonn2os4
nonn2osc
nonn2oec

oonozova
gonozoyc

oonnzoan

oonozoAE

void Samplettzort(long #a)

long 13
int i, i. k., zap:

gap = 03
whilel gap » 0 3
for{ k=0; kdigap: k++if
forf i=k+tgap: (<103 i=itzap )
forfj=i-zap: j»=k: j=j-zap){
if{alil>alitgap]df

t = alil;
alil = alitgapl;
all+tzap] = t;

elze
break;

'
I
gap = gap/2;
!
void Sample::chanzellonz #a)

lonz tmp[10];

Figure6.52 [Editor] Window (PC Breakpoint Setting)
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e Set the same program counter and stack pointer values (PC = H’ 00000800 and R15 =
H’00010000) as were set in section 6.8, Setting Registers (again, use the [Register] window).
Click the [Go] button.

When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). The interna RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

o If program execution isfailed, reset the device and execute again the procedures above.

o After the break in program execution, select [Stack Trace] from the [Code] submenu of the
[View] menu to open the [Stack Trace] window.

Stack Trace [®]
KEind | Hawme Value

F Sample: :sorkt [(long *) { 00oo0Z0e }
F main () { 000010RE }
F PowerON Reset PCI) { oooooezo
F PowerON Reset PCI) { ooooogzo
F PowerON Reset PO { oooooezo b
F PowerON Reset PCI) { oooooezo b
F PowerON Reset PO} { oooooezo b
F PowerON Reset PO { oooooezo b
F FowerON Reset PCI) { oooooezo

Figure6.53 [Stack Trace] Window

Figure 6.53 shows that the position of the program counter is currently at the selected line of the
sort () function, and that the sort () functioniscalled fromthe tutorial () function.

To remove the PC breakpoint, double-click the [S/W breakpoint] column in the sort function
again.

Note: For details on this function, refer to the online help.
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6.21 Performance Measurement Function
The emulator has performance measurement functions.

¢ Performance measurement function

This function applies a counter in the MCU/MPU to measure the number of times various
events have occurred and cycle count. A start and end condition for counting can be set.

Various items that can be measured differ according to the supported MCU/MPU.
e Profiling function
The profiling function is used to measure the performance of each function.

When execution of the user program is ended, the number of times each function is called and
the measured data are displayed. The measured items are the same as those for the number of
times various events have occurred, and cycle count.

6.21.1 Performance Measurement Function

The following is an example of the use of a counter in the MCU/MPU to measure the number of
times various events have occurred and cycle count.

This function cannot be used with the profiling function that is described later.
(1) Setting method

Select [Performance Analysis] from the [ Performance] submenu of the [View] menu. When the
[Select Performance Analysis Type] dialog box will open, click the [OK] button.

Select Performance Analysis Type

Performance fnalvsis: Perfomance Snalvzis

Cancel

Figure6.54 [Select Performance Analysis Type] Dialog Box
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e The[Performance Analysis] window will be displayed.

e Place the mouse cursor on any event channel in this window, click the right-hand mouse
button, and then select [Set] from the popup menu. The [Performance Analysis] dialog box
will open. The events to be measured and measuring conditions can be set in this dialog box.

Note: Theitemsthat can be displayed in this dialog box differ according to the product. For
details on the settings for each product, refer to the online help.

After the conditions have been set, clicking the [OK] button and executing the user program will
display the result of measurement in the [Performance Analysis] window.

Performance Analysis

“a¥a B | o H

Channel  Condition Eesult
zhl LISAELE oooooooo
zh2 DISAELE ogoogooao
zh3 DISAELE ooooocao
zhd LISAELE oooooooo

Figure6.55 [Performance Analysis] Window

Note: Theitemsthat can be displayed in this window differ according to the product. For details
on the settings for each product, refer to the online help.
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6.21.2 Profiling Function
The profiling function can measure performance for each function.

Notes: 1. Realtime operation is not possible while this function isin operation, since interna
breaks are generated during program execution. Measuring the profileitself affectsthe
measurements.

2. Performance profile measurement is not supported for all products. On those products
for which it is supported, its characteristics differ according to the product. For details
on the specifications of each product, refer to the additional document, Supplementary
Information on Using the SHxxxx.

3. Thisfunction cannot be used with the performance measurement function that has
been described before. Use one of these functions.

o First, download the tutorial program by referring to section 6.6, Downloading the Tutorial
Program.

o Select [Profile] from the [Performance] submenu of the [View] menu. The [Profile] window
will be displayed.

Profile F-i_|
i ]Show Functions ariables L] o | P
Function/Variahle | F/v | Address | ] =) | Times | Optionl | Option | Option3 | Optiond
£ >
~ || List ."{\ Tree ‘,-'r

Figure6.56 [Profile] Window

e To enablethe profiling function, place the mouse cursor on an entry in the [List] sheet of the
[Profile] window, click the right-hand mouse button, and then select [Enable Profiler] from the
popup menu.
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Profile [E5]
E == |!E{§=!Show Functions/Variables ;‘ = | &7 ‘
Function/Varishle | F,-"Vl Address I Size | Times I Optionl I OptionZ | Option3d | Optiond

View Source

“iew Pr 1art

i_\’_ Enable Profiler
Mot trace the function call
Setting 3

Properties

Eind Citrl+F
Clear Data
< 1l 2|

4 I Pl-\ I_isL';{Lle_?J COutput Profile Information Files.

Output Text Fils..

:7 Toolbar dizplay

Customize toolbar..

[v Allow Dacking
Hide:

Figure 6.57 Selection of [Enable Profiler]

e To set the data to be measured for the selected function, place the mouse cursor on an entry in
the [List] sheet of the [Profile] window, click the right-hand mouse button, and then select
[Properties] from the popup menu. The [Select Data] dialog box is displayed.
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Select Data

Select Data lcnnditinn]

" OptionZ
" Optiond
" Cptiond

(] I Cancel |

Figure 6.58 [Select Data] Page

e Open the [Select Data] page and select an option as the datato be measured. Select [Option 1]
in this example.

e Open the [Condition] page and specify the type of datato be measured. To measure the
number of elapsed cycles, deselect the [Disable] checkbox and select the [Cycle] checkbox on
the [Condition] page. Then select the [Elapsed cycles] checkbox on the [Cycle] page.

o After the data has been selected, press the [OK] button.
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Select Data

Select Data  Condition IG;-.H:IE |

...........................

™ Don't Care:
Selection of a count item
CPU performance
v Cvcle
Count
(" Thetruction
" Branch

" Exception, interruption
" Stalled Cwcle

(" TLE performance
(" Tn=truction bus performance
Cperand bus performance
(™ Bccess count
" focezs miss count
" Waited cycle

(] I Cancel |

Figure6.59 [Condition] Page

Y ou may need to select the type of data from the [Option 1] drop-down list in the [Select Data)
dialog box (figure 6.60) depending on the MCU/MPU in use.
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bSelect Data

Optian 1 Elapsed time

Option 2 Dizabled |

Figure6.60 [Select Data] Dialog Box

Note: The contents of this dialog box vary with the product. For details on the specifications of
each product, refer to the online help.

e Double-click the [S/W breakpoint] column for the whi 1 e statement of the main function to
set a PC breakpoint.
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28
24
a0
31
az
a8
34
a5
36
37
a8
34
40
41
42
43
44
45
46
47
43
43
a0
b1
52
ha
b4
55
i1
a7
58
54
G0
61

nooninza

nonotoge
nonotos4
nonotoss
nonoto44
noooto4s
nonotosn

nonoi10ss

nono106s
noooioin

noootove
nonotova
nonotoveE
noootog?
nonotoge
nonotogs
nono1ogE
nonotogz2
nonoto9e
nonotoga
nonotoag

wvoid main{vwoid)

longz al107:

long i3

int i;

clasz Sample #p_sam:

while (13
p_sam= new Sample;
forl i=03 i<103 i++ 3
i = rand(};
if (i < 0

i= -
alil = j;

p_sam-rsort{al;
p_zam->changela);

p_sam-»s0=al0];
p_zam->sl=all];
p_sam-rs2=al2];:
p_sam-»s3=al3];:
p_zam->sd=a[4];
p_sam-»=zh=a[8];
p_sam-»sh=alf];
p_zam-rs¥=al?]:
p_sam-r=z8=a[8];
p_sam-»s3=a[9];:
delete p_sam;

Figure6.61 [Editor] Window (PC Breakpoint Setting)

e Set the same program counter and stack pointer values (PC = H’ 00000800 and R15 =
H’00010000) as were set in section 6.8, Setting Registers (again, use the [Register] window).
Click the [Go] button.
When using the MCU with flash memory, specify the end address of the internal RAM for the
stack pointer (SP). Theinterna RAM area differs depending on the MCU. Refer to the
hardware manual of the MCU used.

o If program execution isfailed, reset the device and execute again the procedures above.
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After the break in program execution, the results of the measurements are displayed in the [List]
sheet of the [Profile] window.

S ]Show Functions/ ariables LJ |
Function/Variable | FfV| Address | Size | Times | Optionl I Optiond | Optiond I Optiond I L
_PowerON Reset PC F Qoooosno H'OODOOOQOZC 1 1453 0 0 u]
Sample: :change (long *) F 0000Z0AE  H'OOOOOD42 1 11604 0 0 u]
Sample::sort (long *) F 000020ZE  H'O00OOQOSO 1 30449 0 0 o]
Sample::Sample () F 00002000  H'O000QOZE 1 1501 0 0 o]
_ diwlu F 00001468  H'O0000C0OO 1 787 0 0 u]
00001370 F 00001370  H'O0000C00O 1 2469 0 0 u]
_malloe F oooolzco  H'OOOOOQOOO 1 4343 0 0 o]
_free F oooolzic  H'O0OOOQOOO 1 941 0 0 o]
_rand F 000011F0  H'O00000Zc 10 9030 0 0 o
operator new(unsigned long) F ooooligc  H'00000064 1 2217 u] ] u]
__CATLL INIT F 00001138 H'O00000ZC 1 1322 0 0 o] v
4 List A Tree ‘,-'r

Figure6.62 [List] Sheet of the[Profile] Window

Figure 6.63 shows the [Tree] sheet of the [Profile] window.

(B Shon Furctons farat =% @
Function I Address | Fize I Stack Size | Tirmes | Optionl I Optiond | L) Ml
=i\ llorkSpace Tutorial\E10A-TUSEY . . .
=~ _PowerON_Reset PC 00000800 H'000000Z¢ H'OODOOOOOO 1 1453 u] u]
_ INITSCT 000010p0  E'00000000 H'O000000O0 1 108760 0 ]
__ CALL_INIT 00001138  E'000000ZC H'O000OO0OO 1 1322 0 ]
= _main 00001024 H'00000094 ®H'OOOOOOOO 1 12079 u] u]
=l Gample: :Sample [} 00002000  E'O00000ZE  H'O000OO0OO 1 1501 0 0
+ - operator new(unsigned... 0000118¢C H'00000064 H'OOOOOOOO 1 2217 u] u]
Fample: ichange (long *) 000020AE H'00000042 H'OOOOOOOO 1 11604 u] 0
Sample: :sort[long *) OD0DZ0ZE H'00000020 H'OOOOOOOO 1 30449 u] 0
« ‘ ST Tt e i —— -
[T e /
Figure6.63 [Tree] Sheet of the [Profile] Window
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When [View Profile-Chart] is selected from the popup menu, a chart diagram is shown.

Profile-Chart

:change [ long

_PowerON _Reset PC

tgortilong *

t3aumplel)

Figure6.64 [Profile-Chart] Window

6.22 Downloadingtothe Flash Memory Area

The emulator enables downloading to the external flash memory area. This function requires a
program for programming the flash memory (hereinafter referred to as a write module), a program
for erasing the flash memory (hereinafter referred to as an erase module), and the RAM areafor
downloading and executing these modules.

Notes: 1. The write and erase modules must be prepared by the user.

2. Thisfunction is not available when the SH7047F, SH7144F, or SH7145F isin use. For
these MCUSs, the [Loading flash memory] page shown in figure 6.65 will not be

displayed.

¢ Interface of the write and erase modules with the emulator firmware

The emulator firmware branches to the write and erase modules. The following conditions

must be satisfied if branching from the emulator firmware to the write and erase modules and

return from the write and erase modules to the emulator firmware are to be successful.

— The write and erase modules must be entirely written in assembly language.

— All values of general and control registers must be saved before the write or erase modules
are called and restored on return from the modules.

— Configure the write and erase modules so that execution returns to the origin of the call
after processing.

— The write and erase modules must be Motorola S-type files.

R20UT0870EJ1000 Rev. 10.00 Page 254 of 292
Aug 10, 2012 RENESAS




SuperH™ Family E10A-USB Emulator Section 6 Tutorial

— The write and erase modules must not contain SLEEP, DIVS, DIVU, or REBANK
instructions.
— FPU exceptions must not occur within the write and erase modules.

The module interface must be as follows so that the information required for flash memory
access is passed correctly.

Table6.3 ModulelInterface

Module Name Argument Return Value

Write module R4(L): Write address RO(L): End code
Normal end = 0,

R5(L): Access size
Abnormal end = other than 0

0x4220 = byte,
0x5720 = word,
0x4C20 = longword

R6(L): Write data

Erase module R4(L): Access size None
0x4220 = byte,
0x5720 = word,
0x4C20 = longword

Note: The (L) means the longword size.

Note: Write module: The write data for the access size is set to the R6 register. When the access
sizeisword or byte, 0 is set to the upper bits of the R6 register.
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¢ Flash memory download method

For downloading to the flash memory, set the items on the [Loading flash memory] page in the
[Configuration] dialog box, which is opened from [System...], then [Emulator] from the

[Setup] menu.

Configuration

General Loading flazh memary

Loading flazh memary
Erazing flazh memary
Eile name
Bus width of flash memary
Flazh memory erazing time
Entry paint
All erazing module address
Wiriting module address

fcocess gize

" Dizable

o Dizable

" Enable

Browsze..

|32-bit bus width

[

minute

o]

Cancel |

Figure6.65 [Loading flash memory] Page
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Table 6.4 shows the options for the [L oading flash memory] page.

Table6.4 [Loadingflash memory] Page Options

Option

Description

[Loading flash memory]
radio button

Sets Enable for flash memory downloading.

When Enable is selected, and [File load] is selected from the [File]
menu for downloading, the write module is always called.

Enable: Download to the flash memory

Disable: Not download to the flash memory

[Erasing flash memory]
radio button

Sets Enable for erasing before the flash memory is programmed.

When Enable is selected, the erase module is called before calling
the write module.

Enable: Erase the flash memory

Disable: Not erase the flash memory

[File name] edit box

Sets the file name of the S-type load module including the write and
erase modules. The file that has been set is loaded to the RAM
area before loading to the flash memory.

A maximum of 128 characters can be input for the file name.

[Bus width of flash
memory] list box

Sets the bus width of the flash memory.

[Flash memory erasing
time] edit box*

Sets the TIMEOUT value for erasing the flash memory. Set a larger
value if erasing requires much time; the default time is three
minutes. The radix for the input value is decimal. It becomes
hexadecimal by adding H'.

[Entry point] group box

Sets the calling destination address or access size of the write and
erase modules.

[All erasing module address] edit box: Inputs the calling destination
address of the erase module.

[Writing module address] edit box: Inputs the calling destination
address of the write module.

[Access size] combo box: Selects the access size of the RAM area
where the write/erase module is loaded.

Note: Although the values that can be set are D'1 to D'65535, the TIMEOUT period may be
extended according to the set value. Therefore, it is recommended to input the minimum
value by considering the erasing time of the flash memory in use.
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¢ Noteson using the flash memory download function

The following are notes on downloading to the flash memory.
— When the flash memory download is enabled, downloading to areas other than the flash

memory areais disabled.

— Downloading is only enabled to the flash memory area. Perform memory write or PC

break only to the RAM area.

— When the flash memory eraseis enabled, the [ Stop] button cannot stop erasing.
— The areafor the write and erase modules must be set in an MM U-disabled space.

e Anexample of downloading to the flash memory

An example of downloading from the emulator to the flash memory isgiven below. Thisis
given as an example because the actual values will vary with the target MCU and flash
memory that arein use. A sampleis provided in the \Fmtool folder in the installation
destination folder. Create a program that suits the user specifications by referring to this

sample.

To use a sample workspace on Windows Vista® or Windows® 7, it must be copied into a folder

that corresponds to the currently logged account.

Table 6.5 Board Specifications

Item

Contents

SDRAM address

H'0C000000 to H'OFFFFFFF

Flash memory address

H'00000000 to H'01FFFFFF

Bus width of flash memory 32 bits

Operating CPU internal frequency 167 MHz

environment Bus frequency 55.7 MHz
CPU internal module frequency  27.84 MHz
Endian Big endian
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SHxxxx

Flash memory
(32 Mbytes)
A0-A22 [ FIA bus buffer A2-A24
CEQ |- FPGA CcSo
CE1,2 |—— GND Cs2
OF [ FIA bus buffer RD
| WE [# WEO
0-7 _
Do-D7 FD bus buffer | DO-D31
D8-D15 [—
DO-D7 48'15—.
D8-D15|—
pop7 |22 o
D8-D15 |—
D0-D7 |a223!
D8-D15[—

Figure6.66 Flash Memory Wiring

Table6.6 Sample Program Specifications

Item

Contents

RAM area to be used

H'0C001000 to H'0OC0015BF

Write module start address

H'0C001100

Erase module start address

H'0C001000

e Sincethe SDRAM is used, the bus controller must be set.
e Set the options on the [Loading flash memory] page in the [Configuration] dialog box as

follows:

R20UTO0870EJ1000 Rev. 10.00
Aug 10, 2012

RENESAS

Page 259 of 292




SuperH™ Family E10A-USB Emulator

Section 6 Tutorial

Configeuration

General Loading flagh memory
Loading flash memoary = Disable (« Enable
Erazing flash memary " Disable (+ Enable
File hame [\ Program Files'Renesas'Hey
Buz width of flash memory |32—bit bus width ﬂ
Flash memory erasing time [E] minute
Entry point
All erazing module address |H'DGDD‘| onn
Writing module address [HDCOO01100
Access gize |1 ﬂ
o] | Gancel |

Figure 6.67 [Loading flash memory] Page

Notes: 1. When the data has already been written in the flash memory, be sure to select [Enable]
for [Erasing flash memory]. If [Disabl€] is selected, a verify error occurs.

2. When [Erasing flash memory] is selected, it takes about one minute to erase the flash

memory (in this example).

e Sdlect the object for downloading to the flash memory area.
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6.23 What Next?

Thistutorial has described the major features of the emulator and the use of the High-performance
Embedded Workshop.

Sophisticated debugging can be carried out by using the emulation functions that the emulator
offers. Thisprovidesfor effective investigation of hardware and software problems by accurately
isolating and identifying the conditions under which such problems arise.
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Section 7 Maintenance and Guarantee

This section describes maintenance, guarantee, repair provisions, and how to request for repair of
the emulator.

7.1 User Registration

When you purchase our product, be sure to register as a user. For user registration, refer to the
section of ‘User Registration’ (p. iii) of this user's manual.

7.2 Maintenance

1. If dust or dirt collects on any equipment of this product, wipe the board dry with a soft cloth.
Do not use thinner or other solvents because these chemicals can cause the equipment's surface
coating to separate.

2. When you do not use this product for along period, for safety purposes, disconnect the power
cable from the power supply.

7.3 Guarantee

If your product becomes faulty within one year after its purchase while being used under good
conditions by observing ‘IMPORTANT INFORMATION’ described in this user's manual, we will
repair or replace your faulty product free of charge. Note, however, that if your product'sfault is
raised by any one of the following causes, we will repair it or replace it with new one with extra-
charge:

e Misuse, abuse, or use under extraordinary conditions

e Unauthorized repair, remodeling, maintenance, and so on
¢ Inadeguate user's system or misuse of it

o Fires, earthquakes, and other unexpected disasters

In the above cases, contact your local distributor. If your product is being leased, consult the
|leasing company or the owner.
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74 Repair Provisions

741 Repair with Extra-Charge

The products elapsed more than one year after purchase can be repaired with extra-charge.

7.4.2 Replacement with Extra-Charge

If your product's fault fallsin any of the following categories, the fault will be corrected by
replacing the entire product instead of repair, or you will be advised to purchase new one,
depending on the severity of the fault.

e [Faulty or broken mechanical parts

o Flaw, separation, or rust in coated or plated parts

e Flaw or cracksin plastic parts

o Faultsor breakage caused by improper use or unauthorized repair or modification

e Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply
e Cracksinthe printed circuit board or burnt-down patterns

e Widerange of faults that makes replacement less expensive than repair

e Unlocatable or unidentified faults

743 Expiration of the Repair Period

When a period of one year elapses after the model was dropped from production, repairing
products of the model may become impossible.

7.4.4 Transportation Fees at Sending Your Product for Repair

Send your product to usfor repair at your expense.
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75 How to Make a Request for Repair
If your product is found faulty, follow the procedure below to send your product for repair.

Fill in the Repair Request Sheet included with this product, then send it along with this product for
repair to your local distributor. Make sure that information in the Repair Request Sheet is written
in as much detail as possible to facilitate repair.

A CAUTION

Note on Transporting the Product:

When sending your product for repair, use the packing
box and cushion material supplied with this product when
delivered to you and specify handling caution for it to be
handled as precision equipment. If packing of your product is
not complete, it may be damaged during transportation. When
you pack your product in a bag, make sure to use conductive
polyvinyl supplied with this product (usually a blue bag).
When you use other bags, they may cause a trouble on your
product because of static electricity.
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1

Appendix A Troubleshooting

| have a text file open in the editor but syntactic color-coding is not being displayed.

Ensure that you have named the file (i.e. saved it) and that the “ Syntax coloring” check box is
set on the “Editor” tab of the “Options’ dialog box, which islaunched via [Setup ->
Options...]. The High-performance Embedded Workshop looks up the filename extension to
determine the group to which the file belongs and decides whether or not coloring should be
applied to thefile. To view the currently defined filename extensions and file groups, select
[Project -> File Extensions...] to launch the “File Extensions’ dialog box. To view the
coloring information, select [Setup -> Format] to display the “ Color” tab of the “Format”
dialog box.

| want to change the settings of a tool but the [Tools->Administration...] menu option is not
selectable.

[Tools->Administration...] is not selectable while aworkspace is open. To open the “ Tool
Administration” dialog box, close the current workspace.

| opened a workspace from my PC, and one of my colleagues opened the same workspace
simultaneously from another PC. | changed the settings of the workspace and saved it. My
colleague saved the workspace after me. | opened the workspace again and found that the
settings of the workspace differed from those | had made.

The last settings to be saved are effective. While a workspace is open in the High-performance
Embedded Workshop, updating of the workspace is within the memory. The settings are not
saved in afile unless the user intentionally saves the workspace.

In addition to above, refer to FAQs on the emulator and High-performance Embedded Workshop
on the Renesas web site (www.renesas.com).
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Appendix B Menus

Table B.1 shows GUI menus.

TableB.1 GUI Menus

Toolbar
Menu Option Shortcut  Button Remarks
View Disassembly Ctrl + D — Opens the [Disassembly]
‘ | window.
Command Line Ctrl + L = Opens the [Command Line]
;
I window.
TCL toolkit Shift + @ Opens the [Console] window.
Ctrl + L ‘*3’|
Workspace Alt + K IE Opens the [Workspace]
I window.
Output Alt+U I:E Opens the [Output] window.
Difference Opens the [Difference]
window.
CPU Registers Ctrl +R Opens the [Register] window.
Memory... Ctrl + M |: Opens the [Memory] window.
10 Ctrl + 1 I: Opens the [IO] window.
Status Ctrl+ U I:E Opens the [Status] window.
Cache Shift + El Opens the [Cache] window.
Ctrl+C
TLB Shift + ﬁ Opens the [TLB] window.
Ctrl + X
Sym-  Labels Shift + - Opens the [Labels] window.
bol Ctrl + A |
Watch Ctrl + W I:@ Opens the [Watch] window.
Locals Shift + I:ﬁ Opens the [Locals] window.
Ctrl + W |
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TableB.1 GUI Menus(cont)

Toolbar
Menu Option Shortcut  Button Remarks
View Code Eventpoints Ctrl+ E @ Opens the [Event] window.
(cont)

Trace Ctrl+ T r@ Opens the [Trace] window.

Stack Trace Ctrl + K ’_ @ Opens the [Stack Trace]
window.

Gra- Image... Shift + ’_. Opens the [Image] window.
phic Ctrl+G

Waveform... Shift + ’_g Opens the [Waveform] window.

Ctrl +V
Per- Performance Shift + =] Opens the [Performance
form-  Analysis Ctrl+ P Analysis] window.
ance
Profile Shift + = Opens the [Profile] window.
Ctrl + F
Setup Radix Hexadecimal 16 Uses a hexadecimal for
= displaying a radix in which the
numerical values will be
displayed and entered by
default.
Decimal 10 Uses a decimal for displaying a
= radix in which the numerical
values will be displayed and
entered by default.

Octal Uses an octal for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Binary Uses a binary for displaying a

= radix in which the numerical
values will be displayed and
entered by default.
Emu-  System... ‘E’ Opens the [Configuration]
lator dialog box allowing the user to
modify the debugging platform
settings.
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TableB.1 GUI Menus(cont)

Menu Option

Toolbar

Shortcut Button

Remarks

Debug Debug Sessions...

Opens the [Debug Sessions]
dialog box to list, add, or remove
the debug session.

Debug Settings...

Opens the [Debug Settings]
dialog box to set the debugging
conditions or download modules.

Reset CPU

(]
—

Resets the target hardware and
sets the PC to the reset vector
address.

Go

F5

Starts executing the user program
at the current PC.

Reset Go

Shift + F5

B E

Resets the target microcomputer
and executes the user program
from the reset vector address.

Go To Cursor

L]
=+

Starts executing the user program
at the current PC until the PC
reaches the address indicated by
the current text cursor position.

Set PC To Cursor

=i

Sets the PC to the address at the
row of the text cursor.

Run...

Launches the [Run Program]
dialog box allowing the user to
enter the PC or PC breakpoint
during executing the user
program.

Step In

F11 Tl}

Executes a block of user program
before breaking.

Step Over

F10 ™

Executes a block of user program
before breaking. If a subroutine
call is reached, then the
subroutine will not be entered.

Step Out

Shift + F11
{F|

Executes the user program to
reach the end of the current
function.

Step...

Launches the [Step Program]
dialog box allowing the user to
modify the settings for stepping.
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TableB.1 GUI Menus(cont)

Toolbar
Menu Option Shortcut  Button Remarks
Debug Step  Auto Steps only one source line
(cont) Mode when the [Source] window is
active. When the [Disassembly]
window is active, stepping is
executed in a unit of assembly
instructions.
Assembly Executes stepping in a unit of
assembly instructions.
Source Steps only one source line.
Halt Program Esc Stops the execution of the user
program.
Connect 7] Connects the debugging
= platform.
Initialize Disconnects the debugging
platform and connects it again.
Disconnect F| Disconnects the debugging
platform.
Download Modules Downloads the object program.
Unload Modules Unloads the object program.
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Appendix C Command-Line Functions

The emulator supports the commands that can be used in the command-line window.

For details, refer to the online help.
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Appendix D Notes on High-performance Embedded
Workshop

1. Note on Moving Source File Position after Creating Load Module

When the source file is moved after creating the load module, the [Open] dialog box may be
displayed to specify the source file during the debugging of the created load module. Select
the corresponding source file and click the [Open] button.

2. Source-Level Execution
— Sourcefile

Do not display source files that do not correspond to the load module in the program
window. For afile having the same name as the source file that corresponds to the load
module, only its addresses are displayed in the program window. The file cannot be
operated in the program window.

Even standard C libraries are executed. To return to a higher-level function, enter Step
Out. Inafor statement or awhile statement, executing a single step does not move
execution to the next line. To move to the next line, execute two steps.

3. Operation during Accessing Files
Do not perform other operations during downloading the load module, operating [Verify
Memory] or [Save Memory] in the [Memory] window, or saving in the [ Trace] window
because thiswill not allow correct file accessing to be performed.

4. Watch
— Local variables at optimization

Depending on the generated object code, local variablesin a C source file that is compiled
with the optimization option enabled will not be displayed correctly. Check the generated
object code by displaying the [ Disassembly] window.

If the allocation area of the specified local variable does not exist, displays as follows.

Example: The variable nameis asc.

asc = ? - target error 2010 (XxxX)
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— Variable name specification
When a name other than a variable name, such as a symbol name or function name, is
specified, no data is displayed.

Example: The function nameis main.
main =

5. Line Assembly
— Input radix
Regardless of the Radix setting, the default for line assembly input is decimal. Specify H’
or Ox asthe radix for a hexadecimal input.

6. Command Line Interface
— Batch file
To display the message “Not currently available” while executing a batch file, enter the
sleep command. Adjust the sleep time length which differs according to the operating

environment.
Example: To display “Not currently available” during memory_fill
execution:
sleep d’ 3000

memory_fill O ffff O

— File specification by commands

The current directory may be altered by file specificationsin commands. Itis
recommended to use absolute paths are recommended to be used to specify thefilesin a

command file so that the current directory alteration is not affected.

Example: FILE_LOAD C:\Hew3\Tools\Renesas\DebugComp\Platform
\E10A-USB\Tutorial\Tutorial\Debug_SHxxxx_E10A-USB_
SY STEM\tutorial .abs

7. Memory Save during User Program Execution
Do not execute memory save or verifying during user program execution.
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8. Load of Motorola S-type Files

This HEW does not support Motorola S-type files with only the CR code (H'0OD) at the end of
each record. Load Motorola S-type files with the CR and LF codes (H'ODOA) at the end of
each record.

9. Note on [Register] Window Operation during Program Execution

The register value cannot be changed in the [Register] window during program execution.
Even if the changed valueis displayed, the register contents are not changed actually.

10. Break Functions

— When the PC breakpoint is set in the internal flash memory area, the program is written to
the internal flash memory each time the user program is executed. At thistime, note that
the number of rewritable times will be decreased.

— BREAKPOINT cancellation
When the contents of the BREAKPOINT address is modified during user program
execution, the following message is displayed when the user program stops.

BREAKPOINT ISDELETED A=XXXXXXXX

If the above message is displayed, cancel all BREAKPOINT settings with the [Delete All]
or [Disable] button in the [Eventpoint] window.

11. Number of BREAKPOINT and [Stop At] Settingsin the [Run...] Menu
The maximum number of BREAKPOINTSs and [Stop At] settings allowed in the [Run...] menu
is 255. Therefore, when 255 BREAKPOINTSs are set, specification by [Stop At] in the [Run...]
menu becomesinvalid. Usethe BREAKPOINTs and [Stop At] in the [Run...] menu with 255
or lesstotal settings.

12. Note on RUN-TIME Display

The execution time of the user program displayed in the [ Status] window is not a correct value
since the timer in the host computer has been used.

13. Note on Displaying Timeout error
If Timeout error isdisplayed, the emulator cannot communicate with the target
microcomputer. Turn off the user system and connect the USB connector of the emulator
again by using the HEW.
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14. Note on Using the [Run Program] Dialog Box

When [Run...] is selected from the [Debug] menu to specify the stop address, there isthe
following note:

— When the breakpoint that has been set as Disable is specified as the stop address, note that
the breakpoint becomes Enable when the user program stops.

15. Memory Access during User Program Execution

When amemory is accessed from the memory window, etc. during user program execution,
the user program is resumed after it has stopped in the emulator to access the memory.
Therefore, realtime emulation cannot be performed.

The stopping time of the user program is as follows:

Environment:
Host computer: 3.00 GHz (Pentium® 4)
SH72633: 100 MHz (system clock frequency)
JTAG clock: 5 MHz

When a one-byte memory is read from the command-line window, the stopping time will be
about 40 ms.

16. BREAKPOINT Setting for SLEEP Instruction

When abreak is set for the SLEEP instruction, use the Event Condition instead of the
BREAKPOINT.

17. Note on Session Save in the [Configuration] Dialog Box
The following settings are not saved as a session:
— JTAG clock in the [General] page
— Loading flash memory in the [Loading flash memory] page

18. Scrolling Window During User Program Execution

Do not scroll the [Memory] and [Disassembly] windows by dragging the scroll box during user
program execution. This generates many memory reads causing the user program to stop
execution until the memory reads have been completed.

19. Memory Test Function

This product does not support the memory test function, which is used by selecting [Test...]
from the [Memory] menu.
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20. MCU for usein debugging

However, an actual MCU which has been used in connection with the ELJ0A-USB Emulator
for debugging will have been programmed at emulation and subjected to stress accordingly.
Do not use an MCU that has been used for debugging in a mass-produced product.

21. Writing Flash Memory Mode

This mode is only intended for writing a user program to the internal flash memory. In this
mode, do not attempt anything other than downloading. When microcomputers are to be
continuously programmed, be sure to turn the target on or off.

22. Memory Access in the Writing Flash Memory Mode

Memory cannot be accessed in the Writing Flash Memory mode. In this mode, values
displayed in the [Memory] or [10] window are dummy.

23. Memory Access during Flash Memory Programming

During flash memory programming (e.g., user program execution), operation for memory
accessing such as opening the [Memory] window is not allowed. Values displayed here are
dummy. Access the memory again after flash memory programming has been completed.

24. Host Computer in the Sleep or Hibernating Mode

The host computer must not enter the sleep or hibernating mode while the emulator isin use:
otherwise the emulator will not be operable. In such a case, re-connect the emulator after the
host computer has |eft the sleep or hibernating mode.

25. Manua Navigator
Follow the procedure below to execute this program under Windows Vista® or Windows® 7.

Work-around:
(1) Loginwith administrative rights.
(2) Open the properties window for file man_navi.exe in the Manuals folder under the
installation folder for the High-performance Embedded Workshop.

(3) Onthe[Compatibility] tabbed page, check the [Run this program as an administrator]
box.
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Appendix E 1/0O File Format

The High-performance Embedded Workshop formats the [IO] window based on information it
findsin an 1/O Register definition file. When you select a debugging platform, the High-
performance Embedded Workshop will look for a“<device>.10” file corresponding to the
selected device and load it if it exists. Thisfileis aformatted text file that describes the I/0
modules and the address and size of their registers. Y ou can edit thisfile, with atext editor, to add
support for memory mapped registers or peripherals you may have specific to your application
(e.g. registersin an ASIC device mapped into the microcomputer's address space).

The following describes two formats of the “<device>.1O” file that supports or not the bit field.

E.1 FileFormat (Bit Field Not Supported)

Each module name must be defined in the [Modules] definition section and the numbering of each
module must be sequential. Each module corresponds to a register definition section and within
the section each entry defines an 1/0 register.

The [BaseAddress] definition is for devices where the location of 1/0O registers movesin the
address space depending on the CPU mode. In this case, the [BaseAddress] value is the base
address of the 1/0 registersin one specific mode and the addresses used in the register definitions
are the address locations of the registersin the same mode. When the 1/O register fileis actualy
used, the [BaseAddress] valueis subtracted from the defined register address and the resultant
offset added to the relevant base address for the selected mode.

The [Register] definition entry is entered in the format <name> = <address> [<size>
[<absolute>]].

1. <name> register name to be displayed.
2. <address> address of the register.
3. <size> which may be B, W, or L for byte, word, or longword (default is byte).

4. <absolute> which can be set to A if the register is at an absolute address. Thisis
only relevant if the 1/0 area address range moves about on the CPU in different
modes. In this case, if aregister is defined as absolute the base address of fset
calculation is not performed and the specified addressis used directly.

Comment lines are allowed and must start with a“;” character.
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An example is shown below.

Comment

Module
definition

Register
definition

Register name

Address

Example:

; H8S/2655 Series 1/0 Register Definitions File

[Modules]
BaseAddress=0

Modulel=Power_Down_Mode_Registers
Module2=DMA_Channel_Common
Module3=DMA_Channel_0

Module42=Bus_Controller

Module43=System_Control
Module44=Interrupt_Controller

[DMA_Channel_Common]

DMAWER=0xffff00 B A

DMATCR=0xffff01 B A

DMACROA=0xffff02 B A
DMACRO0B=0xffff03 B A
DMACR1A=0xffff04 B A
DMACR1B=0xffff05 B A
DMABCRH=0x{fff06 B A
DMABCRL=0Xffff07 B A

[DMA_Channel_0]
MAROAH=0xfffee0 W A
MAROAL=0xfffee2 W A
IOAROA=0xfffeed W A
ETCROA=0xfffee6 W A
MAROBH=0xfffee8 W A
MAROBL=0xfffeea W A
IOAROB=0xfffeec W A
ETCROB=0xfffeee W A

Size

Absolute address flag
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E.2 FileFormat (Bit Field Supported)

Each module name must be defined in the [Modules] definition section and the numbering of each
module must be sequential. Each module corresponds to aregister definition section and within
the section each entry defines an 1/0 register.

The user must define “FileVersion=2" at the start of the section. It means that this I/O register file
is described with the version that supports the bit field.

The [BaseAddress] definition is for devices where the location of 1/0 registers moves in the
address space depending on the CPU mode. In this case, the [BaseAddress] value is the base
address of the I/O registers in one specific mode and the addresses used in the register definitions
are the address |ocations of the registers in the same mode. When the I/O register fileis actually
used, the [BaseAddress] valueis subtracted from the defined register address and the resultant
offset added to the relevant base address for the selected mode.

Each module has a section that defines the registers forming it along with an optional dependency.
The dependency is checked to see if the module is enabled or not. Each register name must be
defined in the section and the numbering of each register must be sequential. The dependency is
entered in the section as dep=<reg> <hit> <value>.

1. <reg>istheregister id of the dependency.
2. <bit> isthe bit position within the register.
3. <value> isthe value that the bit must be for the module to be enabled.

The [Register] definition entry is entered in the format id=<name> <address> [<size>
[<absolute>[<format>[<bitfields>]1]].

1. <name> register nameto be displayed.
2. <address> address of the register.
3. <size> which may be B, W, or L for byte, word, or longword (default is byte).

4. <absolute> which can be set to A if theregister is at an absolute address. Thisis
only relevant if the I/O area address range moves about on the CPU in different
modes. In this case, if aregister is defined as absolute the base address of fset
calculation is not performed and the specified addressis used directly.
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5. <format> format for register output. Valid values are H for Hexadecimal, D for
decimal, and B for binary.

6. <bitfields> section defining the bits within the register.

Bitfield sections define the bits within aregister each entry is of the type bit<no>=<name>.
1. <no> isthe bit number.
2. <name> isasymbolic name of the hit.

Comment lines are allowed and must start with a*“;” character.

An example is shown below.
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Comment

Module

Module
definition

Register name

Example:

; H8S/2655 Series 1/0 Register Definitions File
[Modules]

FileVersion=2

BaseAddress=0
Modulel=Power_Down_Mode_Registers
Module2=DMA_Channel_Common
Module3=DMA_Channel_0

Module42=Bus_Controller
Module43=System_Control
Module44=Interrupt_Controller

[DMA_Channel_Common]
reg0=regDMAWER
regl=regDMATCR
reg2=regDMACROA
reg3=regDMACRO0B
regd=regDMACR1A
reg5=regDMACR1B
reg6=regDMABCRH
reg7=regDMABCRL
dep=regMSTPCRH 7 0

Bit

Value

Register
definition

Register name

[regDMAWER]
id=DMAWER 0xffff00 B A H dmawer_bitfields

Address

Size

Absolute address flag

Format

Bit field
[dmawer_bitfields]
Bit-field bit3=WE1B
definition bit2=WE1A
bit1=WEOB
bitO=WEOA
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Appendix F Diagnostic Test Procedure

For the diagnostic test procedure using the emulator test program, refer to the test program manual
for the emulator (file name: E1I0A-USBTME.PDF) in the CD-R.
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Appendix G Repair Request Sheet

Thank you for purchasing the E10A-USB emulator (HSO005K CUO1H or HS0005K CUO2H).

In the event of amalfunction, fill in the repair request sheet on the following pages and send it to
your distributor.
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Repair Request Sheet

To Distributor

Y our company name:
Person in charge:

Tel.:

Item

Symptom

1. Date and time when the malfunction
occurred

Month/Day/Year {at system initiation, in system operation}

*Circle either of items in the braces { }.

2. Frequency of generation of the malfunction

() times in () {day(s), week(s), or month(s)}

*Enter the appropriate numbers in the parentheses () and
circle one of the three items in the braces { }.

3. System configuration when the malfunction
occurred

System configuration of the emulator:

e E10A-USB emulator (HSO005KCUO1H or
HS0005KCUO02H):
Serial No.:
Revision:

The above items are written on the label for product
management at the bottom of the emulator unit; the
serial no. is the five-digit number and the revision is the
string of letters following the number.

e Provided CD-R (HSO005KCUO01SRY):

Version: V.

Shown as ‘V.x.xx release xx’ on the CD-R (x: numeral).
e Host computer in use:

Manufacturer:

Type number:
0S: (Windows® XP, Windows Vista®, or Windows® 7)
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Repair Request Sheet

Item

Symptom

4. Settings when the malfunction occurred

(1) MCU/MPU: Part number:
(2) Operating frequency: MHz

5. Failure phenomenon

6. Error in debugging

7. Error in the diagnostic program

8. The High-performance Embedded
Workshop does not link-up with the emulator.

Content of the error message

For errors other than the above, fill in the box below.
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